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Zu diesem Handbuch

Dieses Buch enthält Hinweise zum Installieren, Einrichten und Verwenden von IBM
®

Netfinity
®

FAStT Storage Manager Version 7.02 in einer Umgebung mit dem
Betriebssystem Microsoft

®

WindowsNT
®

. Dieses Installations- und Unterstützungs-
handbuch wurde für Systemadministratoren erstellt. Verwenden Sie dieses Hand-
buch, um

v zur Installation der Speicherverwaltungssoftware erforderliche Hard- und Soft-
ware zu bestimmen,

v die notwendigen Hardwarekomponenten im Netzwerk zu installieren,

v die Speicherverwaltungssoftware zu installieren,

v die Controller-Firmware zu aktualisieren, falls notwendig,

v Speicherverwaltungs-Features zu identifizieren, die einzigartig für Windows NT
sind.

Aufbau des Handbuchs
„Kapitel 1. Einführung” auf Seite 1 bietet eine Übersicht zu IBM Netfinity FAStT Sto-
rage Manager Version 7.02 und beschreibt Verwaltungsmethoden für Speicher-
subsysteme, Konfigurationstypen, Installationstypen und Installationsvorausset-
zungen.

In „Kapitel 2. Vorbereitung der Installation” auf Seite 17 wird die Vorbereitung auf
eine Netzwerkinstallation behandelt, einschließlich der Einrichtung eines Microsoft
DHCP-Servers oder eines UNIX BOOTP-Servers, und es werden andere Setup-
Vorgänge beschrieben.

Unter „Kapitel 3. Installieren der Software in einer Standardkonfiguration” auf Sei-
te 33 wird die Prozedur zur Installation der Software in einer Standardumgebung
(keine Cluster) beschrieben.

Unter „Kapitel 4. Installieren von Software in einer Cluster-Server-Umgebung” auf
Seite 45 werden die Prozedur zur Installation der Software in einer Cluster-Server-
Umgebung und das Upgrade von einer früheren Version der Speicherverwaltungs-
software beschrieben.

Unter „Kapitel 5. Beenden der Installation” auf Seite 61 werden Enterprise Manage-
ment und Subsystem Management, das Ändern von NVSRAM-Konfigurations-
einstellungen und das Abschließen des Installationsvorgangs erläutert.

Unter „Kapitel 6. Migrationsprozess” auf Seite 69 werden die Prozedur zum Upgrade
der Speicherverwaltungsoftware Version 6.22 auf IBM Netfinity FAStT Storage
Manager Version 7.01, das Aktualisieren von RDAC auf dem Host, das Installieren
von MSVM und SM7agent auf dem Host und die Migration der Firmware 3.x auf 4.x
auf den RAID-Controllern erläutert.

xi



In „Kapitel 7. Unterstützung von Betriebssystemen” auf Seite 83 werden die Ein-
schränkungen unter Windows NT, die Verwendung der Dienstprogramme Hot Add
und SM7devices und weitere Software-Features erläutert.

Der Abschnitt „Anhang A. Hinweise” auf Seite 89 enthält Hinweise zum Produkt und
Informationen zu Marken.

Der Abschnitt „Anhang B. Informationsdatensatz zum Speichersubsystem/Controller”
auf Seite 93 enthält ein Datenblatt, das kopiert werden kann und auf dem Sie Infor-
mationen über Ihre Hardware-Einheiten festhalten können.
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Hinweise in diesem Handbuch
Dieses Buch enthält Bemerkungen, die Informationen hervorheben oder die
Sicherheitsinformationen bieten:

v Hinweise

Ein Hinweis enthält wichtige Informationen, Anleitungen oder Ratschläge.

v Wichtig

Diese Hinweise enthalten Informationen oder Ratschläge, die Ihnen dabei helfen,
gefährliche Situationen oder Problemsituationen zu vermeiden.

v Achtung

Dieser Begriff weist auf die Gefahr der Beschädigung von Programmen, Einhei-
ten oder Daten hin. Ein mit ″Achtung″ gekennzeichneter Hinweis befindet sich
direkt vor der Anweisung oder der Beschreibung der Situation, die diese Beschä-
digung bewirken könnte.

Referenzliteratur
Die folgenden Publikationen liegen im Adobe Acrobat Portable Document Format
(PDF) auf der IBM Netfinity FAStT Storage Manager-CD und im World Wide Web
unter http://www.ibm.com/pc/support/ vor.

Anmerkung: Die mit einem Stern (*) markierten Einträge der Liste bezeichnen Ver-
öffentlichungen, die als Druckausgabe im Lieferumfang der IBM
FAStT200- und FAStT200 High Availability (HA) Storage-Server ent-
halten sind.

v IBM Netfinity FAStT Storage Manager Version 7.02 für Windows NT Installations-
und Unterstützungshandbuch (dieses Buch)

v IBM Netfinity FAStT Storage Manager Version 7.02 für Windows 2000
Installations- und Unterstüzungshandbuch

v IBM FAStT200 and FAStT200 HA Storage ServersInstallation and User’s Guide*

v IBM Netfinity FAStT500 RAID Controller Enclosure Unit Installation Guide

v IBM Netfinity FAStT500 RAID Controller Enclosure Unit User’s Reference

v IBM Netfinity Fibre Channel Storage Manager Concepts Guide

v IBM Netfinity Fibre Channel RAID Controller Unit User’s Handbook

Wenn Sie die Tasks in diesem Handbuch beendet haben, lesen Sie die folgenden
Online-Hilfefunktionen durch.

v Online-Hilfe zu IBM Netfinity FAStT Storage Manager Version 7.02 Enterprise
Management. In dieser Hilfe finden Sie weitere Informationen zum Arbeiten mit
der Verwaltungsdomäne.

v Online-Hilfe für IBM Netfinity FAStT Storage Manager Version 7.02 Subsystem
Management. In dieser Hilfe finden Sie weitere Informationen zum Verwalten von
Speichersubsystemen.

Sie können die Hilfefunktion über die Fenster Enterprise Management und Subsys-
tem Management in Netfinity FAStT Storage Manager Version 7.02 aufrufen. Kli-
cken Sie auf Hilfe auf der Funktionsleiste, oder drücken Sie F1.

Zu diesem Handbuch xiii



Die Hilfefunktion enthält Betriebsinformationen, die bei allen Betriebsumgebungen
gleich sind. Informationen, die für Windows NT spezifisch sind, finden Sie in diesem
Handbuch.

IBM bietet zusätzliche Veröffentlichungen zum Kauf an. Ihr IBM Fachhändler oder
IBM Vertriebsbeauftragter kann Ihnen eine Liste der in Ihrem Land verfügbaren Ver-
öffentlichungen geben.

v In den USA oder Puerto Rico rufen Sie folgende Telefonnummer an: 001-800-
497-7426.

v In Großbritannien rufen Sie eine der folgenden Telefonnummern an: 01705-
565000 oder 0161-9056001.

v In Kanada rufen Sie folgende Telefonnummer an: 001-800-465-1234.

v Wenden Sie sich in anderen Ländern an die IBM Unterstützungsorganisation, die
Ihr Gebiet betreut, Ihren IBM Vertriebsbeauftragten oder Ihren IBM Händler.
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Kapitel 1. Einführung

IBM IBM Netfinity FAStT Storage Manager Version 7.02 für Windows NT ist ein
Java-basiertes Tool zur Vereinfachung der Verwaltung von Netfinity Fibre Array Sto-
rage Technology (FAStT)200- und FAStT200 HA Storage-Servern, von Netfinity
FAStT500 RAID Controller Enclosure Unit und von Netfinity Fibre Channel RAID
Controller Unit. Netfinity FAStT Storage Manager Version 7.02 ist unter der vorheri-
gen Bezeichnung Netfinity Fibre Channel Storage Manager 7 bekannt. Die Software
IBM Netfinity FAStT Storage Manager Version 7.02 bietet eine Schnittstelle für die
Speicherverwaltung mit Hilfe der Informationen, die von den Controllern der
Speichersubsysteme geliefert werden. Sie können die Speicherverwaltungssoftware
auf einer Verwaltungsstation, d.h. in dem System, das für die komplette Verwaltung
zuständig ist, oder in einem Teil dieses Systems, einem Netz, installieren. Die
Verwaltungsstation kommuniziert über ein Netzverwaltungsprotokoll, beispielsweise
SNMP (Simple Network Management Protocol) mit den Netzverwaltungsagenten,
die sich im verwalteten Knoten befinden. Wenn Sie ein Speichersubsystem mit der
auf einer Verwaltungsstation installierten Client-Software verwalten, werden die
Befehle an die Controller der Speichersubsysteme gesendet. Die Controller-
Firmware enthält die notwendigen Informationen zur Ausführung der Speicher-
verwaltungsbefehle. Der Controller übernimmt die Auswertung und Ausführung der
Befehle und gibt Status- und Konfigurationsdaten an die Client-Software zurück. Im
vorliegenden Handbuch beziehen sich die Begriffe Speicherverwaltungssoftware
und Storage Manager 7.02 auf IBM Netfinity FAStT Storage Manager Version 7.02
für Windows NT-Software. Einzelne Komponenten der Speicherverwaltungssoftware
werden namentlich gekennzeichnet.

Wichtige Begriffe
Wenn Sie ein Upgrade von einer vorherigen Version der Speicherverwaltungs-
software durchführen, werden Sie feststellen, dass sich einige bekannte Bezeich-
nungen geändert haben. Machen Sie sich daher mit der neuen Terminologie ver-
traut. Tabelle 1 auf Seite 2 zeigt Ihnen eine Liste mit einigen der alten und der
neuen Bezeichnungen. Weitere Informationen erhalten Sie im Leitfaden zu IBM Net-
finity Fibre Channel Storage Manager.

Produktname Produkt-
Release
Firmware-
Version

Release Speicher-
verwaltungs-
softwareversion

Maschi-
nentyp

Modell

IBM FAStT200 4.x 7.02 3542 1RU

IBM FAStT200 HA 4.x 7.02 3542 2RU

Netfinity Fibre Channel RAID Controller Unit 3.x, 4.x 6.22, 7.0, 7.01, 7.02 3526 1RU

Netfinity FAStT500 RAID Controller Enclosure Unit 4.x 7.01, 7.02 3552 1RU

1



Tabelle 1. Alte und neue Terminologie

Bezeichnung in früheren Versionen Neue Bezeichnung

RAID module Storage subsystem

Drive group Array

Logical Unit (LUN)1 Logical drive
1 Im Storage Manager 7.02 bezeichnet der Begriff Logical Unit Number (LUN) eine logische Adresse, die vom Host für
den Zugriff auf ein bestimmtes logisches Laufwerk verwendet wird.

Der Unterschied zwischen den beiden folgenden Bezeichnungen ist im vorliegenden
Handbuch von besonderer Bedeutung.

Verwaltungsstation
Ein System zur Verwaltung des Speichersubsystems. Dieses System muss
nicht über den Fibre Channel-E/A-Pfad an das Speichersubsystem ange-
schlossen werden.

Host/Host-Computer
Die Begriffe Host und Host-Computer werden gleichwertig im gesamten
Dokument verwendet. Beide Begriffe beziehen sich auf ein System, das
direkt über einen Fibre Channel-E/A-Pfad an das Speichersubsystem ange-
schlossen ist. Mit diesem System werden Daten (in der Regel in Dateiform)
vom Speichersubsystem abgerufen.

Anmerkung: Ein System kann gleichzeitig eine Verwaltungsstation und einen Host-
Server darstellen.
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Softwarekomponenten
Storage Manager 7.02 umfasst die folgenden Softwarekomponenten:

v Client-Software

v Host-Agent

v RDAC-Paket

v Migrationsdienstprogramm

Client-Software
Die Storage Manager 7.02-Client-Komponente (SM7client) bietet eine grafische
Benutzerschnittstelle zur Verwaltung der Speichersubsysteme über das Ethernet-
Netz oder vom Host aus. Der SM7client enthält zwei Hauptkomponenten:

v Enterprise Management zum Hinzufügen, Entfernen und Überwachen der
Speichersubsysteme innerhalb der Verwaltungsdomäne

v Subsystem Management für die Verwaltung der Komponenten eines einzelnen
Speichersubsystems

Host-Agent-Paket
Der Storage Manager 7.02-Agent (SM7agent) besteht aus zwei Software-
komponenten:

v Host-Agent-Software Mit Hilfe der Host-Agent-Software können Sie die
Speichersubsysteme über die Host-Ethernet-Verbindung verwalten. Für die Host-
Agent-Software muss eine Ethernet-Verbindung zwischen einer Verwaltungs-
station und dem Host vorhanden sein, und die Anfragen an die Controller des
Speichersubsystems müssen über den Fibre Channel-E/A-Pfad weitergegeben
werden. Weitere Informationen über die Verwaltung von Speichersubsystemen
mittels des Host-Agenten erhalten Sie unter „Verwaltung mit dem Host-Agenten”
auf Seite 5.

v Dienstprogramm SM7devices Mit Hilfe des Dienstprogramms SM7devices kön-
nen Sie den logischen Laufwerken der Speichersubsysteme Einheitennamen des
Betriebssystems zuordnen. Weitere Informationen zur Verwendung von
SM7devices erhalten Sie unter „Verwenden des Dienstprogramms SM7devices”
auf Seite 86.
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RDAC-Paket
Das RDAC-Paket (RDAC = Redundant Disk Array Controller) enthält zwei Software-
komponenten:

v RDAC-Multipath-Einheitentreiber Der RDAC-Multipath-Einheitentreiber bietet
eine Überbrückungsunterstützung für den anderen Controller, wenn eine Kompo-
nente entlang des Fibre Channel-E/A-Pfades ausfällt.

v Dienstprogramm Hot Add Mit Hilfe des Dienstprogramms Hot Add können Sie
neu erstellte logische Laufwerke mit dem Betriebssystem registrieren. Weitere
Informationen zur Verwendung des Dienstprogramms Hot Add erhalten Sie unter
„Verwenden des Hot-Add-Dienstprogramms” auf Seite 86.

Migrationspaket
Mit Hilfe des Migrationsdienstprogramms des Storage Manager 7.02 (SM7migrate)
können Sie die Controller-Firmware für das Modell 3526 aktualisieren und Stan-
dardkonfigurationseinstellungen auf NVSRAM herunterladen, um bestehende
Speichersubsysteme mit Storage Manager 7.02 zu verwalten.

Wichtig: Storage Manager 7.02 funktioniert ausschließlich mit Controllern mit Firm-
ware der Version 4.x. Wenn Sie Controller mit Storage Manager 7.02 verwalten
möchten, müssen Sie für die Firmware ein Upgrade auf Version 4.x durchführen.
Zur Verwaltung von Speichersubsystemen mit Controllern, die Firmware der Version
3.x verwenden, müssen Sie Version 6.22 der Speicherverwaltungssoftware einset-
zen. Weitere Informationen erhalten Sie unter „Installationsarten” auf Seite 12.

Mittels der Migrationsprozedur können Sie folgende Tasks ausführen:

v Migration von der Speicherverwaltungssoftware Version 6.22 zu Netfinity FAStT
Storage Manager Version 7.02 auf einer oder mehreren Verwaltungsstationen

v Aktualisierung von RDAC auf einem oder mehreren Hosts

v Installation von Microsoft Virtual Machine (MSVM) und SM7agent auf einem oder
mehreren Hosts

v Migration von Firmware 3.x zu 4.x auf den Redundant Array of Independent
Disks-Controllern (RAID) in einer IBM Netfinity Fibre Channel RAID Controller
Unit, Modell 3526-1RU

Weitere Informationen finden Sie unter „Kapitel 6. Migrationsprozess” auf Seite 69.
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Verwaltungsmethoden für Speichersubsysteme
Die Speicherverwaltungssoftware bietet zwei Methoden zur Verwaltung von
Speichersubsystemen: die Verwaltung mit dem Host-Agenten und die direkte Ver-
waltung. Je nach Konfiguration Ihrer Speichersubsysteme können Sie eine der bei-
den oder auch beide Methoden verwenden.

Verwaltung mit dem Host-Agenten
Wenn Sie diese Methode verwenden, verwalten Sie die Speichersubsysteme über
den Fibre Channel-E/A-Pfad zum Host. Das Speichersubsystem kann vom Host aus
oder von der an den Host über eine Ethernet-Verbindung angeschlossenen
Verwaltungsstation verwaltet werden.

Die Verwaltung von Speichersubsystemen durch den Host-Agenten weist folgende
Vorteile auf:

v Sie müssen keine Ethernet-Kabel an die Controller anschließen.

v Sie benötigen keinen BOOTP-Server für die Verbindung zum Netz.

v Die Ausführung der Tasks zur Controller-Netzkonfiguration, wie sie in „Kapitel 2.
Vorbereitung der Installation” auf Seite 17 beschrieben sind, ist nicht erforderlich.

v Wenn Sie Einheiten hinzufügen, müssen Sie lediglich für den Host einen Host-
Namen oder eine IP-Adresse angeben, nicht jedoch für die einzelnen Controller
in einem Speichersubsystem. Speichersubsysteme, die an den Host angeschlos-
sen sind, werden automatisch erkannt.

Die Host-Agent-Methode weist jedoch auch Nachteile auf:

v Bei der Konfiguration der logischen Einheitennummern (LUN = Logical Unit Num-
ber) liegt eine Beschränkung auf eine Anzahl vor, die eine Ziffer unter der Anzahl
liegt, die das verwendete Betriebssystem und der eingesetzte Host-Adapter
zulassen.

v Für den Host-Agenten ist ein spezielles logisches Laufwerk, ein so genanntes
Access Volume, erforderlich, um mit den Controllern im Speichersubsystem zu
kommunizieren.

Anmerkung: Das Access Volume verwendet eine der logischen Einheitennummern
(LUN). Windows NT ermöglicht die Verwendung einer maximalen
Anzahl von LUNs, je nachdem, welcher Service Pack installiert ist
und welchen Host-Adapter Sie verwenden. Weitere Informationen
finden Sie unter „Zahl der unterstützten logischen Laufwerke” auf Sei-
te 84.

Wenn Sie ein Upgrade der Controller von Firmware Version 3.x auf Version 4.x
durchführen und Ihr Host-System bereits die maximale Anzahl an LUNs konfiguriert
hat, müssen Sie eine LUN für das Access Volume zur Verfügung stellen.

Abb. 1 auf Seite 6 zeigt ein System, in dem die Speichersubsysteme mit dem Host-
Agenten verwaltet werden.
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Ethernet

Host-Computer

Controller

Controller

Controller

Controller

E/A-Pfad des Fibre Channel

Verwaltungsstation
(eine oder mehrere)

Ausführen der
Host-Agent-Software

Speicher-Subsysteme

Hinweis: Der Host kann auch als
Verwaltungsstation agieren.

Direkte Verwaltung
Wenn Sie diese Methode verwenden, verwalten Sie die Speichersubsysteme direkt
mittels der Ethernet-Verbindung zu jedem Controller über das Netz. Um das
Speichersubsystem über diese Ethernet-Verbindungen verwalten zu können, müs-
sen Sie die IP-Adresse und den Host-Namen für jeden Controller definieren und an
die Ethernet-Anschlüsse an den Controllern des Speichersubsystems ein Kabel
anschließen.

Die direkte Verwaltung von Speichersubsystemen weist folgende Vorteile auf:

v Durch die Ethernet-Verbindungen mit den Controllern ist eine Verwaltungsstation,
auf der Windows NT läuft, in der Lage, Speichersubsysteme zu verwalten, die
mit einem Host verbunden sind, der ein Betriebssystem aufweist, das nicht von
Storage Manager 7.02 unterstützt wird.

v Sie müssen kein Access Volume verwenden, um mit den Controllern zu kommu-
nizieren, wie es bei der Host-Agent-Software der Fall ist. Sie können die maxi-
male Anzahl an LUNs konfigurieren, die von Ihrem Betriebssystem und dem ver-
wendeten Host-Adapter unterstützt wird.

Die direkte Verwaltung der Speichersubsysteme weist jedoch auch Nachteile auf:

v Für die Verbindung beider Controller des Speichersubsystems mit dem Netz sind
zwei Ethernet-Kabel erforderlich.

v Wenn Sie Einheiten hinzufügen, müssen Sie für jeden Controller eine IP-Adresse
oder einen Host-Namen angeben.

Abbildung 1. Speichersubsysteme, die mit dem Host-Agenten verwaltet werden
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Anmerkung: Bei Controllern des Maschinentyps 3526 ist für das Anschließen
eines RJ-45-Anschlusses ein Transceiver für die Schnittstelle der
Anschlusseinheit (AUI = Attachment Unit Interface) erforderlich.

v Sie benötigen einen BOOTP-Server, und es sind Vorbereitungs-Tasks für das
Netz erforderlich. Eine Zusammenfassung der Vorbereitungs-Tasks finden Sie in
Tabelle 8 auf Seite 18.

Abb. 2 zeigt ein System, in dem die Speichersubsysteme direkt verwaltet werden.

Ethernet

Host-Computer

E/A-Pfad des Fibre Channel

Verwaltungsstation
(eine oder mehrere)

Controller

Controller

Controller

Controller

Speicher-Subsysteme

Abbildung 2. Speichersubsysteme mit direkter Verwaltung
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Konfigurationsarten
Sie können Storage Manager 7.02 in einer der beiden folgenden Konfigurationen
installieren:

v Standardkonfiguration (keine Cluster-Konfiguration)

v Konfiguration mit Cluster-Server

Standardkonfiguration (keine Cluster-Konfiguration)
In Tabelle 2 wird beschrieben, wo die Softwarekomponenten für die Speicher-
verwaltungssoftware bei einer Standardkonfiguration (nicht bei der Konfiguration
von Cluster-Servern) installiert werden.

Tabelle 2. Installationsort der Softwarekomponenten bei einer Standardkonfiguration (ohne Cluster)

Softwarekomponente Installationsort Hinweise

Storage Manager 7.02-Client
(SM7client)

Sie können das SM7client-Paket an
folgenden Orten installieren:

v Verwaltungsstation (für direkte
Verwaltung oder Verwaltung mit
dem Host-Agenten)

v Host-Computer (für eine
Konfiguration, die nicht über das
Netz erfolgt, vergleichbar
vorherigen Versionen der
Speicherverwaltungssoftware)

v Verwaltungsstationen Wenn Sie die
SM7client-Software auf einer oder mehreren
Verwaltungsstationen installieren, können Sie
die Speichersubsysteme entweder direkt über
die Ethernet-Verbindungen zu den Controllern
oder mittels des Host-Agenten über das Netz
verwalten. Auch eine Kombination beider
Methoden ist möglich.

v Host-Computer Wenn Sie die SM7client-
Software auf dem Host installieren, muss der
Host nicht mit dem Netz verbunden sein,
solange die Host-Agent-Software installiert ist.
Auf dem Host-Computer muss jedoch die
TCP/IP-Software installiert sein, und Sie
müssen dem Host eine statische IP-Adresse
zuordnen.

RDAC Host-Computer Die RDAC-Komponente ist für die
Überbrückungsunterstützung des Controllers
und die Installation und Verwendung der Host-
Agent-Software erforderlich. Stellen Sie sicher,
dass RDAC auf jedem mit dem Speicher-
subsystem verbundenen Host installiert ist.

Microsoft Virtual Machine
(MSVM)

Host-Computer Die Komponente Microsoft Virtual Machine ist
für die Installation und Verwendung der
Software erforderlich, die Bestandteil des Host-
Agent-Pakets ist.

Storage Manager 7.02-Agent
(SM7agent)

Host-Server Sie müssen die SM7agent-Software selbst dann
installieren, wenn Sie die Speichersubsysteme
nicht mit der Host-Agent-Software verwalten
möchten. Der Host-Agent beinhaltet wichtige
Dienstprogramme, die für den Betrieb der
Speicherverwaltungssoftware notwendig sind.
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In der folgenden Abbildung ist ein Beispiel für eine Standardkonfiguration (ohne
Cluster) einschließlich einer Verwaltungsstation dargestellt. Sie können den
SM7client auf einem eigenständigen Host-Computer installieren, wenn auf diesem
Host die TCP/IP-Software (TCP/IP = Transmission Control Protocol/Internet Proto-
col) installiert ist und der Host eine statische IP-Adresse aufweist. Wenn Sie
Speichersubsysteme mit der Host-Agent-Software verwalten möchten, müssen Sie
Microsoft Virtual Machine (MSVM) ebenfalls auf dem Host installieren.

Ethernet

Host-Computer

Controller

Controller

Controller

Controller

E/A-Pfad des Fibre Channel

Verwaltungsstation

RDAC, Microsoft
VM und Host-Agent

Die Client-Software ist
auf einem oder mehreren

Verwaltungssystemen oder
auf dem Host-Computer installiert.

Speicher-Subsysteme

Abbildung 3. Beispiel für eine Standardkonfiguration (ohne Cluster)
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Konfiguration eines Cluster-Servers
In Tabelle 3 werden die Softwarekomponenten für die Speicherverwaltung beschrie-
ben, die Sie in einer Cluster-Server-Umgebung installieren können.

Wichtig: Achten Sie darauf, dass Sie alle Komponenten der Speicherverwaltungs-
software auf jedem Server in Ihrem Cluster installieren.

Tabelle 3. Installationsort der Softwarekomponenten bei einer Konfiguration auf einem Cluster-Server

Softwarekomponente Installationsort Hinweise

Storage Manager 7.02-Client
(SM7client)

Sie können das SM7client-Paket an
folgenden Orten installieren:

v Verwaltungsstation (für direkte
Verwaltung oder Verwaltung mit
dem Host-Agenten)

v Knoten A und B (für direkte
Verwaltung oder Verwaltung mit
dem Host-Agenten)

v Verwaltungsstationen Wenn Sie die
SM7client-Software auf einer oder
mehreren Verwaltungsstationen
installieren, können Sie die Speicher-
subsysteme entweder direkt über die
Ethernet-Verbindungen zu den
Controllern oder mittels des Host-
Agenten über das Netz verwalten. Auch
eine Kombination beider Methoden ist
möglich.

v Knoten A und B Wenn Sie den
SM7client auf den Cluster-Servern
(Knoten A und B) installieren, muss der
Server nicht an das Netz angeschlossen
sein, solange die Host-Agent-Software
installiert ist. Auf dem Host muss jedoch
die TCP/IP-Software installiert sein, und
Sie müssen dem Host eine statische
IP-Adresse zuordnen.

RDAC Knoten A und B Die RDAC-Komponente ist für die
Überbrückungsunterstützung des
Controllers und die Installation und
Verwendung der Host-Agent-Software
erforderlich. Stellen Sie sicher, dass RDAC
auf jedem mit dem Speichersubsystem
verbundenen Host installiert ist.

Microsoft Virtual Machine
(MSVM)

Knoten A und B Die Komponente Microsoft Virtual Machine
ist für die Installation und Verwendung der
Software erforderlich, die Bestandteil des
Host-Agent-Pakets ist.

Storage Manager 7.02-Agent
(SM7agent)

Knoten A und B Sie müssen den Host-Agenten selbst dann
installieren, wenn Sie die Speicher-
subsysteme nicht mit der Host-Agent-
Software verwalten möchten. Der Host-
Agent beinhaltet wichtige
Dienstprogramme, die für den Betrieb der
Speicherverwaltungssoftware notwendig
sind.
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In der folgenden Abbildung ist ein Beispiel für eine Konfiguration auf einem Cluster-
Server dargestellt.

Ethernet

E/A-Pfad des
Fibre Channel

Verwaltungsstation
(eine oder mehrere)

Cluster-Server-
Knoten A

Cluster-Server-
Knoten B

RDAC, Microsoft
VM und SM7agent

Controller

Controller

Speicher-Subsysteme

Verwalteter Hub
oder Schalter

Die SM7client-Software
wird auf einer oder mehreren
Verwaltungsstationen oder
auf den Cluster-Servern installiert.

Abbildung 4. Beispiel für eine Konfiguration mit einem Cluster-Server (einfache Schleife)
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Installationsarten
Um Storage Manager 7.02 zu installieren, wählen Sie in der folgenden Liste die
Installationsart aus, die für Ihr Unternehmen am besten geeignet ist.

v Neue Speichersubsystem-Umgebung Sie verfügen bisher noch nicht über
Speichersubsysteme. In diesem Fall installieren Sie neue Speichersubsysteme
mit Controllern des Maschinentyps 3526, 3552 oder 3542, die Firmware der Ver-
sion 4.x verwenden. Sie beabsichtigen, diese neuen Speichersubsysteme mit
Storage Manager 7.02 zu verwalten. Um mit dieser Installation fortzufahren,
gehen Sie zu Schritt „Systemvoraussetzungen” auf Seite 15.

v Bestehende Speichersubsystemumgebung Sie verfügen bereits über
Speichersubsysteme. In Tabelle 4 werden die Optionen für die Verwaltung dieser
bestehenden Speichersubsysteme erläutert.

Tabelle 4. Konfigurationen für bestehende Speichersubsysteme

Bestehende Speichersubsysteme
mit:

Optionen

Controllern des Maschinentyps 3526
mit der Firmware-Version 3.x

Option 1 — Führen Sie das Upgrade der Controller-Firmware auf die Version
4.x aus, und verwalten Sie die Speichersubsysteme mit dem Storage Manager
7.02. Fahren Sie mit dem Schritt „Systemvoraussetzungen” auf Seite 15 fort.

Option 2 — Installieren Sie die Speichersubsysteme, und ordnen Sie die
Subsysteme dem Host zu, dem die bereits bestehenden Speichersubsysteme
zugeordnet sind. Diese bestehenden und die neuen Speichersubsysteme
werden als ″koexistierende Speichersubsysteme″ bezeichnet. Weitere
Informationen finden Sie unter „Verwalten neuer und bestehender Speicher-
subsysteme, die an denselben Host angeschlossen sind” auf Seite 13.

Option 3 — Verwenden Sie weiterhin die Version 6.22 der Speicher-
verwaltungssoftware zur Verwaltung dieser Speichersubsysteme, wenn diese
an Hosts angeschlossen sind, die nicht mit durch den Storage Manager 7.02
verwalteten Speichersubsystemen verbunden sind. Fahren Sie mit dem Schritt
„Systemvoraussetzungen” auf Seite 15 fort.

Controllern der Maschinentypen 3526
und 3552, auf denen Firmware-
Versionen von 4.00.00 bis 4.00.01
ausgeführt werden

Option 1 — Deinstallieren Sie die vorherige Version der Speicherverwaltungs-
software; installieren Sie anschließend Storage Manager 7.02. Nehmen Sie
nach der Installation des Storage Manager 7.02 ein Upgrade der Controller-
Firmware von den Versionen 4.00.00 bis 4.00.01 auf die Version 4.00.02 vor,
und verwalten Sie diese bestehenden Speichersubsysteme mit Storage
Manager 7.02. Fahren Sie mit dem Schritt „Systemvoraussetzungen” auf
Seite 15 fort.

Option 2 — Verwenden Sie weiterhin Ihre vorhandenen Versionen 4.00.00 bis
4.00.01 der Controller-Firmware. Deinstallieren Sie die vorherige Version der
Speicherverwaltungssoftware; installieren Sie anschließend Storage Manager
7.02. Sie können diese bestehenden Speichersubsysteme mit Storage
Manager 7.02 verwalten, der Komponenten enthält, die mit diesen älteren
Firmware-Versionen kompatibel sind. Informationen zu den Unterschieden in
der Funktionsweise zwischen Ihrer vorhandenen Controller-Firmware und der
Firmware-Version 4.00.02 finden Sie auf der Installations-CD. Weitere
Informationen finden Sie in der README-Datei, die sich im Verzeichnis \NT\
auf der Installations-CD befindet. Fahren Sie mit dem Schritt
„Systemvoraussetzungen” auf Seite 15 fort.
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Verwalten neuer und bestehender Speichersubsysteme, die an densel-
ben Host angeschlossen sind

Wenn Sie Storage Manager 7.02 installieren, müssen Sie festlegen, wie die beste-
henden Speichersubsysteme verwendet werden sollen. Bestehende Speicher-
subsysteme werden ″koexistierende Speichersubsysteme″ genannt, wenn sie an
denselben Host angeschlossen sind wie die mit Storage Manager 7.02 verwalteten
Speichersubsysteme und wenn die unter Tabelle 5 genannten Bedingungen erfüllt
sind.

Tabelle 5. Anforderungen für koexistierende Speichersubsysteme

Bestehende Speichersubsysteme Neue oder aktualisierte Speicher-
subsysteme

v Verwenden Firmware der Version 3.01.x

v Werden mit Version 6.22 der Speicher-
verwaltungssoftware verwaltet

Anmerkung: Firmware- und Softwareebenen
stellen die Minimalanforderungen für
Controller des Maschinentyps 3526 dar, damit
eine Koexistenz mit neuen oder aktualisierten
Speichersubsystemen möglich ist.

v Verwenden Firmware der Version 4.x

v Werden mit Storage Manager 7.02
verwaltet
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Abb. 5 zeigt ein Beispiel für eine Umgebung, die koexistierende Speicher-
subsysteme umfasst.

Wichtig: Die RDAC-Software, die im Storage Manager 7.02-Paket enthalten ist,
überschreibt den RDAC-Treiber, der mit Version 6.22 der Speicherverwaltungs-
software verknüpft ist. Abb. 5 zeigt ein Beispiel koexistierender Speichersubsysteme
(neue und bereits zuvor installierte Speichersubsysteme, die an denselben Host
angeschlossen sind). Die beiden installierten Versionen der Speicherverwaltungs-
software verwenden den neu installierten RDAC-Treiber.

Ethernet

Host-Computer

Controller

Controller

Controller

Controller

E/A-Pfad des
Fibre Channel

Verwaltungsstation
(eine oder mehrere)

Verwaltungsstation
(eine oder mehrere)

RDAC, Microsoft
VM und Host-Agent

Client-Software

Speicher-Subsysteme

Wichtig:
Beide Versionen der Speicher-
verwaltungssoftware benutzen ein
gemeinsames RDAC - dasjenige, das
Sie mit Storage Manager 7.02
installieren. Diese neue Version von
RDAC überschreibt jede vorherige
Version von RDAC.

Version 6.22 der Speicherverwaltungs-
software muss entweder auf einer Ver-
waltungsstation (Netzwerkversion) oder
auf dem Host installiert sein.

Firmware Version
3.01.x (Minimum)

Firmware Version 4.x

Abbildung 5. Beispiel für eine Koexistenzinstallation
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Systemvoraussetzungen
In diesem Abschnitt finden Sie ausführliche Informationen über die Hardware-,
Software- und Betriebssystemanforderungen für Storage Manager 7.02.

Hardwarevoraussetzungen
In der folgenden Tabelle werden die Hardwarekomponenten aufgeführt, die für die
Installation von Storage Manager 7.02 erforderlich sind.

Tabelle 6. Hardwarevoraussetzungen für die Speicherverwaltungssoftware

Hardwarekomponente Voraussetzungen

Ein BOOTP-Server (nur für direkt
verwaltete Speichersubsysteme)

v BOOTP-kompatibler Microsoft DHCP-Server für Windows NT

v UNIX
®
-BOOTP-Server

Speichersubsysteme (mindestens
eins)

Speichersubsysteme mit Controllern, auf denen Firmware der Versionen
4.00.00 bis 4.00.02 ausgeführt wird
Anmerkung: Wichtige Informationen zur Verwaltung dieser Speicher-
subsysteme, wenn bestehende Speichersubsysteme physikalisch mit
demselben Host verbunden sind, an den Sie auch die neuen Subsysteme
anschließen möchten, finden Sie unter „Installationsarten” auf Seite 12.

Fibre Channel (FC)-Host-Adapter Die folgenden Fibre Channel-Host-Adapter wurden mit der Speicher-
verwaltungssoftware getestet:

v IBM Netfinity FAStT-Host-Adapter (Artikelnummer: 00N6881)

So erhalten Sie weitere Informationen zu bestimmten Host-Adapter-
Anforderungen:

v Lesen Sie die README-Datei, die sich im Verzeichnis \NT\Host_Adapter auf
der Installations-CD befindet.

v Lesen Sie die Dokumentation zum Host-Adapter.

v Besuchen Sie die Website von IBM unter http://www.ibm.com/pc/support.

Switch-Verbünde für Fibre Channels
(FC) (wenn für die gewünschte
Konfiguration erforderlich)

Folgende Switch-Verbünde für Fibre Channels wurden mit der Speicher-
verwaltungssoftware getestet:

v Fibre Channel-Schalter für IBM mit 8 Anschlüssen (Maschinentyp: 2109-S08)

v Fibre Channel-Schalter für IBM mit 16 Anschlüssen (Maschinentyp: 2109-
S16)

Informationen zu den Voraussetzungen für die Einrichtung spezieller Fibre
Channel-Schalter erhalten Sie folgendermaßen:

v Lesen Sie die Dokumentation zu den Schaltern.

v Besuchen Sie die Website von IBM unter http://www.ibm.com/products.

Per Fibre Channel (FC) verwalteter
Hub (wenn für die gewünschte
Konfiguration erforderlich)

Der nachstehende verwaltete Hub wurde mit der Speicherverwaltungssoftware
getestet:

v Verwalteter Hub für IBM Fibre Channel (Maschinentyp: 3534)

Informationen zu den Voraussetzungen für die Einrichtung spezieller
verwalteter Hubs in Fibre Channels erhalten Sie folgendermaßen:

v Lesen Sie die Dokumentation zum Thema ″verwaltete Hubs″.

v Besuchen Sie die Website von IBM unter http://www.ibm.com/products.
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Firmware-Voraussetzungen
Storage Manager 7.02 läuft ausschließlich mit Controllern des Maschinentyps 3526,
3552 oder 3542 und mit der Firmware-Version 4.00 oder höher. Wenn Sie Control-
ler mit Storage Manager 7.02 verwalten möchten, müssen Sie die Firmware auf die
Version 4.00 oder eine neuere Version aktualisieren. Sie müssen die Version 6.22
der Speicherverwaltungssoftware verwenden, um Speichersubsysteme mit Control-
lern zu verwalten, die die Firmware-Version 3.x verwenden.

Softwarevoraussetzungen
Die folgende Tabelle beschreibt die Installationsvoraussetzungen für jedes der
Softwarepakete.

Tabelle 7. Installationsvoraussetzungen für die Softwarepakete

Voraussetzung Software

SM7client RDAC Microsoft VM SM7agent SM7migrate

Verfügbarer
Platten-
speicherplatz

20 MB 1 MB 1 MB 1 MB 10 MB

Administrator-
berechtigungen

Nicht erforderlich Erforderlich Erforderlich Erforderlich Erforderlich

Mindesteinstel-
lungen für die
Anzeige

800x600 Pixel,
256 Farben

640x480 Pixel,
256 Farben1

640x480 Pixel,
256 Farben1

640x480 Pixel,
256 Farben1

640x480 Pixel,
256 Farben1

1 Diese Einstellungen gelten für die Installation mit dem Installationsassistenten der Software.

Betriebssystemvoraussetzungen
Installieren Sie auf Verwaltungsstationen eines der folgenden Betriebssysteme:

v Windows NT Server 4.0 mit Service Pack 5 oder höher

v Windows NT Workstation 4.0 mit Service Pack 5 oder höher

Installieren Sie auf Hosts eines der folgenden Betriebssysteme:

v Windows NT Server 4.0 mit Service Pack 5 oder höher

v Windows NT 4.0 Enterprise Edition mit Service Pack 5 oder höher

Auf Cluster-Servern installieren Sie Windows NT 4.0 Enterprise Edition mit Service
Pack 5 oder höher.
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Kapitel 2. Vorbereitung der Installation

Mit Hilfe dieses Kapitels können Sie die Installation der Speicherverwaltungs-
software planen und vorbereiten.

Wie sollen die Speichersubsysteme verwaltet werden?
Weitere Informationen zu den folgenden beiden Methoden zur Verwaltung von
Speichersubsystemen finden Sie unter „Kapitel 1. Einführung” auf Seite 1.

v Direkte Verwaltung über eine Ethernet-Verbindung zu jedem Controller im
Speichersubsystem

v Verwaltung mit dem Host-Agenten über die Host-Agent-Software, die auf dem
Host installiert ist, der mit dem Speichersubsystem verbunden ist

Sie können eine beliebige oder beide Methoden verwenden. Da jedoch viele
Vorbereitungs-Tasks für die Installation von der gewählten Methode abhängen, müs-
sen Sie vor der Installation entscheiden, wie die Speichersubsysteme in Ihrem Netz
verwaltet werden sollen.

Überprüfen eines Beispielnetzes
Abb. 6 auf Seite 18 zeigt ein Beispiel für eine Netzkonfiguration mit direkt verwalte-
tem Speichersubsystem (siehe Netz A). Dieses Netz umfasst die folgenden Kompo-
nenten:

v BOOTP-Server

v Verwaltungsstation für SNMP-Traps (SNMP = Simple Network Management Pro-
tocol)

v Host, der über einen Fibre Channel-E/A-Pfad mit einem Speichersubsystem ver-
bunden ist

v Verwaltungsstation, die über Ethernet-Kabel mit den Controllern des Speicher-
subsystems verbunden ist

Abb. 6 auf Seite 18 zeigt ein Beispiel einer Netzkonfiguration, bei der das Speicher-
subsystem über den Host-Agenten verwaltet wird (siehe Netz B). Dieses Netz
umfasst die folgenden Komponenten:

v Host, der über einen Fibre Channel-E/A-Pfad mit einem Speichersubsystem ver-
bunden ist

v Verwaltungsstation, die über Ethernet-Kabel mit dem Host verbunden ist

17



Controller

Controller

Controller

Controller

Speicher-
Subsystem

Bankeinrichtung

Speicher-
Subsystem
Entwicklung

E/A-Pfad des Fibre Channel

E/A-Pfad des Fibre Channel

Netzwerk A
TCP/IP

Netzwerk B
TCP/IP

Ethernet

Router

Netzverwaltungs-
station für

SNMP-Traps)

Verwaltungsstation
(eine oder mehrere)

Verwaltungsstation
(eine oder mehrere)

Host-Computer
Denver

(IP-Adresse
153.79.144.12)

Host-Computer
Atlanta

(IP-Adresse
153.79.144.22)

BOOTP-Server

Host-Name: Denver_a
(IP-Adresse 153.79.144.13)

Hardware-Adresse 00.a0.b8.02.04.20
Host-Name: Denver_b

(IP-Adresse 153.79.144.14)
Hardware-Adresse 00.a0.b8.00.00.d8

Vorbereiten einer Netzinstallation
Bevor Sie die Speicherverwaltungssoftware installieren, müssen die Netz-
komponenten eingerichtet sein und ordnungsgemäß funktionieren. Darüber hinaus
müssen Sie alle Host- und Controller-Daten, die für den ordnungsgemäßen Betrieb
der Software erforderlich sind, zur Hand haben. Führen Sie hierzu die Tasks aus,
die in Tabelle 8 zusammengefasst sind (siehe die entsprechenden Prozeduren).
Verwenden Sie Tabelle 14 auf Seite 93 als Datenblatt zum Aufzeichnen der Informa-
tionen über die Speichersubsysteme und Controller.

Tabelle 8. Zusammenfassung der Netzvorbereitungs-Tasks

Auszuführende Task Direkte Verwaltung
oder Verwaltung
durch Host-Agent?

Gründe für die Ausführung der
Task

Hier finden Sie
Anweisungen

Schritt 1: Installieren Sie
alle Hardwarekomponenten
(Host-Computer, Speicher-
subsysteme, Kabel usw.),
die mit dem Netz
verbunden werden sollen.

Beide Um sicherzustellen, dass die
Netzhardware vorhanden ist

Spezielles Installations-
handbuch für die Hardware-
komponenten

Abbildung 6. Beispielnetz
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Tabelle 8. Zusammenfassung der Netzvorbereitungs-Tasks (Forts.)

Auszuführende Task Direkte Verwaltung
oder Verwaltung
durch Host-Agent?

Gründe für die Ausführung der
Task

Hier finden Sie
Anweisungen

Schritt 2: Legen Sie eine
Namenskonvention für die
Speichersubsysteme fest,
die an das Netz
angeschlossen sind, und
zeichnen Sie die
Konvention auf.

Beide Hinzufügen der Speicher-
subsysteme zur Verwaltungs-
domäne nach der Installation der
Software

„Benennung der
Speichersubsysteme” auf
Seite 21

Schritt 3: Bestimmen Sie
die Hardware-Ethernet-
Adresse für jeden
Controller in allen mit dem
Netz verbundenen
Speichersubsystemen.

Direkt Installation des BOOTP-Servers,
um Netzkonfigurationsdaten an
die Controller weiterzugeben

„Ermitteln der Hardware-
Ethernet-Adresse für jeden
Controller” auf Seite 22

Schritt 4: Erfragen Sie die
IP-Adressen und Host-
Namen vom Netz-
administrator.

Beide Bei der Host-Agent-Verwaltung
benötigen Sie die IP-Adressen
und Host-Namen des Hosts, auf
dem die Software ausgeführt
werden soll. Bei der direkten
Verwaltung benötigen Sie die
IP-Adressen für jeden Controller
in den Speichersubsystemen.
Mittels der IP-Adressen wird der
BOOTP-Server so konfiguriert,
dass er die Netzkonfigurations-
daten an die Controller
weitergeben kann. Außerdem
verwenden Sie die IP-Adressen
der Controller, um die Host-
Tabelle oder die Tabelle für das
Domänennamensystem (DNS =
Domain Name System) zu
installieren.

„Ermitteln der IP-Adressen
für Hosts und Controller” auf
Seite 24

Schritt 5: Installieren Sie
den BOOTP-Server, um
die Netzkonfigurations-
daten für einen bestimmten
Controller zur Verfügung
zu stellen.

Direkt Netzkonfigurationsdaten werden
den Controllern mittels des
BOOTP-Servers zur Verfügung
gestellt.

„Einrichten des
BOOTP-Servers” auf Seite 24

Schritt 6: Prüfen Sie, ob
die TCP/IP-Software
installiert ist, und
installieren Sie die Host-
oder DNS-Tabelle.

Direkt Durch die Installation der Client-
Software auf einer Verwaltungs-
station wird sichergestellt, dass
die Verwaltungsstation so
konfiguriert ist, dass sie die
Controller über das Netz
anspricht. Wenn die Client-
Software auf dem Host installiert
ist, ist die TCP/IP-Software nach
wie vor für die erfolgreiche
Kommunikation zwischen der
Client-Software und den
Controllern erforderlich.

„Prüfen der TCP/IP-Software
und Installieren der Host-
oder DNS-Tabelle” auf
Seite 30

Kapitel 2. Vorbereitung der Installation 19



Tabelle 8. Zusammenfassung der Netzvorbereitungs-Tasks (Forts.)

Auszuführende Task Direkte Verwaltung
oder Verwaltung
durch Host-Agent?

Gründe für die Ausführung der
Task

Hier finden Sie
Anweisungen

Schritt 7: Schalten Sie die
Einheiten ein, die an das
Netz angeschlossen sind.

Beide Um sicherzustellen, dass alle
Einheiten und Verbindungen in
Betrieb sind

Spezielles Installations-
handbuch für die Hardware-
komponenten

Tabelle 9 zeigt einen Beispielinformationsdatensatz mit Einträgen für ein direkt ver-
waltetes Speichersubsystem und ein mit einem Host-Agenten verwaltetes Speicher-
subsystem.

Tabelle 9. Beispielinformationsdatensatz

Name des Speicher-
subsystems (siehe
Seite Benennung der
Speicher-
subsysteme21)

Verwaltungsart
(siehe Seite 17Wie
sollen die Speicher-
subsysteme
verwaltet werden?)

Controller — Ethernet- und IP-Adressen
sowie Host-Name (siehe Seiten 22 und 24)

Host — IP-Adresse
und Host-Name
(siehe Seite 24)

Speichersubsystem-
Bankeinrichtung

Direkt Hardware-Ethernet-
Adresse =
00a0b8020420

Hardware-Ethernet-
Adresse =
00a0b80000d8

IP-Adresse =
153.79.144.13

IP-Adresse =
153.79.144.14

Host = Denver_a Host = Denver_b

Speichersubsystem-
Entwicklung

Host-Agent IP-Adresse =
153.79.144.22

Host = Atlanta

Tabelle 14 auf Seite 93 bietet einen Datensatz, in dem Sie die Bezeichnungen für
die Speichersubsysteme, die Verwaltungsarten, die Hardware-Ethernet-Adressen
und die IP-Adressen aufzeichnen können. Kopieren Sie diese Tabelle, und vervoll-
ständigen Sie die Daten über Ihre Subsysteme und Controller. Verwenden Sie die
Informationen aus Tabelle 14 auf Seite 93, um die BOOTP-Tabelle für den Netz-
Server und die Host-Tabelle oder die Tabelle für das Domänennamensystem (DNS
= Domain Name System) zu installieren. Mit Hilfe der Daten aus Tabelle 14 auf Sei-
te 93 können Sie nach der Erstinstallation weitere Speichersubsysteme hinzufügen.
Die Spaltenüberschriften zeigen einen Seitenverweis auf detaillierte Anweisungen
über das Abrufen von Informationen an. Einen Beispieldatensatz finden Sie in
Tabelle 9.
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Benennung der Speichersubsysteme
Wenn Sie Ihr Netz aufbauen, legen Sie die Namenskonvention für die Speicher-
subsysteme fest. Nach der Installation und der ersten Ausführung der Speicher-
verwaltungssoftware werden alle Speichersubsysteme in der Verwaltungsdomäne
als <unnamed> angezeigt. Mittels des Fensters Subsystem Management können Sie
die einzelnen Speichersubsysteme umbenennen.

Die folgende Liste enthält Tipps für die Benennung von Speichersubsystemen:

v Die Zeichenzahl ist auf 30 Zeichen begrenzt. Alle vor- und nachgestellten Leer-
zeichen werden aus dem Namen gelöscht.

v Verwenden Sie ein nur einmal vorhandenes, bedeutungsvolles Benennungs-
schema, das leicht zu verstehen und einprägsam ist.

v Vermeiden Sie willkürliche Namen oder Namen, die ihre Bedeutung in der
Zukunft schnell verlieren können.

v In der Software werden die Namen der Speichersubsysteme mit dem Präfix
Speichersubsystem angezeigt. Wenn Sie daher ein Speichersubsystem in Ent-
wicklung umbenennen, wird es als Speichersubsystem Entwicklung angezeigt.

Wenn Sie sich für ein Benennungsschema entschieden haben, zeichnen Sie die
Namen für die Speichersubsysteme im Informationsdatensatz auf (Tabelle 14 auf
Seite 93).

Wenn Sie Ihr Speichersubsystem direkt verwalten, fahren Sie mit dem Schritt
„Ermitteln der Hardware-Ethernet-Adresse für jeden Controller” auf Seite 22 fort.
Wenn Sie Ihr Speichersubsystem mit dem Host-Agenten verwalten, fahren Sie mit
dem Schritt „Ermitteln der IP-Adressen für Hosts und Controller” auf Seite 24 fort.
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Ermitteln der Hardware-Ethernet-Adresse für jeden Controller
Wenn Sie die Speichersubsysteme direkt über die Ethernet-Verbindungen mit allen
Controllern verwalten möchten, verwenden Sie die folgende Prozedur. Wenn Sie die
Speichersubsysteme mittels der Host-Agent-Software verwalten möchten, übersprin-
gen Sie diese Prozedur, und fahren Sie mit dem Schritt „Ermitteln der IP-Adressen
für Hosts und Controller” auf Seite 24 fort.

1. Entfernen Sie die Frontblende (Maschinentypen 3526 und 3552) von der
Controllereinheit, wie in Abbildung Abb. 7 dargestellt. Ziehen Sie die Unterseite
der Frontblende vorsichtig heraus, um die Kontaktstifte zu lösen «1¬. Schieben
Sie dann die Frontblende nach unten «2¬.

2. Entriegeln und öffnen Sie die Hebel an den RAID-Controllern, Modelle 3526 und
3552.

Abbildung 7. Entfernen der Frontblende der Controller-Einheit (Maschinentypen 3526 und
3552)

Hardware-Ethernet-
Adressenbezeichnung

Abbildung 8. Standort der Hardware-Ethernet-Adresse (Maschinentypen 3526 und 3552)
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3. Die Etiketten für die Hardware-Ethernet-Adressen der Controller befinden sich
auf der Vorderseite jedes Controllers (siehe Abbildungen Abb. 8 auf Seite 22
und Abb. 9).

Die Adresse wird in der Form xx.xx.xx.xx.xx.xx dargestellt (Beispiel:
00.a0.b8.00.00.d8).

4. Zeichnen Sie jede Ethernet-Adresse im Informationsdatensatz auf (Tabelle 14
auf Seite 93).

5. Um die Frontblende (Maschinentypen 3526 und 3552) wieder einzusetzen,
schieben Sie die Oberkante unter den Rand am Gehäuse «1¬. Drücken Sie
anschließend gegen die Unterkante der Frontblende, bis die Kontaktstifte in den
Befestigungslöchern einrasten «2¬ (siehe Abbildung Abb. 10).

6. Fahren Sie mit dem Schritt „Ermitteln der IP-Adressen für Hosts und Controller”
auf Seite 24 fort.

Hardware-Ethernet-
Adressenbezeichnungen

Abbildung 9. Standort der Hardware-Ethernet-Adresse (Maschinentyp 3542)

Abbildung 10. Wiedereinsetzen der Frontblende der Controller-Einheit für die Modelle 3526
und 3552
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Ermitteln der IP-Adressen für Hosts und Controller

Gewünschte Verwaltungsart Gehen Sie zu

Direkte Verwaltung der Speichersubsysteme Schritt 1

Verwaltung der Speichersubsysteme mit dem Host-Agenten Schritt 2

Hinweis: Wenn Sie einige Speichersubsysteme direkt, andere mit der Host-Agent-Software
verwalten möchten, müssen Sie beide der folgenden Schritte ausführen.

1. Ordnen Sie jedem Controller in allen Speichersubsystemen im Netz eine ein-
deutige IP-Adresse und einen zugehörigen Host-Namen zu (oder erfragen Sie
diese Daten vom Netzadministrator). Zeichnen Sie die IP-Adresse und den
Host-Namen für jeden Controller im Informationsdatensatz auf (Tabelle 14 auf
Seite 93). Fahren Sie dann mit dem Schritt „Einrichten des BOOTP-Servers”
fort.

2. Wenden Sie sich an Ihren Netzadministrator, um die IP-Adresse und den Host-
Namen für jeden Host zu erhalten, auf dem Sie die Host-Agent-Software für die
Verwaltung der Speichersubsysteme installieren möchten. Zeichnen Sie die
IP-Adresse und den Host-Namen für den Host im Informationsdatensatz auf
(Tabelle 14 auf Seite 93). Fahren Sie dann mit dem Schritt „Prüfen der TCP/IP-
Software und Installieren der Host- oder DNS-Tabelle” auf Seite 30 fort.

Einrichten des BOOTP-Servers
Wenn Sie die Speichersubsysteme direkt über die Ethernet-Verbindungen mit allen
Controllern verwalten möchten, wählen Sie die Prozedur aus, die Sie für die Einstel-
lung des BOOTP-Servers verwenden möchten:

v Wenn Sie einen BOOTP-kompatiblen DHCP-Server von Microsoft verwenden,
fahren Sie mit dem Schritt „Verwenden des Microsoft DHCP als BOOTP-
kompatibler Server” fort.

v Wenn Sie einen UNIX-BOOTP-Server verwenden, fahren Sie mit dem Schritt
„Verwenden eines UNIX-BOOTP-Servers” auf Seite 29 fort.

Wenn Sie die Speichersubsysteme mittels der Host-Agent-Software verwalten
möchten, fahren Sie mit dem Schritt „Prüfen der TCP/IP-Software und Installieren
der Host- oder DNS-Tabelle” auf Seite 30 fort.

Verwenden des Microsoft DHCP als BOOTP-kompatibler Server
Sie müssen eine Version von DHCP verwenden, mit der die statische Adressierung
von BOOTP unterstützt wird. Um einen DHCP-Server verwenden zu können, muss
ein DHCP-Manager installiert sein. Wenn ein DHCP-Manager im System installiert
ist, fahren Sie mit dem Schritt „Einrichten eines DHCP-Servers” auf Seite 25 fort.
Wenn kein DHCP-Manager installiert ist, verwenden Sie das folgende Installations-
verfahren:
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Installieren des DHCP-Managers
So installieren Sie den DHCP-Manager:

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung .

2. Doppelklicken Sie auf das Symbol Netzwerk .

3. Das Fenster Netzwerk wird geöffnet. Klicken Sie auf die Registerkarte Dienste .

4. Klicken Sie auf DHCP Servernetzwerkdienste → Hinzufügen .

5. Installieren Sie Windows NT Service Pack 5 oder höher erneut, um neue
DHCP-Einstellungen oder Informationen zu erhalten, die mit dem jeweiligen Ser-
vice Pack in Zusammenhang stehen.

6. Fahren Sie mit dem Schritt „Einrichten eines DHCP-Servers” fort.

Einrichten eines DHCP-Servers
Verwenden Sie die nachstehende Prozedur sowie Tabelle 14 auf Seite 93, um den
DHCP-Server einzurichten.

Anmerkung: Bei den folgenden Schritten und Fensterbeispielen wird davon ausge-
gangen, dass Sie einen Windows NT DHCP-Server unter Verwen-
dung des zugehörigen DHCP-Managers konfigurieren.

1. Klicken Sie auf Start → Programme → Verwaltung → DHCP-Manager .

Das Fenster DHCP-Manager wird geöffnet.

2. Erstellen Sie einen Bereich. Mit einem Bereich wird eine Gruppe von Controllern
definiert, die Sie mit dem DHCP-Server konfigurieren möchten.

1.

a. Klicken Sie auf Local Machine .

b. Klicken Sie auf Scope → Create .

Das Fenster Create Scope wird geöffnet.

Abbildung 11. Fenster Create scope - (Local)
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c. Geben Sie die Anfangs- und End-IP-Adressen der Controller ein, die im Netz
konfiguriert werden sollen.

Wenn Sie beispielsweise 50 Controller im Teilnetz 153.79.144.0 konfigurie-
ren möchten, legen Sie die Anfangsadresse auf 153.79.144.1 und die End-
adresse auf 153.79.144.50 fest.

Anmerkung: Wenn die Felder nicht jeweils mindestens drei Zeichen enthal-
ten, drücken Sie die Taste für den Punkt (.), um zum nächsten
Feld weiterzugehen. Wenn Sie mit nur einem Controller arbei-
ten, geben Sie dessen Adresse als Anfangs- und als End-
adresse ein.

d. Geben Sie die Teilnetzmaske ein (die Sie beim Netzadministrator bekom-
men).

e. Legen Sie die Gültigkeitsdauer der Lease auf Unbegrenzt fest. Dadurch
wird die DHCP-Verbindung permanent.

f. Geben Sie einen Bereichsnamen und einen Kommentar ein.

g. Klicken Sie auf OK.

h. Wenn der Bereich erfolgreich erstellt wurde, klicken Sie auf Ja, um ihn zu
aktivieren.

Sie kehren zum Fenster DHCP-Manager zurück.

2. Gehen Sie wie folgt vor, um die globalen Bereichsparameter zu konfigurieren.
Durch die Bereichsparameter können Sie die Einstellungen konfigurieren, die für
alle Controller gültig sein sollen. Informationen darüber, welche Parameter für
die gesamte Gruppe gelten sollen, finden Sie unter Tabelle 8 auf Seite 18.

Anmerkung: Sie können zu einem späteren Zeitpunkt mit Schritt 4 auf Seite 28
Optionen für spezielle Controller anlegen.

a. Klicken Sie auf DHCP Options → Global .

Das Fenster DHCP Options: Global wird geöffnet.

b. Wählen Sie aus der Liste Nicht verwendete Optionen ein Element aus, und
klicken Sie auf Add , um dieses Element in die Liste Aktive Optionen zu ver-
schieben. Jeder Option ist ihre Kennnummer vorangestellt.

c. Klicken Sie auf Value , um der aktiven Option einen Wert zuzuordnen.

Wenn Value ausgeblendet ist, wird das Auswahlfenster Edit Array im unte-
ren Teil des Fensters angezeigt.

Abbildung 12. Fenster DHCP Options
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d. Wenn Sie eine IP-Adresse hinzufügen müssen, klicken Sie auf Edit Array .
Der Editor für IP-Adressen-Array wird geöffnet.

Abb. 13 zeigt ein Beispiel dafür, wie Sie die IP-Adresse für eine
Verwaltungsstation hinzufügen.

Wenn Sie keine IP-Adresse hinzufügen müssen, fahren Sie mit dem Schritt
2g fort.

e. Geben Sie die eindeutige IP-Adresse für die hinzugefügte Option ein.

f. Klicken Sie auf Add , um die neue IP-Adresse in die Liste der IP-Adressen zu
verschieben.

g. Klicken Sie auf OK. Das Fenster DHCP Options: Global wird erneut geöff-
net.

h. Wiederholen Sie die Schritte 2b auf Seite 26 bis 2g, bis alle globalen Optio-
nen hinzugefügt wurden.

i. Wenn Sie das Hinzufügen der globalen Bereichsparameter abgeschlossen
haben, klicken Sie im Fenster DHCP Options: Global auf OK. Das Fenster
DHCP-Manager wird erneut geöffnet.

3. Mit der folgenden Prozedur können Sie eine Reservierung für jeden Controller
erstellen: Verwenden Sie das Datenblatt, das Sie in Schritt Tabelle 14 auf Sei-
te 93 erstellt haben, um sicherzugehen, dass Sie alle Controller für jedes
Speichersubsystem im Netz aufnehmen.

a. Klicken Sie auf Scope → Add Reservations .

b. Geben Sie im Feld IP Address die IP-Adresse für den ersten Controller auf
Ihrem Datenblatt ein.

c. Geben Sie im Feld Unique Identifier die Ethernet-Adresse für die
Controller-Hardware ein.

d. Geben Sie im Feld Client Name den aus acht Buchstaben bestehenden
Namen des Controllers ein.

e. Klicken Sie auf Add .

Abbildung 13. Fenster IP Address Array Editor
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f. Wiederholen Sie die Schritte 3b auf Seite 27 bis 3e auf Seite 27 für jeden
Controller auf Ihrem Datenblatt. Weitere Informationen erhalten Sie unter
Tabelle 14 auf Seite 93.

g. Wenn Sie die Eingabe der Informationen für alle Controller abgeschlossen
haben, klicken Sie auf Close .

Sie kehren zum Fenster DHCP-Manager zurück.

4. Gehen Sie wie folgt vor, um die Controller-spezifischen Optionen zu konfigurie-
ren. Durch die Erstellung einer Controller-spezifischen Option können Sie einen
Konfigurationseintrag für einen Controller einem bestimmten Controller zuord-
nen, den Sie in Schritt 3 auf Seite 27 hinzugefügt haben.

Anmerkung: Wenn Sie eine Option auf Global Scope festlegen, wird diese
Option auf jeden Controller in dieser Gruppe angewendet und
muss nicht erneut hinzugefügt werden.

a. Klicken Sie auf Scope → Aktive Leases .

Das Fenster Aktive Leases wird geöffnet.

b. Wählen Sie einen Controller aus der Liste aus.

c. Klicken Sie auf Properties . Das Fenster Add Option Type hinzufügen wird
geöffnet. Bei der eindeutigen ID (UID) handelt es sich um die Hardware-
Ethernet-Adresse, die Sie in Schritt 3c auf Seite 27 hinzugefügt haben.

Abbildung 14. Fenster Aktive Leases

Abbildung 15. Fenster Add Option Type hinzufügen
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d. Klicken Sie auf Options . Das Fenster DHCP Optionen: Reservations wird
geöffnet.

e. Wählen Sie aus der Liste Unused Options einen Eintrag aus, und klicken
Sie auf Add , um den Eintrag in die Liste Active Options zu verschieben.

f. Klicken Sie auf Value , um der aktiven Option einen Wert zuzuordnen.

g. Geben Sie die Informationen zum Wert der Option ein. Geben Sie beispiels-
weise im Feld Zeichenfolge unter Host-Name den Host-Namen für den Con-
troller (von Ihrem Datenblatt, siehe Tabelle 14 auf Seite 93) ein. Klicken Sie
auf Edit wenn der Wert, den Sie hinzufügen müssen, eine IP-Adresse für
einen Router ist.

h. Wiederholen Sie die Schritte 4e bis 4g, bis Sie alle spezifischen Optionen
für diesen Controller hinzugefügt haben.

i. Klicken Sie auf OK. Sie kehren zum Fenster Add Option Type zurück.

j. Klicken Sie auf OK. Sie kehren zum Fenster Aktive Leases zurück.

k. Wiederholen Sie die Schritte 4b auf Seite 28 bis 4j, bis Sie alle Controller-
spezifischen Optionen für jeden Controller hinzugefügt haben.

l. Wenn Sie die spezifischen Optionen für alle Controller hinzugefügt haben,
klicken Sie im Fenster Aktive Leases auf OK. Sie kehren zum Fenster DHCP
Manager zurück.

5. Fahren Sie mit dem Schritt „Prüfen der TCP/IP-Software und Installieren der
Host- oder DNS-Tabelle” auf Seite 30 fort.

Verwenden eines UNIX-BOOTP-Servers
Tabelle 10 und Tabelle 14 auf Seite 93 bieten Informationen zum Einrichten der
BOOTP-Tabelle und zum Erstellen der erforderlichen Einträge, um die Controller in
den Speichersubsystemen zu unterstützen. Bearbeiten Sie die Datei bootptab im
Verzeichnis /etc mit einem Texteditor.

Tabelle 10. Notwendige Einträge für das Einrichten des UNIX-BOOTP-Servers

Eintrag Beschreibung Beispielformat im
BOOTP-Server

Teilnetzmaske Maske, die zur Weiterleitung von Paketen an
definierte Teilnetze verwendet wird

Punktnotation
(sm=255.255.248.0)

Router IP-Adresse des Hosts, der die Pakete ans Netz
weiterleitet

Punktnotation
(gw=153.79.144.2)

Host-Name für
den Controller

Host-Name, der dem Controller zugeordnet ist
(siehe Tabelle 14 auf Seite 93)

Host-Name (Den-
ver_a)

IP-Adresse IP-Adresse des Controllers (siehe Tabelle 14 auf
Seite 93)

Punktnotation
(ip=153.79.144.13)

Ethernet-Adresse Die Ethernet-Adresse der Controller-Hardware
(siehe Tabelle 14 auf Seite 93)

Hexadezimale
Notation
(ha=00a0b8020420)
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Anmerkung: Die RMS- und NMS-Einträge, die in früheren Versionen der Speicher-
verwaltungssoftware Version 6.22 verwendet wurden, sind nicht erfor-
derlich, wenn Sie die Speichersubsysteme mit dem Storage Manager
7.02 und Controllern mit der Firmware-Version 4.x verwalten.

Beispiel für die Bearbeitung einer UNIX-BOOTP-Tabelle
Beim folgenden Beispiel einer BOOTP-Tabelle wird davon ausgegangen, dass Sie
einen UNIX-BOOTP-Server, z.B. einen Server im Netz A wie unter Abb. 6 auf Sei-
te 18 beschrieben, konfigurieren. Mit dem Eintrag s4.default:\ werden die Einstellun-
gen gekennzeichnet, die für alle Controller gleichermaßen gelten. Mit dem Eintrag
tc=s4.default:\ wird diese allgemeine Einstellungsgruppe einem bestimmten Control-
ler zugeordnet.

s4.default:\ (allgemeine Einstellungen)

ht=ether:\ sm=255.255.248.0:\ gw=153.79.144.2:\ hn: denver_a:\ tc=s4.default:\
(bezieht sich auf allgemeine Einstellungen) ip=153.79.144.13:\ ha=00a0b8020420:
denver_b:\ tc=s4.default:\ ip=153.79.144.14:\ ha=00a0b80000d8:

Wenn Sie die BOOTP-Tabelle eingerichtet haben, gehen Sie folgendermaßen vor:

1. Schalten Sie die Speichersubsysteme ein, so dass die Parameter in der
BOOTP-Tabelle wirksam werden.

2. Wenn Sie die BOOTP-Tabelle eingerichtet haben, fahren Sie mit dem Schritt
„Prüfen der TCP/IP-Software und Installieren der Host- oder DNS-Tabelle” fort.

Prüfen der TCP/IP-Software und Installieren der Host- oder DNS-
Tabelle

Stellen Sie sicher, dass die Host-Namen für die Controller mit den entsprechenden
Internet Protocol-Adressen für die Controller übereinstimmen. Mit der folgenden
Prozedur können Sie prüfen, ob die TCP/IP-Software auf der Verwaltungsstation
installiert ist und die Host- oder DNS-Tabelle einrichten.

Anmerkung: Sie können anstatt des DNS auch den Windows Internet Name Ser-
vice (WINS) verwenden.

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Netzwerk → Pro-
tokolle , um zu prüfen, ob die TCP/IP-Software ordnungsgemäß installiert und
konfiguriert ist.

Anmerkung: Wenn die TCP/IP-Software nicht ordnungsgemäß installiert
wurde, nehmen Sie eine erneute Installation anhand der Windows
NT 4.0-Installations-CD vor. Klicken Sie auf Start → Einstellun-
gen → Systemsteuerung → Netzwerk → Protokolle →
Hinzufügen →Diskette .

2. Aktualisieren Sie entweder die Host- oder die DNS-Tabelle, um einen Host-
Namen anzugeben, der einer IP-Adresse zugeordnet werden kann. Wenn Sie
nicht über ein DNS verfügen, bearbeiten Sie die beiden Host-Tabellen, die sich
in den folgenden Verzeichnissen befinden:

c:\winnt\system32\drivers\etc\hosts

c:\winnt\system32\drivers\etc\imhosts
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Wenn Sie beispielsweise die Host-Tabellen für die Controller einrichten möch-
ten, die mit Netz A verbunden sind Abb. 6 auf Seite 18), erstellen Sie mit einem
Texteditor die folgenden Einträge für IP-Adressen und Controller-Namen:

IP-Adresse Host-Name für den Controller

127.0.0.01 localhost

153.79.144.13 denver_a

153.79.144.14 denver_b

3. Wenn Sie Speichersubsysteme über eine Firewall verwalten möchten, fahren
Sie mit dem Schritt „Aktivieren der Anschlüsse für den Betrieb über eine Fire-
wall” fort. Andernfalls fahren Sie mit dem Schritt „Vorbereiten der Installation der
Speicherverwaltungssoftware” fort.

Aktivieren der Anschlüsse für den Betrieb über eine Firewall
Wenn Sie die Speichersubsysteme über eine Firewall mit Paketfilterung verwalten
möchten, konfigurieren Sie die Firewall so, dass der Anschluss 2463 für die TCP-
Daten geöffnet wird.

Vorbereiten der Installation der Speicherverwaltungssoftware
Sie haben die Vorbereitungs-Tasks durchgeführt und sind nun bereit zum Installie-
ren der Speicherverwaltungssoftware. Welchen Installationsprozess Sie ausführen,
hängt davon ab, wie Sie Ihr System konfigurieren möchten.

Gewünschte Installationsart Gehen Sie zu

Installation der Software in einer Standard-
konfiguration (keine Cluster-Konfiguration)

„Kapitel 3. Installieren der Software in einer
Standardkonfiguration” auf Seite 33.

Installation der Software in einer Cluster-
Server-Umgebung

„Kapitel 4. Installieren von Software in einer
Cluster-Server-Umgebung” auf Seite 45.

Kapitel 2. Vorbereitung der Installation 31
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Kapitel 3. Installieren der Software in einer Standard-
konfiguration

In diesem Kapitel wird beschrieben, wie Sie die Speicherverwaltungssoftware in
einer Standardkonfiguration (keine Cluster-Konfiguration) installieren.

Wichtig: Suchen Sie auf jedem Installationsdatenträger nach einer README-Datei.
Diese README-Datei enthält möglicherweise wichtige Informationen, die noch nicht
verfügbar waren, als das vorliegende Handbuch vorbereitet wurde.

Installationsvorbereitung
Die Speicherverwaltungssoftware kann unter zwei Konfigurationen installiert wer-
den:

v Sie verfügen bisher noch nicht über Speichersubsysteme. In diesem Fall installie-
ren Sie neue Speichersubsysteme mit Controllern der Maschinentypen 3526,
3542 oder 3522 mittels der Firmware-Version 4.x und verwalten diese neuen
Speichersubsysteme mit Storage Manager 7.02. Wenn dieser Fall auf Sie zutrifft,
fahren Sie mit dem Schritt „Neuer Installationsprozess” auf Seite 35 fort.

v Sie verfügen bereits über Speichersubsysteme mit Controllern der Maschinen-
typen 3526, 3552 oder 3542. In diesem Fall können Sie folgendermaßen vorge-
hen:

– Aktualisieren Sie die Controller-Firmware der vorhandenen Speicher-
subsysteme auf die Version 4.x, und verwalten Sie die Subsysteme mit Sto-
rage Manager 7.02.

– Verwalten Sie die Speichersubsysteme weiterhin mit der Version 6.22 der
Speicherverwaltungssoftware. Sie können diese Speichersubsysteme auch in
Koexistenz mit neuen Speichersubsystemen verwalten, die Sie mit Storage
Manager 7.02 verwalten. Informationen darüber, ob Sie über koexistierende
Speichersubsysteme verfügen, finden Sie unter „Verwalten neuer und beste-
hender Speichersubsysteme, die an denselben Host angeschlossen sind” auf
Seite 13.
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Bestimmen Sie den für Sie geeigneten Installationsprozess anhand von Tabelle 11.

Tabelle 11. Festlegen des Installationsprozesses in einer Standardkonfiguration (keine Cluster-Konfiguration)

Aktuelle Umgebung Geplante Umgebung Aktion

Keine Speichersubsysteme
vorhanden

Neue Speichersubsysteme mit Controllern,
die Firmware der Version 4.00.02
verwenden und mit Storage Manager 7.02
verwaltet werden

Fahren Sie mit dem Schritt „Neuer
Installationsprozess” auf Seite 35 fort.

Bestehende Speicher-
subsysteme mit Controllern,
die Firmware der Version 3.x
(Maschinentyp 3526) und
Speicherverwaltungssoftware
der Version 6.22 verwenden

Upgrade der Speichersubsysteme auf
Controller, die Firmware der Version
4.00.02 verwenden und mit Storage
Manager 7.02 verwaltet werden.

Fahren Sie mit dem Schritt „Kapitel 6.
Migrationsprozess” auf Seite 69 fort.

Bestehende Speicher-
subsysteme mit Controllern,
die Firmware der Versionen
4.00.00 bis 4.00.01 und
Speicherverwaltungssoftware
der Version 7.00 oder 7.01
(Maschinentypen 3526 und
3552) verwenden

Upgrade der Speichersubsysteme auf
Controller, die Firmware der Version
4.00.02 verwenden und mit Storage
Manager 7.02 verwaltet werden

1. Deinstallieren Sie die Speicher-
verwaltungssoftware Version 7.0 oder
7.01 mit Hilfe der Prozeduren, die im
Installationshandbuch für die
vorherige Version der Speicher-
verwaltungssoftware beschrieben
sind.

2. Fahren Sie mit dem Schritt „Neuer
Installationsprozess” auf Seite 35 fort.

3. Aktualisieren Sie unter Verwendung
der Online-Hilfefunktion der Speicher-
verwaltungssoftware die NVSRAM
und die Firmware auf Version
4.00.02.

Weitere Verwendung der vorhandenen
Versionen 4.00.00 bis 4.00.01 der
Controller-Firmware. Achten Sie darauf,
dass die vorherigen Versionen der
Speicherverwaltungssoftware deinstalliert
werden, bevor Sie die Version 7.02
installieren. Sie können diese bestehenden
Speichersubsysteme mit dem Storage
Manager 7.02 verwalten, der Komponenten
enthält, die mit diesen älteren Firmware-
Versionen kompatibel sind. Informationen
zu den Unterschieden in der Funktions-
weise zwischen Ihrer vorhandenen
Controller-Firmware und der Firmware-
Version 4.00.02 finden Sie auf der
Installations-CD. Weitere Informationen
erhalten Sie in der README-Datei, die sich
im Verzeichnis \NT\ auf der Installations-CD
befindet.

1. Deinstallieren Sie die Speicher-
verwaltungssoftware Version 7.0 oder
7.01 mit Hilfe der im Installations-
handbuch für die vorherige Version
der Speicherverwaltungssoftware
beschriebenen Prozeduren.

2. Fahren Sie mit dem Schritt „Neuer
Installationsprozess” auf Seite 35 fort.
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Neuer Installationsprozess
Beginnen Sie die Installation der Speicherverwaltungssoftware mit Schritt „Installie-
ren des SM7client-Pakets” auf Seite 37. Setzen Sie den Prozess fort, bis Sie Schritt
„Installieren des SM7agent-Pakets” auf Seite 42 abgeschlossen haben. Sie müssen
das Migrationsdienstprogramm nicht installieren oder verwenden.

Abb. 16 zeigt ein Ablaufdiagramm des Installationsprozesses.

Installieren Sie das Client-Paket.

Installieren Sie das RDAC-Paket.

Installieren Sie Microsoft Virtual Machine

Installieren Sie das Host-Agent-Paket.

Beenden Sie die Installation.

Abbildung 16. Installationsprozess
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Installation mit bestehenden Speichersubsystemen
Beginnen Sie diese Installation mit Schritt „Installieren des SM7client-Pakets” auf
Seite 37. Setzen Sie den Prozess fort, bis Sie Schritt „Installieren des
SM7agent-Pakets” auf Seite 42 abgeschlossen haben. Wenn Sie anschließend die
Controller-Firmware bei den bestehenden Speichersubsystemen auf Version 4.x
aktualisieren, fahren Sie mit dem Schritt „Installieren von SM7migrate” auf Seite 75
fort.

Abb. 17 zeigt ein Ablaufdiagramm des Installationsprozesses mit bestehenden
Speichersubsystemen.

Möchten Sie
einen kürzlich

installierten Maschinentyp
3526 Controller mit
Storage Manager 7

verwalten?

Möchten Sie ein
Speichersubsystem auf
Firmware-Stufe 3.x oder

3.01.03 migrieren?

Ja

Nein

Ja
3.x

Installieren Sie das Client-Paket.

Beenden Sie die Installation.

Führen Sie mit dem Migrationsdienst-
programm ein Upgrade der Firmware
auf diesen Speichersubsystemen von

Version 3.01.x auf 3.01.03 durch

Installieren Sie das
Migrationsdienstprogramm

Laden Sie mit dem Migrations-
dienstprogramm eine

NVSRAM-Datei herunter

Führen Sie mit dem Migrationsdienst-
programm ein Upgrade der Firmware
von Version 3.01.03 auf 4.00x durch

Beenden Sie die Installation.

Installieren Sie das RDAC-Paket.

Installieren Sie Microsoft
Virtual Machine

Installieren Sie das
Host-Agent-Paket

Wenn der Host, der dem Speichersubsystem
physikalisch zugeordnet ist, das
Windows NT Betriebssystem nicht ausführt,
installieren Sie nur das Client-Paket.
Installieren Sie auch das Migrationsdienstprogramm,
wenn Sie mit dem Storage Manager 7 bestehende
Speichersubsysteme mit Maschinentyp 3526 Controllern
verwalten möchten.

Abbildung 17. Installationsprozess mit bestehenden Speichersubsystemen
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Installieren des SM7client-Pakets
Wenn Sie den SM7client auf einer Verwaltungsstation installieren möchten, die mit
einem der nachstehenden Programme konfiguriert ist, gehen Sie folgendermaßen
vor:

v Windows NT Server 4.0 mit Service Pack 5 oder höher

v Windows NT Workstation 4.0 mit Service Pack 5 oder höher

Wichtige Hinweise:

v Wenn Sie lediglich eine vernetzte Verwaltungsstation konfigurieren, müssen Sie
nur den SM7client installieren.

v Wenn Sie den SM7client auf einem eigenständigen Host installieren und die
Speichersubsysteme über den Fibre Channel-E/A-Pfad anstatt über das Netz
verwalten möchten, müssen Sie die TCP/IP-Software auf dem Host installieren
und dem Host eine statische IP-Adresse zuordnen. Als Betriebssystem des Hosts
muss Windows NT Server 4.0 oder Windows NT Workstation 4.0 installiert sein.

Installationsanweisungen
Überprüfen Sie vor dem Installieren der Software folgende Punkte:

v Die Verwaltungsstation weist mindestens 20 MB verfügbaren Plattenspeicherplatz
auf.

v Die Anzeigemerkmale sind auf eine Mindestbildschirmauflösung von 800x600
Pixeln und eine Palette von 256 Farben oder mehr festgelegt.

v Sie haben alle anderen Programme geschlossen.

So installieren Sie das SM7client-Paket:

1. Legen Sie die IBM Netfinity FAStT Storage Manager-CD in das CD-ROM-
Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software . Das
Fenster Eigenschaften von Software wird geöffnet.

3. Klicken Sie auf Installieren , und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen . Das Fenster Durchsuchen wird geöffnet.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis \NT\SM7client aus.

7. Wählen Sie die Datei setup.exe aus, und klicken Sie anschließend auf Öffnen .

8. Klicken Sie auf Fertigstellen . Das Fenster Willkommen des Konfigurations-
programms wird geöffnet.

9. Klicken Sie auf Weiter , um mit der Installation zu beginnen.

Das Fenster Bestimmungsort auswählen wird geöffnet.

10. Klicken Sie auf Durchsuchen , wenn Sie den Bestimmungsort ändern möch-
ten.

11. Klicken Sie auf Weiter .

12. Wenn die Installation abgeschlossen ist, klicken Sie auf Fertigstellen .
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Prüfen der SM7client-Installation
Prüfen Sie mittels folgender Prozedur, ob die Installation erfolgreich war:

1. Klicken Sie auf Start → Programme .

2. Prüfen Sie, ob der “Netfinity Fibre Channel Storage Manager-Client” in der Liste
der Programme angezeigt wird.

3. Wenn Sie den SM7client lediglich auf einer Verwaltungsstation installieren, fah-
ren Sie mit dem Schritt „Kapitel 5. Beenden der Installation” auf Seite 61 fort.
Andernfalls fahren Sie mit dem Schritt „Installieren des RDAC-Pakets” fort.

Installieren des RDAC-Pakets
Gehen Sie bei der Installation des RDAC-Pakets auf einem Host, der mit einem
oder mehreren Speichersubsystemen verbunden ist, folgendermaßen vor:

Das RDAC-Paket enthält die folgenden Komponenten:

v den Multipath-Einheitentreiber, der für die Überbrückungsunterstützung des Cont-
rollers erforderlich ist;

v das Dienstprogramm Hot Add für ein dynamisches Hinzufügen logischer Lauf-
werke zum Betriebssystem (siehe „Verwenden des Hot-Add-Dienstprogramms”
auf Seite 86).

Wichtig: Sie müssen RDAC vor dem SM7agent-Paket installieren.

Zuordnen von Laufwerkbuchstaben

Anmerkung: Wenn Sie die RDAC-Software unter einer bestehenden Konfiguration
installieren, fahren Sie mit dem Schritt „Installationsanweisungen” auf
Seite 40 fort.

Beim Installationsverfahren wird der RDAC-Einheitentreiber vor dem ursprünglichen
Einheitentreiber der Windows NT-Klasse installiert. Dieser Vorgang ist erforderlich,
um RDAC zu aktivieren. Dies bedeutet jedoch, dass das System die logischen
Laufwerke der Speichersubsysteme erkennt, bevor es andere lokale Laufwerke
erkennt. Entsprechend werden die Laufwerkbuchstaben zugeordnet.

Anmerkung: Bevor Sie diese Software installieren, müssen Sie den bestehenden
lokalen Laufwerken statische Laufwerkbuchstaben zuordnen.

Mittels der folgenden Prozedur können Sie feststellen, ob Sie statische Laufwerk-
buchstaben zuordnen müssen, und sie dann zuordnen, falls dies erforderlich ist:

1. Schalten Sie das Speichersubsystem aus, um zu verhindern, dass der
Festplatten-Manager (WINDISK) gesperrt wird, während Sie Laufwerk-
buchstaben zuordnen und den RDAC-Einheitentreiber installieren.

2. Klicken Sie auf Start → Programme → Verwaltung → Festplatten-Manager , um
die Datenträgerkonfiguration anzuzeigen und die Anzahl der Partitionen zu über-
prüfen.

v Wenn Sie lediglich über eine Partition verfügen, fahren Sie mit Schritt 4 fort.

v Wenn Sie über zwei Partitionen verfügen, fahren Sie mit Schritt 3 fort.

38 IBM Netfinity FAStT Storage Manager Version 7.02 for Windows NT: Installations- und Unterstützungshandbuch



3. Wenn Sie über mindestens zwei Partitionen verfügen (die Boot-Partition und
eine weitere Partition) und die beiden folgenden Bedingungen zutreffen, fahren
Sie mit Schritt „Installationsanweisungen” auf Seite 40 fort.

v Die letzte Partition, die Sie erstellt haben, wurde mit dem Festplatten-
Manager erstellt.

v Der Partition wurde ein Laufwerkbuchstabe zugeordnet, und sie weist den
Status Unbekannt auf oder verfügt über ein Dateisystem (d.h., sie weist nicht
den Status Unformatiert auf).

4. Gehen Sie wie folgt vor, um eine neue Partition zu erstellen:

a. Wählen Sie ein Laufwerk aus, das genügend freien Plattenspeicherplatz auf-
weist.

b. Klicken Sie auf Partition → Erstellen . Die Partition wird erstellt. (Ein
Laufwerkbuchstabe wird zugeordnet, und der Status der Partition lautet
Unformatiert.)

c. Klicken Sie auf Partition → Änderungen jetzt festschreiben . Der Status der
Partition wird in Unbekannt geändert, und die statischen Laufwerk-
buchstaben werden allen bestehenden Partitionen zugeordnet.

5. Fahren Sie mit Schritt „Installationsanweisungen” auf Seite 40 fort.
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Installationsanweisungen
Stellen Sie vor dem Installieren der Software Folgendes sicher:

v Sie verfügen über Administratorberechtigungen auf dem Host.

v Der Host ist mit Windows NT 4.0 und Service Pack 5 oder höher konfiguriert.

v Der Host weist mindestens 1 MB verfügbaren Plattenspeicherplatz auf.

v Die Anzeigemerkmale sind auf eine Mindestbildschirmauflösung von 640x480
Pixeln und eine Palette von 256 Farben oder mehr festgelegt.

v Sie haben alle anderen Programme geschlossen.

So installieren Sie die RDAC-Software:

1. Legen Sie die IBM Netfinity FAStT Storage Manager-CD in das CD-ROM-
Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird geöffnet.

3. Klicken Sie auf Installieren , und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen .

Das Fenster Durchsuchen wird geöffnet.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis \NT\RDAC aus.

7. Wählen Sie die Datei setup.exe aus, und klicken Sie anschließend auf Öffnen .

8. Klicken Sie auf Fertigstellen .

Das Fenster Willkommen des Konfigurationsprogramms wird geöffnet.

9. Klicken Sie auf Weiter , um mit der Installation zu beginnen.

Wenn RDAC installiert ist, wird das Fenster Setup Complete geöffnet.

10. Klicken Sie auf Nein, ich werde den Computer später neu starten . Klicken
Sie anschließend auf Fertigstellen .

11. Klicken Sie auf Start → Beenden .

Das Fenster Shut Down Windows wird geöffnet.

12. Klicken Sie auf Shutdown , um den Server herunterzufahren.

13. Schalten Sie das Speichersubsystem ein.

14. Wenn das Speichersubsystem vollständig eingeschaltet ist, schalten Sie den
Host ein, um sicherzustellen, dass die Änderungen wirksam werden.

Prüfen der RDAC-Installation
Prüfen Sie mittels folgender Prozedur, ob die Installation erfolgreich war:

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Devices .

Das Fenster Devices wird geöffnet.

2. Blättern Sie durch die Liste der Geräte, und wählen Sie anschließend symarray
aus.

3. Stellen Sie sicher, dass der Status des Geräts symarray Started lautet.

4. Fahren Sie mit dem Schritt „Installieren von Microsoft Virtual Machine (MSVM)”
auf Seite 41 fort.
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Installieren von Microsoft Virtual Machine (MSVM)
Gehen Sie bei der Installation von Microsoft Virtual Machine (MSVM) auf einem
Host, der mit einem oder mehreren Speichersubsystemen verbunden ist, folgender-
maßen vor:

Wichtig: Sie müssen Microsoft Virtual Machine (MSVM) vor dem SM7agent instal-
lieren. Die Installations-CD des Netfinity FAStT Storage Manager 7.02 enthält eine
Version der Microsoft VM, die mit der Speicherverwaltungssoftware getestet wurde.
Bevor Sie diese Version installieren, besuchen Sie unsere Website unter
http://www.ibm.com/pc/support, um festzustellen, ob eine neuere Version der Soft-
ware verfügbar ist. Überprüfen Sie auf der Website außerdem, ob aktuelle Unter-
stützungsdaten vorliegen.

Installationsanweisungen
Stellen Sie vor dem Installieren der Software Folgendes sicher:
v Sie verfügen über Administratorberechtigungen auf dem Host.
v Der Host ist mit Windows NT 4.0 und Service Pack 5 oder höher konfiguriert.
v Der Host weist mindestens 1 MB verfügbaren Plattenspeicherplatz auf.
v Die Anzeigemerkmale sind auf eine Mindestbildschirmauflösung von 640x480

Pixeln und eine Palette von 256 Farben oder mehr festgelegt.
v Sie haben alle anderen Programme geschlossen.

So installieren Sie Microsoft Virtual Machine (MSVM) auf einem Host:

1. Legen Sie die IBM Netfinity FAStT Storage Manager-CD in das CD-ROM-
Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird geöffnet.

3. Klicken Sie auf Installieren , und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen .

Das Fenster Durchsuchen wird geöffnet.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis \NT\SM7agent aus.

7. Wählen Sie die Datei msjavx86.exe aus, und klicken Sie anschließend auf Öff-
nen .

8. Klicken Sie auf Fertigstellen , und befolgen Sie die Anweisungen auf dem Bild-
schirm.

Wenn das Programm neuere Dateien findet, werden Sie dazu aufgefordert, die
älteren Dateien zu überschreiben. Klicken Sie auf Ja. Wenn die Software
installiert ist, wird das Fenster Setup Complete geöffnet.

Wenn Service Pack 6a installiert ist, werden Sie aufgefordert, einen Warmstart
durchzuführen. Klicken Sie auf Ja, um den Host erneut zu starten.

Anmerkung: Sie müssen den Host erneut starten, um sicherzustellen, dass
alle Änderungen wirksam werden.

9. Nach der Installation von SM7agent und dem erneuten Starten des Hosts
installieren Sie Service Pack 6a erneut. Falls Sie diesen Schritt auslassen,
startet der Agent-Service nicht ordnungsgemäß.

10. Klicken Sie auf Ja, um den Host erneut zu starten.

11. Fahren Sie mit dem Schritt „Installieren des SM7agent-Pakets” auf Seite 42
fort.
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Installieren des SM7agent-Pakets
Gehen Sie bei der Installation von SM7agent auf einem Host, der mit einem oder
mehreren Speichersubsystemen verbunden ist, folgendermaßen vor: Der SM7agent
besteht aus den folgenden Komponenten:

v der Host-Agent-Software, die für die Verwaltung der Speichersubsysteme über
den Host-Agenten erforderlich ist;

v dem Dienstprogramm SM7devices, mittels dessen die Beziehung der logischen
Laufwerke zu den Einheitennamen des Betriebssystems angezeigt wird. Weitere
Informationen finden Sie unter „Verwenden des Dienstprogramms SM7devices”
auf Seite 86.

Wichtig: Sie können den SM7agent erst installieren, wenn RDAC installiert ist. Mic-
rosoft Virtual Machine ist ebenfalls eine Komponente, die für die Installation und die
Verwendung des SM7agent erforderlich ist. Sie müssen den SM7agent selbst dann
installieren, wenn Sie die Speichersubsysteme nicht über die Host-Agent-Software
verwalten möchten.

Installationsanweisungen
Stellen Sie vor dem Installieren der Software Folgendes sicher:

v Sie verfügen über Administratorberechtigungen auf dem Host.

v Der Host ist mit Windows NT 4.0 und Service Pack 5 oder höher konfiguriert.

v Der Host weist mindestens 1 MB verfügbaren Plattenspeicherplatz auf.

v Die Anzeigemerkmale sind auf eine Mindestbildschirmauflösung von 640x480
Pixeln und eine Palette von 256 Farben oder mehr festgelegt.

v Sie haben RDAC und Microsoft Virtual Machine (MSVM) bereits installiert.

v Sie haben alle anderen Programme geschlossen.

So installieren Sie den SM7agent:

1. Legen Sie die IBM Netfinity FAStT Storage Manager-CD in das CD-ROM-
Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird geöffnet.

3. Klicken Sie auf Installieren , und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen .

Das Fenster Durchsuchen wird geöffnet.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis \NT\SM7agent aus.

7. Wählen Sie die Datei setup.exe aus, und klicken Sie anschließend auf Öffnen .

8. Klicken Sie auf Fertigstellen .

Das Fenster Willkommen des Konfigurationsprogramms wird geöffnet.

9. Klicken Sie auf Weiter , um mit der Installation zu beginnen.

Wenn SM7agent installiert ist, wird das Fenster Setup Complete geöffnet.

Anmerkung: Sie müssen den Host erneut starten, um sicherzustellen, dass
alle Änderungen wirksam werden.

10. Klicken Sie auf Finish , um den Host erneut zu starten.
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Prüfen der SM7agent-Installation
Prüfen Sie mittels folgender Prozedur, ob die Installation erfolgreich war:

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Services . Das
Fenster Services wird geöffnet.

2. Blättern Sie durch die Liste der Services, bis Sie “Netfinity Fibre Channel Sto-
rage Manager 7agent” finden.

3. Stellen Sie sicher, dass der Status des Agent-Service Started lautet.

Anmerkung: Wenn Sie die Host-Agent-Software nicht zur Verwaltung der
Speichersubsysteme verwenden, können Sie den Host-Agent-
Service ausschalten. Klicken Sie auf Start → Einstellungen →
Systemsteuerung → Services . Wählen Sie aus der Liste der
angezeigten Services den Host-Agenten aus, und klicken Sie auf
Startup . Klicken Sie unter Startup Type auf Manuell und
anschließend auf OK.

4. Fahren Sie mit dem Schritt „Kapitel 5. Beenden der Installation” auf Seite 61
fort.
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Kapitel 4. Installieren von Software in einer Cluster-Server-
Umgebung

In diesem Kapitel wird beschrieben, wie Hardwarekomponenten und Speicher-
verwaltungssoftware in der Mehrfach-Host-Umgebung mit Cluster-Server-Software
installiert werden.

Wichtig: Prüfen Sie immer, ob eine README-Datei auf dem Installations-
datenträger vorhanden ist. Diese README-Datei enthält wichtige Informationen, die
bei der Erstellung dieses Installations- und Unterstützungshandbuchs noch nicht zur
Verfügung standen.

Installationsvorbereitung
Zur Installation der Speicherverwaltungssoftware stehen zwei Konfigurationen zur
Verfügung:

v Sie haben keine bestehenden Speichersubsysteme.

v Sie haben bestehende Speichersubsysteme.

Bevor Sie die Installation von Storage Manager 7.02 beginnen, lesen Sie den
Abschnitt „Installieren der Hardware” auf Seite 47, um sicherzustellen, dass alle
Hardwarekomponenten für die Cluster-Server-Konfiguration ordnungsgemäß instal-
liert sind. Bestimmen Sie dann anhand des Abschnitts Tabelle 12 den Installations-
prozess.

Tabelle 12. Bestimmen des Installationsprozesses in eine Cluster-Server-Umgebung

Aktuelle Umgebung Geplante Umgebung Aktion

Keine bestehenden Speicher-
subsysteme

Neue Speichersubsysteme mit Controllern,
die über Firmware mit der Version 4.00.02
verfügen und mit Storage Manager 7.02
verwaltet werden.

Fahren Sie mit „Neue Installation” auf
Seite 46 fort.

Bestehende Speicher-
subsysteme mit Controllern,
die über Firmware der
Version 3.x verfügen
(Maschinentyp 3526) und
Speicherverwaltungssoftware
Version 6.22

Upgraden von Speichersubsystemen mit
Controllern, die über Firmware der Version
4.00.02 verfügen und mit Storage Manager
7.02 verwaltet werden.

Fahren Sie mit „Migrationsprozess für
eine Windows NT-Cluster-Konfiguration”
auf Seite 59 fort.
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Tabelle 12. Bestimmen des Installationsprozesses in eine Cluster-Server-Umgebung (Forts.)

Aktuelle Umgebung Geplante Umgebung Aktion

Bestehende Speicher-
subsysteme mit Controllern,
die über Firmware der
Versionen 4.00.00 bis 4.00.01
und Speicherverwaltungs-
software der Versionen 7.00
oder 7.01 verfügen
(Maschinentyp 3526 oder
3552)

Upgraden von Speichersubsystemen mit
Controllern, die über Firmware der Version
4.00.02 verfügen und mit Storage Manager
7.02 verwaltet werden.

Fahren Sie mit „Upgraden einer früheren
Version der Speicherverwaltungssoftware
in einer Cluster-Server-Konfiguration” auf
Seite 56 fort.

Verwenden Sie die bestehenden Versionen
4.00.00 bis 4.00.01 der Controller-Firmware
weiter. Stellen Sie sicher, dass vorherige
Versionen der Speicherverwaltungssoftware
deinstalliert sind, bevor Sie die Version 7.02
installieren. Sie können diese bestehenden
Speicherverwaltungssysteme mit Storage
Manager 7.02 verwalten, der Komponenten
enthält, die mit diesen älteren Firmware-
Versionen kompatibel sind. Die funktionalen
Unterschiede zwischen der bestehenden
Controller-Firmware und der Controller-
Firmware 4.00.02 werden auf der
Installations-CD erläutert. Weitere
Informationen hierzu finden Sie in der
README-Datei im Verzeichnis \NT\ auf der
Installations-CD.

Fahren Sie mit „Upgraden einer früheren
Version der Speicherverwaltungssoftware
in einer Cluster-Server-Konfiguration” auf
Seite 56 fort.
Anmerkung: Wenn Sie mit diesem
Verfahren die Versionen 4.00.00 bis
4.00.01 der Controller-Firmware weiterhin
verwenden möchten, aktualisieren Sie
das NVSRAM und die Controller-
Firmware nicht auf die Version 4.00.02.

Neue Installation
Bevor Sie die neue Installation beginnen, lesen Sie den Abschnitt „Installieren der
Hardware” auf Seite 47, um sicherzustellen, dass alle Hardwarekomponenten für die
Cluster-Server-Umgebung ordnungsgemäß installiert sind. Beginnen Sie dann mit
dem Installationsprozess im Abschnitt „Installieren des SM7client-Pakets” auf Sei-
te 49. Fahren Sie mit dem Prozess fort, bis der Abschnitt „Installieren der
Cluster-Server-Software” auf Seite 55 abgeschlossen ist. Sie brauchen das
Migrations-Dienstprogramm weder zu installieren noch auszuführen.

Wichtig: Nachdem die Speichersubsysteme mit beiden Knoten verbunden sind,
starten Sie Windows NT erst dann gleichzeitig auf beiden Knoten, wenn Sie die
Cluster-Software auf mindestens einem Knoten installiert haben. Um den Windows
NT-Systemstart auf Knoten B auszusetzen, drücken Sie die Leertaste beim System-
start des Betriebssystems. Installieren Sie die Cluster-Software erst, wenn Sie dazu
aufgefordert werden.

Unter Abb. 18 auf Seite 47 ist ein Ablaufdiagramm des Installationsprozesses der
Speicherverwaltungssoftware für eine neue Installation dargestellt.
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Installieren Sie das Client-Paket.

Installieren Sie das RDAC-Paket.

Installieren Sie Microsoft Virtual Machine

Installieren Sie das Host-Agent-Paket.

Beenden Sie die Installation.

Installieren der Hardware
Die Hardwareinstallation beinhaltet die Installation von Host-Adaptern und Speicher-
subsystemen.

Host-Adapter
Informationen zu spezifischen Installationsvoraussetzungen und Prozeduren erhal-
ten Sie in der entsprechenden Dokumentation des Host-Adapters. Folgende Punkte
sollten berücksichtigt werden:

v Sie können zwei Host-Adapter in jedem Knoten installieren, um beide Controller
in einem Speichersubsystem über zwei Kabel mit jedem Knoten zu verbinden.
Wenn Sie beispielsweise Einzelkanal-Host-Adapter verwenden und die Dual-
Path-Konfiguration wünschen, müssen Sie auf jedem Knoten zwei Host-Adapter
installieren. Unter Abb. 19 auf Seite 48 werden Beispiele für Fibre Channel
Single- und Dual-Path-Verbindungen dargestellt.

v Stellen Sie in einem Multi-Knotensystem sicher, dass jeder Host-Adapter zu
Diagnosezwecken über eine eindeutige Leitungsschleifen-ID verbunden ist. Infor-
mationen zum Festlegen der Leitungsschleifen-ID finden Sie in der Dokumenta-
tion des Host-Adapters.

v Laden Sie den Treiber für den Host-Adapter. Informationen zu unterstützten Host-
Adaptern und Einheitentreibern erhalten Sie in der README-Datei im Verzeich-
nis \NT\Host_Adapter auf der IBM Netfinity FAStT Storage Manager CD.

Abbildung 18. Prozess für eine neue Installation
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Speichersubsysteme
Informationen zur Installation der Speichersubsysteme finden Sie in der entspre-
chenden Hardware-Dokumentation. Folgende Punkte sollten berücksichtigt werden:
v Wenn Sie Speichersubsysteme direkt verwalten, müssen Sie Ethernet-Kabel auf

beiden Controllern in jedem Speichersubsystem installieren.
v Wenn Sie keine Dual-Channel-Host-Adapter verwenden, müssen Sie zwei Host-

Adapter pro Knoten installieren, um die Dual-Path-Konfiguration zu verwenden.

Anmerkung: Die Dual-Path-Konfiguration bietet den höchsten RDAC-Schutz im
Fall von Problemen mit der Verbindung.

In der folgenden Abbildung werden Fibre Channel-Verbindungen mit Single-Path-
und Dual-Path-Konfigurationen abgebildet, die Vollredundanz, Teilredundanz und
Nicht-Redundanz bieten. Weitere Informationen finden Sie in der Hardware-
dokumentation, die im Lieferumfang der Controllereinheit oder des Speicher-Servers
enthalten ist.

Anmerkung: Der Interlink wird als Pfad für das Clustering-Überwachungssignal
verwendet.

Knoten A

Host-Adapter

Knoten A

Host-Adapter

Knoten B

Host-Adapter

Knoten B

Host-Adapter

Verwalteter Hub
oder Schalter

Verwalteter Hub
oder Schalter

Verwalteter Hub oder
Schalter

Speicher-
Subsystem
Controller

Speicher-
Subsystem
Controller

Speicher-Subsystem

Speicher-Subsystem

Interlink

Interlink

Fibre Channel Verbindung
(einzelner Pfad)

Fibre Channel Verbindung
(doppelter Pfad)

Anmerkung: Andere verwaltete Hub-Konfigurationen sind möglich.

Fahren Sie mit Schritt „Installieren des SM7client-Pakets” auf Seite 49 fort.

Abbildung 19. Installieren des Speichersubsystems auf einem Fibre Channel-Netzwerk
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Installieren des SM7client-Pakets
Installieren Sie das SM7client-Paket auf jeder Verwaltungsstation. Sie können das
Paket auf Knoten A oder B installieren, die mit einem der folgenden Betriebssys-
teme konfiguriert sind:
v Windows NT Server 4.0
v Windows NT Workstation 4.0
v Windows 98
v Windows 98 Second Edition

Wichtige Hinweise:

v Wenn Sie lediglich eine Netzverwaltungsstation konfigurieren, müssen Sie nur
den SM7client installieren.

v Nachdem die Speichersubsysteme mit beiden Knoten verbunden sind, starten
Sie Windows NT erst dann gleichzeitig auf beiden Knoten, wenn Sie die Cluster-
Software auf mindestens einem Knoten installiert haben. Um den Windows
NT-Systemstart auf Knoten B auszusetzen, drücken Sie die Leertaste beim
Systemstart des Betriebssystems. Installieren Sie die Cluster-Software erst, wenn
Sie dazu aufgefordert werden.

v Wenn Sie SM7client auf einem eigenständigen Host installieren, und Speicher-
subsysteme über den Fibre Channel E/A-Pfad statt über das Netzwerk verwalten
möchten, müssen Sie die TCP/IP-Software auf dem Host installieren und dem
Host eine statische IP-Adresse zuweisen. Das Betriebssystem des Hosts muss
Windows NT Server 4.0 oder Windows NT Workstation 4.0 sein.

Installationsanweisungen
Stellen Sie vor dem Installieren der Software sicher, dass:
v Auf der Verwaltungsstation mindestens 20 MB Plattenspeicherplatz verfügbar

sind.
v Die Anzeigemerkmale auf eine Mindestauflösung von 800 x 600 Pixel und eine

Palette von 256 Farben oder mehr festgelegt sind.
v Alle anderen Programms geschlossen sind.

Installieren von SM7client:

1. Legen Sie die Installations-CD für IBM Netfinity FAStT Storage Manager in das
CD-ROM-Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird angezeigt.

3. Klicken Sie auf Installieren und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen . Das Fenster Durchsuchen wird angezeigt.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis \NT\SM7client aus.

7. Wählen Sie die Datei setup.exe aus, und klicken Sie auf Öffnen .

8. Klicken Sie auf Beenden . Das Begrüßungsfenster des Konfigurations-
programms wird geöffnet.

9. Klicken Sie auf Weiter , um die Installation zu beginnen.

Das Fenster Zieladresse auswählen wird geöffnet.

10. Klicken Sie auf Browse , um die Zieladresse zu ändern.

11. Klicken Sie auf Weiter .

12. Klicken Sie auf Beenden , wenn die Installation abgeschlossen ist.
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Prüfen der SM7client-Installation
Gehen Sie folgendermaßen vor, um zu prüfen, dass die Installation erfolgreich war:

1. Klicken Sie auf Start → Programme .

2. Überprüfen Sie, dass Netfinity FAStT Channel Storage Manager 7 in der Liste
von Programmen angezeigt wird.

3. Wenn Sie SM7client lediglich auf einer Verwaltungsstation installieren, fahren
Sie mit „Fortsetzen der Installation” auf Seite 54 fort; fahren Sie andernfalls mit
„Installieren des RDAC-Pakets” fort.

Installieren des RDAC-Pakets
Gehen Sie folgendermaßen vor, um das RDAC-Paket auf einem Host zu installie-
ren, der mit einem der folgenden Betriebssysteme konfiguriert ist.

Das RDAC-Paket besteht aus folgenden Komponenten:
v Der Multi-Path-Einheitentreiber, der für die Überbrückungsunterstützung benötigt

wird.
v Das Dienstprogramm Hot Add zum dynamischen Hinzufügen von logischen Lauf-

werken zum Betriebssystem (siehe „Verwenden des Hot-Add-Dienstprogramms”
auf Seite 86).

Wichtig: Sie müssen das RDAC-Paket installieren, bevor Sie das SM7agent-Paket
installieren.

Zuordnen von Laufwerksbuchstaben
Die Installation lädt den RDAC-Einheitentreiber vor dem nativen Windows NT
Klasseneinheitentreiber. Dies ist zur Erkennung des RDAC notwendig. Dies bedeu-
tet jedoch, dass das System die logischen Laufwerke des Speichersubsystems
erkennt, bevor lokale Laufwerke erkannt werden, und die Laufwerkbuchstaben ent-
sprechend vergeben werden.

Anmerkung: Bevor Sie diese Software installieren, müssen Sie den bestehenden
lokalen Laufwerken statische Laufwerkbuchstaben zugeordnet haben.

Bestimmen Sie mit der folgenden Prozedur, ob Sie statische Laufwerkbuchstaben
hinzufügen müssen, und fügen Sie sie, wenn notwendig, hinzu.

Schalten Sie das Speichersubsystem aus, damit der Festplatten-Manager (WIN-
DISK) nicht blockiert, während Sie Laufwerkbuchstaben zuordnen oder den RDAC-
Einheitentreiber installieren.

Klicken Sie auf Start → Programme → Administrative Tools → Disk Administrator ,
um die Plattenkonfiguration zu sichten und die Zahl der Partitionen zu überprüfen.

v Wenn Sie eine oder mehrere Partitionen haben, fahren Sie fort mit Schritt 3.

v Wenn Sie lediglich über eine Partition verfügen, fahren Sie fort mit Schritt 4.

v Wenn Sie mindestens zwei Partitionen haben (die Boot-Partition und eine weite-
re), und folgende Bedingungen beide zutreffen, fahren Sie fort mit Abschnitt
„Installationsanweisungen” auf Seite 51. Fahren Sie andernfalls mit 51 fort.

v Die letzte erstellte Partition wurde mit Disk Administrator erstellt.

v Der Partition ist ein Laufwerkbuchstabe zugeordnet, und sie hat den Status
Unbekannt, oder verfügt über ein Dateisystem (das bedeutet, sie hat einen ande-
ren Status als Unformatiert).
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Gehen Sie wie folgt vor, um eine neue Partition zu erstellen.

1. Wählen Sie ein Laufwerk mit freiem Plattenspeicherplatz aus.

2. Klicken Sie auf Partition → Erstellen . Die Partition wird erstellt (es wird ein
Laufwerkbuchstabe zugewiesen, und der Status der Partition ist Unformatiert).

3. Klicken Sie auf Partition → Commit Changes Now . Der Status der Partition
wechselt auf Unbekannt, und allen bestehenden Partitionen werden Laufwerks-
buchstaben zugewiesen.

4. Fahren Sie fort mit Schritt „Installationsanweisungen”.

Installationsanweisungen
Stellen Sie vor dem Installieren des RDAC-Pakets sicher, dass:
v Sie die Administratorberechtigung auf dem Host haben.
v Der Host mit Windows NT 4.0 und Service Pack 5 oder höher konfiguriert ist.
v Auf dem Host mindestens 1 MB Plattenspeicherplatz verfügbar sind.
v Die Anzeigemerkmale auf eine Mindestauflösung von 640 x 480 Pixel und eine

Palette von 256 Farben oder mehr festgelegt sind.
v Alle anderen Programme geschlossen sind.

Installieren von RDAC:

1. Legen Sie die Installations-CD für IBM Netfinity FAStT Storage Manager in das
CD-ROM-Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird angezeigt.

3. Klicken Sie auf Installieren und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen .

Das Fenster Durchsuchen wird angezeigt.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis \NT\RDAC aus.

7. Wählen Sie die Datei setup.exe aus, und klicken Sie auf Öffnen .

8. Klicken Sie auf Beenden .

Das Begrüßungsfenster des Konfigurationsprogramms wird geöffnet.

9. Klicken Sie auf Weiter , um die Installation zu beginnen.

Nachdem RDAC installiert ist, wird das Fenster Setup Complete geöffnet.

10. Klicken Sie auf No, I will restart my computer later ; klicken Sie dann auf
Beenden .

11. Klicken Sie auf Start → Beenden... .

Das Dialogfeld Windows NT beenden wird geöffnet.

12. Klicken Sie auf Beenden , um den Server herunterzufahren.

13. Schalten Sie das Speichersubsystem ein.

14. Nachdem das Speichersubsystem vollständig eingeschaltet ist, schalten Sie
den Host ein, um sicherzustellen, dass die Änderungen wirksam werden.
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Prüfen der RDAC-Installation
Gehen Sie folgendermaßen vor, um zu prüfen, dass die Installation erfolgreich war.

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Geräte .

Das Fenster Geräte wird geöffnet.

2. Wählen Sie aus der Geräteliste symarray aus.

3. Stellen Sie sicher, dass der Status des Geräts symarray gestartet ist.

4. Fahren Sie fort mit Schritt „Installieren von Microsoft Virtual Machine (MSVM)”.

Installieren von Microsoft Virtual Machine (MSVM)
Gehen Sie folgendermaßen vor, um das SM7agent-Paket auf einer Host-Maschine
zu installieren, die mit einem oder mehreren Speichersubsystemen verbunden ist.

Wichtig: Sie müssen Microsoft Virtual Machine (VM) installieren, bevor Sie
SM7agent installieren. Die Installations-CD zu Netfinity FAStT Storage Manager
7.02 enthält eine Version von Microsoft VM, die mit der Speicherverwaltungs-
software getestet wurde. Bevor Sie diese Version installieren, rufen Sie die IBM
Website über http://www.ibm.com/pc/support auf, ob eine neuere Version der Soft-
ware verfügbar ist. Überprüfen Sie die Website auf die neuesten Support-
Informationen.

Installationsanweisungen
Stellen Sie vor dem Installieren der Software sicher, dass:

v Sie die Administratorberechtigung auf der Host-Maschine haben.

v Die Host-Maschine mit Windows NT 4.0 und Service Pack 5 oder höher konfigu-
riert ist.

v Auf der Host-Maschine mindestens 1 MB Plattenspeicherplatz verfügbar sind.

v Die Anzeigemerkmale auf eine Mindestauflösung von 640 x 480 Pixel und eine
Palette von 256 Farben oder mehr festgelegt sind.

v Alle anderen Programme geschlossen sind.

Gehen Sie folgendermaßen vor, um Microsoft Virtual Machine zu installieren:

1. Legen Sie die Installations-CD für IBM Netfinity FAStT Storage Manager in das
CD-ROM-Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird angezeigt.

3. Klicken Sie auf Installieren und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen .

Das Fenster Durchsuchen wird angezeigt.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis NT\SM7agent aus.

7. Wählen Sie die Datei msjavx86.exe aus, und klicken Sie auf Öffnen .

8. Klicken Sie auf Beenden und befolgen Sie die Anweisungen auf dem Bild-
schirm.

Nachdem die Software installiert ist, wird das Fenster Setup Complete geöff-
net.
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Anmerkung: Sie müssen den Host neu starten, um sicherzustellen, dass alle
Änderungen wirksam werden.

9. Klicken Sie auf Ja, um den Host erneut zu starten.

10. Fahren Sie fort mit Schritt „Installieren des SM7agent-Pakets”.

Installieren des SM7agent-Pakets
Gehen Sie folgendermaßen vor, um das SM7agent-Paket auf einer Host-Maschine
zu installieren, die mit einem oder mehreren Speichersubsystemen verbunden ist.

Das SM7agent-Paket besteht aus folgenden Komponenten:

v Die Host-Agent-Software, die zur Verwaltung des Host-Agenten der Speicher-
subsysteme erforderlich ist.

v Das Dienstprogramm SM7devices, das zur Verbindung von logischen Laufwerken
mit den Einheitennamen des Betriebssystems benötigt wird. Weitere Informatio-
nen finden Sie unter „Verwenden des Dienstprogramms SM7devices” auf Sei-
te 86.

Wichtige Hinweise:

v Sie können das SM7agent-Paket erst installieren, wenn das RDAC-Paket instal-
liert ist. Microsoft Virtual Machine ist auch eine erforderliche Komponente zum
Installieren und Verwenden des SM7agent-Pakets.

v Sie müssen SM7agent installieren, selbst wenn Sie Speichersubsystem nicht
über die Host-Agent-Software verwalten möchten.

Installationsanweisungen
Stellen Sie vor dem Installieren der Software sicher, dass:

v Sie die Administratorberechtigung auf der Host-Maschine haben.

v Die Host-Maschine mit Windows NT 4.0 und Service Pack 5 oder höher konfigu-
riert ist.

v Auf der Host-Maschine mindestens 1 MB Plattenspeicherplatz verfügbar sind.

v Die Anzeigemerkmale auf eine Mindestauflösung von 640 x 480 Pixel und eine
Palette von 256 Farben oder mehr festgelegt sind.

v RDAC und Microsoft Virtual Machine (VM) installiert sind.

v Alle anderen Programms geschlossen sind.

Installieren des SM7agent-Pakets:

1. Legen Sie die Installations-CD für IBM Netfinity FAStT Storage Manager in das
CD-ROM-Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird angezeigt.

3. Klicken Sie auf Installieren und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen .

Das Fenster Durchsuchen wird angezeigt.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis \NT\SM7agent aus.

7. Wählen Sie die Datei setup.exe aus, und klicken Sie auf Öffnen .

8. Klicken Sie auf Beenden .

Das Begrüßungsfenster des Konfigurationsprogramms wird geöffnet.
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9. Klicken Sie auf Weiter , um die Installation zu beginnen.

10. Nach der Installation von SM7agent wird das Fenster Installation beendet
geöffnet.

11. Sie müssen den Host neu starten, um sicherzustellen, dass alle Änderungen
wirksam werden. Klicken Sie auf Beenden , um den Host erneut zu starten.

Prüfen der SM7agent-Installation
Gehen Sie folgendermaßen vor, um zu prüfen, dass die Installation erfolgreich war.

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Dienste .

Das Fenster Dienste wird geöffnet.

2. Blättern Sie durch die Liste mit Diensten, bis Sie den Netfinity Fibre Channel
Storage Manager-7-Agenten finden, um sicherzustellen, dass der Service instal-
liert ist.

3. Stellen Sie sicher, dass der Status des Geräts host-agent gestartet ist.

Anmerkung: Wenn Sie die Host-Agent-Software nicht zum Verwalten von
Speichersystemen verwenden, können Sie den Dienst Host-Agent
ausschalten. Klicken Sie auf Start → Einstellungen → Systems-
teuerung → Dienste . Wählen Sie den Agenten aus der Liste der
angezeigten Dienste aus, und wählen Sie dann Starten . Wählen
Sie als Startart Manuell aus, und klicken Sie dann auf OK.

Fortsetzen der Installation
Wenn Sie die Speicherverwaltungssoftware auf Knoten A installiert haben, fahren
Sie fort mit Abschnitt „Festlegen der Speichersubsysteme”. Wenn Sie die Speicher-
verwaltungssoftware auf Knoten B installiert haben, fahren Sie fort mit Abschnitt
„Prüfen von Laufwerksbuchstaben” auf Seite 55.

Festlegen der Speichersubsysteme
Gehen Sie anhand der in Abschnitt „Kapitel 5. Beenden der Installation” auf Seite 61
beschrieben Prozeduren vor, um die folgenden Tasks auszuführen:

1. Starten Sie Enterprise Management und führen Sie eine automatische Initialer-
kennung der Speichersubsysteme auf dem lokalen Netzwerk durch. (Lesen Sie
hierzu „Starten von Enterprise Management” auf Seite 61.)

2. Fügen Sie andere Geräte zur Verwaltungsdomäne hinzu. (Lesen Sie hierzu
„Hinzufügen von Einheiten” auf Seite 63.)

3. Erstellen Sie alle geplanten logischen Laufwerke und Arrays für jedes Speicher-
subsystem, das mit dem Cluster verbunden ist. (Lesen Sie hierzu „Erstellen von
Bereichen und logischen Laufwerken” auf Seite 63.)

4. Ändern Sie Konfigurationseinstellungen in NVSRAM, indem Sie die entspre-
chenden Scripts ausführen, die für Ihre Konfiguration erforderlich sind. (Lesen
Sie hierzu „Ändern der Konfigurationseinstellungen in NVSRAM” auf Seite 67.)

5. Öffnen Sie für jedes Speichersubsystem ein Fenster Subsystem Management,
und konfigurieren Sie das Speichersubsystem so weit wie möglich. Sie müssen
die Speichersubsysteme nicht vollständig konfigurieren. Dennoch müssen alle
Änderungen, die zu einem späteren Zeitpunkt durchgeführt werden, dem Knoten
B vermittelt werden. (Lesen Sie hierzu „Starten von Subsystem Management”
auf Seite 65.)

6. Wenn Sie die Prozeduren in „Kapitel 5. Beenden der Installation” auf Seite 61
abgeschlossen haben, fahren Sie fort mit Schritt 7 auf Seite 55.
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7. Wenn Sie die Speicherverwaltungssoftware auf Knoten B installiert haben, fah-
ren Sie fort mit Abschnitt „Systemabschluss für Knoten A durchführen”, wenn
Sie die Speicherverwaltungssoftware auf Knoten B installiert haben, fahren Sie
fort mit Abschnitt „Prüfen von Laufwerksbuchstaben”.

Systemabschluss für Knoten A durchführen
Wenn die Installation der Speicherverwaltungssoftware auf Knoten A abgeschlossen
ist:

1. Beenden Sie Windows NT, aber lassen Sie Sie Knoten A aktiviert (schalten Sie
den Knoten nicht aus).

2. Kehren Sie zu „Installieren des SM7client-Pakets” auf Seite 49 zurück, und wie-
derholen Sie das Installationsverfahren, um die notwendigen Software-
komponenten auf Knoten B zu installieren.

Prüfen von Laufwerksbuchstaben
Wenn die Installation der Speicherverwaltungssoftware auf Knoten B abgeschlossen
ist:

1. Überprüfen Sie mit dem Windows NT Festplatten-Manager, dass die Laufwerk-
buchstaben, die den konfigurierten logischen Laufwerke zugeordnet sind, die
gleichen wie die sind, die auf Knoten A zugeordnet sind.

2. Fahren Sie fort mit Schritt „Systemabschluss für Knoten B durchführen”.

Systemabschluss für Knoten B durchführen
1. Beenden Sie Windows NT, aber lassen Sie Sie Knoten B aktiviert (schalten Sie

den Knoten nicht aus).

2. Fahren Sie fort mit dem nächsten Schritt, „Installieren der Cluster-Server-
Software”.

Installieren der Cluster-Server-Software
Gehen Sie folgendermaßen vor, um die Cluster-Server-Software auf den Knoten A
und B zu installieren.

Wichtig: Stellen Sie sicher, dass die Speicherverwaltungssoftware auf beiden Kno-
ten des Cluster-Servers installiert ist, bevor Sie die Cluster-Server-Software instal-
lieren.

1. Installieren Sie folgendermaßen die Cluster-Server-Software auf Knoten A:

a. Lesen Sie die Informationen zur ordnungsgemäßen Installation der Cluster-
Server-Software in der entsprechenden Dokumentation von Microsoft Clus-
ter Server (MSCS).

Anmerkung: Geben Sie bei der Installation an, dass Sie einen neuen Clus-
ter bilden möchten.

b. Lassen Sie den Knoten A nach dem Systemwiederanlauf aktiv.

Kapitel 4. Installieren von Software in einer Cluster-Server-Umgebung 55



2. Installieren Sie folgendermaßen die Cluster-Server-Software auf Knoten B:

a. Lesen Sie die Informationen zur ordnungsgemäßen Installation der Cluster-
Server- Software in der entsprechenden Dokumentation von Microsoft Clus-
ter Server (MSCS).

Anmerkung: Geben Sie bei der Installation an, dass Sie einen bestehen-
den Cluster verknüpfen möchten.

b. Lassen Sie den Knoten B nach dem Systemwiederanlauf aktiv.

Wichtig: Wenn die Installation von MSCS vollständig ist, sollten Sie das neueste
unterstützte Service Pack erneut installieren.

3. Überprüfen Sie die Softwareinstallation folgendermaßen:

a. Klicken Sie auf einem Knoten (A oder B) auf Start → Programme → Admi-
nistrative Tools (Common) .

b. Klicken Sie auf Cluster Administrator.

c. Geben Sie im Feld Cluster or Server Name den Namen des Clusters oder
den Namen oder die IP-Adresse eines der beiden Knoten ein.

d. Wenn die Installation erfolgreich war, werden die Rechnernamen beider
Knoten auf der linken Seite des Fensters Cluster Administrator angezeigt.

4. Wenn beide Knoten angezeigt werden, fahren Sie fort mit „Beenden der letzten
Tasks” auf Seite 68. Installieren Sie andernfalls die Cluster-Server-Software
erneut.

Upgraden einer früheren Version der Speicherverwaltungssoftware in
einer Cluster-Server-Konfiguration

Vergewissern Sie sich, dass sie mit den in „Neue Installation” auf Seite 46 erforder-
lich Schritten vertraut sind, bevor Sie die Installationsprozedur fortsetzen.

Sie können das bestehende Speichersubsystem auf über eines der folgenden
Speichersubsysteme auf Storage Manager 7.02 und Controller-Firmware Version
4.00.02 upgraden:

v Durchführen eines geplanten Upgrades. Ein geplantes Upgrade beinhaltet,
dass eine Zeit geplant wird, in der der Cluster-Server inaktiv ist, um die
Controller-Firmware und die Speicherverwaltungssoftware zu aktualisieren. Das
geplante Upgrade ist die zu bevorzugende Prozedur zum Upgrade einer Cluster-
Server-Konfiguration.

v Durchführen eines durchlaufenden Upgrades. Ein durchlaufendes Upgrade
beinhaltet, dass die Controller-Firmware und die Speicherverwaltungssoftware
aktualisiert werden, so dass die Dienste und Ressourcen, die vom Cluster ange-
boten werden, verfügbar sind, während der Knoten, der aktualisiert wird, nicht
verfügbar ist.

Wichtig: Nach dem Upgrade der Controller-Firmware auf Version 4.00.02 kann mit
dem Controller nicht kommuniziert werden, bis die Software Storage Manager 7.02
auf der Verwaltungsstation und dem Host installiert. Bereits installierte Versionen
des Speicherverwaltungs-Clients und der Host-Agentsoftware können Controller
nicht erkennen, auf denen Firmware mit der Version 4.00.02 installiert ist.
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Ausführen eines geplanten Upgrades der Speicherverwaltungssoftware
der Version 7.0 oder 7.01 auf Storage Manager 7.02

Führen Sie folgende Schritte aus, um ein Upgrade der Speicherverwaltungssoftware
der Version 7.0 oder 7.01 auf Storage Manager 7.02 durchzuführen.

1. Führen Sie vor dem Installieren der Speicherverwaltungssoftware folgende
Schritte aus:

a. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Dienste .

Das Fenster Geräte wird geöffnet.

b. Wählen Sie aus der Liste der angezeigten Geräte Cluster-Server aus, und
klicken Sie auf Starten . Das Fenster Dienste wird geöffnet.

c. Klicken Sie in der Auswahlgruppe Startart auf Manuell ; klicken Sie dann auf
OK.

d. Schalten Sie Cluster-Server auf allen Knoten in der Cluster-Konfiguration.

2. Führen Sie für alle Knoten, bis auf Knoten A, einen Systemabschluss durch.

3. Deinstallieren Sie auf dem Knoten A die Komponenten der vorherigen Version
der Speicherverwaltungssoftware anhand der Deinstallationsprozedur, die in der
Version der ausgeführten Speicherverwaltungssoftware enthalten ist.

4. Stellen Sie sicher, dass die Treiberversionen von IBM Host Bus Adapter auf
dem neuesten Stand sind. Wenn sie nicht auf dem aktuellen Stand sind, lesen
Sie die README-Datei im Verzeichnis \NT\Host_Adapter auf der Installations-
CD, um die Treiberversionen zu installieren, bevor Sie fortfahren.

5. Installieren Sie das Storage Manager 7.02 SM7client-Paket anhand der in
„Installieren des SM7client-Pakets” auf Seite 49 beschriebenen Prozedur.

6. Installieren Sie das Storage Manager 7.02 RDAC-Paket anhand der in „Installie-
ren des RDAC-Pakets” auf Seite 50 beschriebenen Prozedur.

7. Installieren Sie das Storage Manager 7.02 SM7agent-Paket anhand der in
„Installieren des SM7agent-Pakets” auf Seite 53 beschriebenen Prozedur.

8. Upgraden Sie das Controller-NVSRAM und die Controller-Firmware auf Version
4.00.02. Ändern Sie dann die entsprechenden Konfigurationseinstellungen in
NVSRAM anhand der Prozedur unter „Ändern der Konfigurationseinstellungen in
NVSRAM” auf Seite 67.

Anmerkung: Verwenden Sie die bestehenden Versionen 4.00.00 bis 4.00.01
der Controller-Firmware weiter. Sie können diese bestehenden
Speicherverwaltungssysteme mit Storage Manager 7.02 verwal-
ten.

9. Führen Sie für diesen Knoten einen Systemabschluss durch.

10. Wiederholen Sie auf Knoten B die Schritte 3 bis 7; wiederholen Sie dann den
Schritt 9.

11. Alle Knoten sollten heruntergefahren sein. Starten Sie die Knoten einzeln
anhand der folgenden Prozedur:

a. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Dienste .

Das Fenster Dienste wird geöffnet.

b. Wählen Sie aus der Liste der angezeigten Geräte Cluster-Server aus, und
klicken Sie auf Starten . Das Fenster Dienste wird geöffnet.

c. Klicken Sie in der Auswahlgruppe Startart auf Automatisch ; klicken Sie
dann auf OK.

d. Starten Sie den Cluster-Server auf Knoten B.
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Ausführen eines durchlaufenden Upgrades der Speicherverwaltungs-
software der Version 7.0 oder 7.01 auf Storage Manager 7.02

Anmerkung: Um den Zugriff auf einen Cluster zu erhalten, müssen Sie ein durch-
laufendes Upgrade durchführen. Ein durchlaufendes Upgrade bein-
haltet, dass die Controller-Firmware und die Speicherverwaltungs-
software aktualisiert werden, so dass die Dienste und Ressourcen,
die vom Cluster angeboten werden, verfügbar sind, während der
Knoten, der aktualisiert wird, nicht verfügbar ist.

Wenn in der Cluster-Server-Umgebung Anwendungen installiert sind, die kein
durchlaufendes Upgrade ermöglichen, müssen Sie einen der folgenden Schritte
durchführen:
v Stellen Sie die Ressourcen vor dem Upgrade offline; stellen Sie sie nach dem

Upgrade wieder online, oder
v verwenden Sie eine andere Upgrade-Methode.

Führen Sie folgende Schritte aus, um ein durchlaufendes Upgrade der Speicher-
verwaltungssoftware der Version 7.0 oder 7.01 auf Storage Manager 7.02 durchzu-
führen.

1. Öffnen Sie auf Knoten A den Cluster Administrator.
2. Wählen Sie Knoten A aus, und halten Sie ihn an (File → Pause Node )
3. Doppelklicken Sie auf den Ordner Aktive Gruppen im rechten Fenster von

Cluster Administrator.
4. Wählen Sie jede aufgelistete Gruppe aus, und verschieben Sie die Auswahl

nach Knoten B.
5. Deinstallieren Sie auf Knoten A die Komponenten der vorherigen Version der

Speicherverwaltungssoftware anhand der Deinstallationsprozedur, die in der
Version der ausgeführten Speicherverwaltungssoftware enthalten ist.

6. Stellen Sie sicher, dass die Treiberversionen von IBM Host Bus Adapter auf
dem neuesten Stand sind. Wenn sie nicht auf dem aktuellen Stand sind, lesen
Sie die README-Datei im Verzeichnis \NT\Host_Adapter auf der Installations-
CD, um die Treiberversionen zu installieren, bevor Sie fortfahren.

7. Installieren Sie das Storage Manager 7.02 SM7client-Paket anhand der in
„Installieren des SM7client-Pakets” auf Seite 49 beschriebenen Prozedur.

8. Installieren Sie das Storage Manager 7.02 RDAC-Paket anhand der in „Instal-
lieren des RDAC-Pakets” auf Seite 50 beschriebenen Prozedur.

9. Installieren Sie das Storage Manager 7.02 SM7agent-Paket anhand der in
„Installieren des SM7agent-Pakets” auf Seite 53 beschriebenen Prozedur.

10. Upgraden Sie das Controller-NVSRAM und die Controller-Firmware auf Ver-
sion 4.00.02. Ändern Sie dann die entsprechenden Konfigurationseinstellungen
in NVSRAM anhand der Prozedur unter „Ändern der Konfigurationsein-
stellungen in NVSRAM” auf Seite 67.

Anmerkung: Verwenden Sie die bestehenden Versionen 4.00.00 bis 4.00.01
der Controller-Firmware weiter. Sie können diese bestehenden
Speicherverwaltungssysteme mit Storage Manager 7.02 verwal-
ten.

11. Führen Sie Cluster Administrator aus, und nehmen Sie den Betrieb des Kno-
tens wieder auf (Datei → Knoten wieder aufnehmen )

12. Wiederholen Sie auf Knoten B die Schritte 1 bis 9; wiederholen Sie dann den
Schritt 11.
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Migrationsprozess für eine Windows NT-Cluster-Konfiguration
Führen Sie folgende Schritte durch, um die Controller-Firmware von Version 3.x auf
4.x zu migrieren, und die Speicherverwaltungssoftware auf Storage Manager 7.02
zu upgraden.

1. Führen Sie vor dem Installieren der Speicherverwaltungssoftware folgende
Schritte aus:

a. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Dienste .

Das Fenster Dienste wird geöffnet.

b. Wählen Sie aus der Liste der angezeigten Geräte Cluster-Server aus, und
klicken Sie auf Starten . Das Fenster Dienste wird geöffnet.

c. Klicken Sie in der Auswahlgruppe Startart auf Manuell ; klicken Sie dann auf
OK.

d. Schalten Sie Cluster-Server auf allen Knoten in der Cluster-Konfiguration
aus.

2. Führen Sie für alle Knoten, bis auf Knoten A, einen Systemabschluss durch.

3. Um den Migrationsprozess auf Knoten A abzuschließen, fahren Sie fort mit
„Kapitel 6. Migrationsprozess” auf Seite 69.

Anmerkung: Führen Sie folgende Schritte durch, um die Controller-Firmware
von Version 3.x auf 4.x zu migrieren, und die Speicher-
verwaltungssoftware von Version 6.22 auf 7.02 zu upgraden.

4. Deinstallieren Sie von Knoten A aus die Komponenten der vorherigen Version
der Speicherverwaltungssoftware anhand der Deinstallationsprozedur, die in der
Version der ausgeführten Speicherverwaltungssoftware enthalten ist.

5. Stellen Sie sicher, dass die Treiberversionen von IBM Host Bus Adapter auf
dem neuesten Stand sind. Wenn sie nicht auf dem aktuellen Stand sind, lesen
Sie die README-Datei im Verzeichnis \NT\Host_Adapter auf der Installations-
CD, um die Treiberversionen zu installieren, bevor Sie fortfahren.

6. Installieren Sie das Storage Manager 7.02 SM7client-Paket anhand der in
„Installieren des SM7client-Pakets” auf Seite 49 beschriebenen Prozedur.

7. Installieren Sie das Storage Manager 7.02 RDAC-Paket anhand der in „Installie-
ren des RDAC-Pakets” auf Seite 50 beschriebenen Prozedur.

8. Installieren Sie das Storage Manager 7.02 SM7agent-Paket anhand der in
„Installieren des SM7agent-Pakets” auf Seite 53 beschriebenen Prozedur.

9. Upgraden Sie das Controller-NVSRAM und die Controller-Firmware auf Version
4.00.02. Ändern Sie dann die entsprechenden Konfigurationseinstellungen in
NVSRAM anhand der Prozedur unter „Ändern der Konfigurationseinstellungen in
NVSRAM” auf Seite 67.

10. Führen Sie für diesen Knoten einen Systemabschluss durch.

11. Wiederholen Sie auf Knoten B die Schritte 4 bis 8; wiederholen Sie dann den
Schritt 10.
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12. Alle Knoten sollten heruntergefahren sein. Starten Sie die Knoten einzeln
anhand der folgenden Prozedur:

a. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Dienste .

Das Fenster Dienste wird geöffnet.

b. Wählen Sie aus der Liste der angezeigten Geräte Cluster-Server aus, und
klicken Sie auf Starten . Das Fenster Dienste wird geöffnet.

c. Klicken Sie in der Auswahlgruppe Startart auf Automatisch ; klicken Sie
dann auf OK.

d. Starten Sie den Cluster-Server auf dem Knoten.
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Kapitel 5. Beenden der Installation

Dieses Kapitel enthält Prozeduren zum Starten von Enterprise Management und
Subsystem Management sowie zum Beenden der Installations-Tasks.

Starten von Enterprise Management
Das Fenster Enterprise Management wird als erstes Fenster beim Starten der Soft-
ware geöffnet. In diesem Fenster können Sie Folgendes tun:

v Die Speichersubsysteme, die Sie verwalten möchten, hinzufügen und suchen

v Eine umfassende Anzeige aller Speichersubsysteme in Ihrer Verwaltungsdomäne
zur Verfügung stellen

v Stapel-Tasks für die Speichersubsysteme anhand des Scripteditors ausführen

Mittels folgender Prozedur starten Sie das Fenster Enterprise Management:

1. Klicken Sie auf Start → Programme .

2. Klicken Sie auf Netfinity Fibre Channel Storage Manager 7-Client .

Die Client-Software wird gestartet, und das Fenster Enterprise Management
sowie das Fenster Confirm Initial Automatic Discovery werden geöffnet (siehe
Abb. 20).

Anmerkung: Es kann einige Minuten dauern, bis das Fenster Enterprise
Management geöffnet wird. Es wird kein Cursor (etwa eine Sand-
uhr) für den Wartestatus angezeigt. Wenn Sie die erste automati-
sche Erkennung nicht ausführen möchten, klicken Sie auf No. Sie
können mittels der Menüoption Edit → Add Device Hosts und
Speichersubsysteme hinzufügen. Weitere Informationen finden
Sie unter „Hinzufügen von Einheiten” auf Seite 63.

Abbildung 20. Fenster Initial Automatic Discovery
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3. Klicken Sie auf Yes, um eine erste automatische Erkennung der Hosts und
Speichersubsysteme zu beginnen, die an das lokale Teilnetz angeschlossen
sind, in dem die Verwaltungsstation installiert ist.

Die Software sendet eine Broadcast-Nachricht über das lokale Teilnetz, in dem
die Verwaltungsstation installiert ist. Dabei werden mit dem Host-Agent verwal-
tete Speichersubsysteme erkannt, wenn die Hosts, die die Netzverwaltungs-
verbindungen mit den Speichersubsystemen gewährleisten, auf den Broadcast-
Betrieb antworten. Mit der Software werden direkt verwaltete
Speichersubsysteme erkannt, wenn die Controller in diesen Speicher-
subsystemen auf die Broadcast-Nachricht antworten.

Anmerkung: Es kann bis zu einer Minute dauern, bis das Fenster Enterprise
Management nach der ersten automatischen Erkennung aktualisiert
wird.

Wenn Sie den automatischen Erkennungsvorgang stoppen müssen, schließen Sie
das Fenster Enterprise Management.

Wenn die erste automatische Erkennung beendet ist, können Sie alle Hosts und
Speichersubsysteme anzeigen, die an das lokale Teilnetz angeschlossen sind
(siehe Abb. 21).

Wenn nicht alle Hosts und Speichersubsysteme angezeigt werden, gehen Sie
folgendermaßen vor:

v Überprüfen Sie die Hardware und die Verbindungen auf mögliche Fehler. (Spezi-
elle Prozeduren finden Sie in der Hardware-Dokumentation.)

v Detaillierte Informationen finden Sie in der Enterprise Management-Hilfe unter
dem Hilfethema über die Erkennung von Speichersubsystemen.

v Stellen Sie sicher, dass sich die Einheit im lokalen Teilnetz befindet. Ist dies nicht
der Fall, müssen Sie die Option Add Device verwenden.

Abbildung 21. Fenster Enterprise Management
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Anmerkung: Wenn eine der Einheiten den Status Unresponsive aufweist, entfer-
nen Sie die Einheit mit Hilfe der Software aus der Verwaltungs-
domäne, und fügen Sie sie erneut hinzu. Anweisungen zum Entfer-
nen und Hinzufügen von Einheiten finden Sie in der Online-
Hilfefunktion von Enterprise Management.

Ein Speichersubsystem kann unter Umständen nach einer automatischen Erken-
nung in der Einheitenbaumstruktur dupliziert werden, wenn das Speichersubsystem
direkt verwaltet wird, jedoch an einen Host angeschlossen ist, auf dem die Host-
Agent-Software installiert und aktiv ist. In diesem Fall können Sie das doppelt vor-
handene Symbol für die Speicherverwaltung aus der Baumstruktur für die Einheiten
mit Hilfe der Option Remove Device im Fenster Enterprise Management löschen.

Fahren Sie mit dem Schritt „Hinzufügen von Einheiten” fort.

Hinzufügen von Einheiten
Sie können weitere Hosts oder Speichersubsysteme außerhalb des lokalen Teil-
netzes hinzufügen. Weitere Informationen zu dieser Option finden Sie in der Online-
Hilfefunktion des Fensters Enterprise Management.

Wichtig: Wenn Sie Speichersubsysteme über die Host-Agent-Software verwalten
und physikalisch neue Speichersubsysteme hinzufügen, müssen Sie den Host-
Agent-Service stoppen und erneut starten, so dass die neuen Speichersubsysteme
erkannt werden können (siehe „Ausschalten des Host-Agent-Service” auf Seite 68).
Gehen Sie anschließend in das Fenster Enterprise Management, und klicken Sie
auf Tools → Rescan , um die neuen Speichersubsysteme zur Verwaltungsdomäne
hinzuzufügen.

Fahren Sie mit dem Schritt „Erstellen von Bereichen und logischen Laufwerken”
fort.

Erstellen von Bereichen und logischen Laufwerken
Gehen Sie wie folgt vor, um einen Bereich oder ein logisches Laufwerk zu erstellen:

1. Heben Sie im Fenster Enterprise Management ein Speichersubsystem hervor,
und wählen Sie Tools → Manage Device aus, um das Fenster Subsystem
Management für das Speichersubsystem aufzurufen.

2. Erstellen Sie sämtliche geplanten Bereiche und logischen Laufwerke in diesem
Speichersubsystem mittels der Option Configure → Create Array/Logical Drive
erstellen. .

3. Wiederholen Sie die Konfiguration der Bereiche/logischen Laufwerke für jedes
an Ihren Cluster angeschlossene Speichersubsystem.

Anmerkung: Wenn Sie weitere logische Laufwerke hinzufügen oder löschen,
müssen Sie diese Vorgänge am Knoten B durchführen.

4. Gehen Sie zu “Einrichten von Alert-Hinweisen”.
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Einrichten von Alert-Hinweisen
Wenn Sie zur Verwaltungsdomäne Einheiten hinzugefügt haben, richten Sie Alert-
Hinweisoptionen ein, um kritische Ereignisse an die Speichersubsysteme weiterzu-
geben. Folgende Optionen sind für die Alert-Hinweise verfügbar:

v Hinweis an eine ausgewählte Netzverwaltungsstation (NMS = Network Manage-
ment Station) anhand von SNMP-Traps (SNMP = Simple Network Management
Protocol) (Weitere Informationen erhalten Sie unter „Einrichten der NMS für die
SNMP-Hinweise”.)

v Hinweis an ausgewählte E-Mail-Adressen

v Hinweis an ausgewählte alphanumerische Empfangsgeräte (wenn ein Software-
paket von Fremdherstellern zum Konvertieren von E-Mail-Nachrichten verwendet
wird)

Anmerkung: Das Fenster Enterprise Management muss geöffnet bleiben, wenn
Sie die Bedingungen der Speichersubsysteme, die Bestandteil Ihrer
Verwaltungsdomäne sind, überwachen möchten. Sie können das
Fenster jedoch auf Symbolgröße verkleinern. Wenn Sie das Fenster
schließen, erhalten Sie keine Alert-Hinweise. Weitere Informationen
zu den Optionen für Alert-Hinweise finden Sie in der Online-
Hilfefunktion von Enterprise Management.

Einrichten der NMS für die SNMP-Hinweise
Wenn Sie die Alert-Hinweise unter Verwendung der SNMP-Traps einrichten möch-
ten, müssen Sie zuerst eine Datei für die Verwaltungsinformationsdatenbank (MIB =
Management Information Base) auf die ausgewählte Netzverwaltungsstation kopie-
ren. Verwenden Sie diese Prozedur, um die MIB-Datei auf der Netzverwaltungs-
station einzurichten.

Wichtig: Sie müssen die ausgewählte NMS lediglich einmal einrichten.

1. Kopieren Sie von der Installations-CD für den Netfinity FAStT Storage Manager
aus dem Verzeichnis \NT\SM7mib die Datei Arrayman.mib auf die Netz-
verwaltungsstation.

2. Befolgen Sie die Schritte, die für Ihre spezielle Netzverwaltungsstation erforder-
lich sind, um die MIB-Datei zu kompilieren.

Anmerkung: Einzelangaben zu den erforderlichen Schritten erhalten Sie von
Ihrem Netzadministrator oder entnehmen Sie der Dokumentation,
die speziell für das von Ihnen verwendete NMS-Produkt erhältlich
ist.

Konfigurieren der Alert-Zieladressen
Konfigurieren Sie die Zieladressen für die SNMP-Traps und für die E-Mails, die
Alert-Hinweise erhalten sollen, mit Enterprise Management. Weitere Hinweise zur
genauen Vorgehensweise finden Sie in der Online-Hilfefunktion von Enterprise
Management.
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Starten von Subsystem Management
Mit dem Fenster Subsystem Management können Sie die ausgewählten Subsys-
teme verwalten.

Mit der folgenden Prozedur wird das Fenster Subsystem Management für ein aus-
gewähltes Speichersubsystem geöffnet:

1. Wählen Sie im Fenster Enterprise Management ein Speichersubsystem aus.

2. Klicken Sie auf Tools → Manage Device .

Das Fenster Subsystem Management für das ausgewählte Speichersubsystem
wird von der Software angezeigt (siehe Abb. 22 auf Seite 66).

Anmerkung: Mit dem geöffneten Fenster Subsystem Management können Sie
lediglich das ausgewählte Speichersubsystem verwalten. Sie kön-
nen jedoch mehrere Fenster Subsystem Management öffnen, um
weitere Speichersubsysteme zu verwalten.
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Umbenennen von Speichersubsystemen
Wenn Sie Storage Manager 7.02 zum ersten Mal starten, sind die Speicher-
subsysteme nicht benannt. Sie müssen jedes Speichersubsystem im Fenster Sub-
system Management von <unnamed> in den gewünschten Namen umbenennen.
Informationen hierzu finden Sie bei den Namen, die Sie im Informationsdatensatz
eingegeben haben, den Sie mit Hilfe der Tabelle 14 auf Seite 93 erstellt haben.
Anschließend gehen Sie in die Online-Hilfefunktion von Subsystem Management,
und lesen Sie die Angaben zum Thema Umbenennen von Speichersubsystemen.
Das Hilfethema bietet ausführliche Anweisungen zum Umbenennen von Speicher-
subsystemen.

Ausführen weiterer Verwaltungs-Tasks für Speichersubsysteme
Sie können die folgenden Verwaltungs-Tasks für Speichersubsysteme ausführen:

v Herunterladen der Controller-Firmware

v Herunterladen der Controller-NVSRAM

v Suchen eines Speichersubsystems

v Anzeigen eines Profils für ein Speichersubsystem

v Eingeben oder Ändern eines Kennworts für ein Speichersubsystem

v Erstellen und Verwalten von logischen Laufwerken und Bereichen

v Verwenden der Leistungsüberwachung

v Erstellen von Speicherpartitionen (falls gültig)

Abbildung 22. Fenster Subsystem Management (Modelle 3526 und 3552)

Abbildung 23. Fenster Subsystem Management (Modell 3542)
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Anmerkung: Um Speicherpartitionen zu erstellen, müssen Sie den weltweit gülti-
gen Namen oder den Anschlussnamen für jeden Host-Adapter in
jedem mit dem Speichersubsystem verbundenen Host ermitteln.

Weitere Informationen über diese und sonstige Verwaltungs-Tasks für Speicher-
subsysteme finden Sie in den entsprechenden Hilfethemen der Online-Hilfefunktion
von Subsystem Management.

Fahren Sie mit dem Schritt „Ändern der Konfigurationseinstellungen in NVSRAM”
fort.

Ändern der Konfigurationseinstellungen in NVSRAM
Je nachdem, für welches Betriebssystem, welche Verwaltungsmethode (Host-Agent
oder direkt) und welche Konfiguration (mit oder ohne Cluster) Sie sich entschieden
haben, müssen Sie möglicherweise Scripts ausführen, um die Konfigurationsein-
stellungen zu ändern, die in NVSRAM auf jedem Speichersubsystem gespeichert
sind, das Sie mit Storage Manager 7.02 verwalten.

Mit der folgenden Prozedur können Sie die Konfigurationseinstellungen ändern.

1. Legen Sie die Installations-CD für Netfinity FAStT Storage Management in das
CD-ROM-Laufwerk auf Ihrer Verwaltungsstation ein.

2. Gehen Sie in das Verzeichnis NT\Scripts, und lesen Sie die README-Datei in
diesem Verzeichnis.

3. Wählen Sie im Fenster Enterprise Management ein Speichersubsystem aus.
Klicken Sie anschließend auf Tools → Execute Script .

4. Führen Sie die Scripts für Ihre Konfiguration mittels der Schritte 6 bis 8 durch.

Anmerkung: Wenn Sie bei einer Cluster-Konfiguration die Speichersubsysteme
ausschließlich mit dem Host-Agenten verwalten, führen Sie das
Script zum Sperren des Netzbetriebs aus.

5. Um eine Script-Datei auszuführen, klicken Sie auf File → Load Script .

Das Fenster Load Script wird geöffnet.

6. Wählen Sie das gewünschte Script aus dem Verzeichnis NT\Scripts auf der
Installations-CD.

7. Klicken Sie auf Öffnen , um das Script zu laden.

8. Klicken Sie auf Tools → Execute Only . Warten Sie, bis die Meldung Script Exe-
cution Complete angezeigt wird.

9. Wiederholen Sie die Prozeduren der Schritte 3 bis 8 für jedes Speicher-
subsystem, das Sie mit der Speicherverwaltungssoftware verwalten.
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Beenden der letzten Tasks
Wenn Sie die Speichersubsysteme ausschließlich mit der direkten Methode verwal-
ten möchten, fahren Sie mit dem Schritt „Ausschalten des Host-Agent-Service” fort.
Andernfalls gehen Sie zu „Kapitel 7. Unterstützung von Betriebssystemen” auf Sei-
te 83.

Anmerkung: Sie können die Speichersubsysteme sowohl mit der direkten als auch
mit der Host-Agent-Methode verwalten.

Ausschalten des Host-Agent-Service
Mit der folgenden Prozedur schalten Sie den Host-Agent-Service aus:

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Services .

2. Klicken Sie auf Netfinity Fibre Channel Storage Manager 7 Agent .

3. Klicken Sie auf Stop .

4. Klicken Sie auf Startup .

Das Fenster Service wird geöffnet.

5. Klicken Sie unter Startup Type auf Manuell .

6. Klicken Sie auf OK.

7. Klicken Sie auf Schließen , um das Fenster Services zu schließen, und schlie-
ßen Sie dann die Systemsteuerung.

8. Gehen Sie zu „Kapitel 7. Unterstützung von Betriebssystemen” auf Seite 83.
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Kapitel 6. Migrationsprozess

Wenn Sie eine bestehende Installation von Speichersubsystemen mit Controller
Modell 3526, diese mit Version 6.22 der Speicherverwaltungssoftware verwalten,
und Sie diese Speichersubsysteme mit Storage Manager 7.01 verwalten möchten,
fahren Sie bitte mit „Installationsvoraussetzungen” fort. Fahren Sie andernfalls mit
„Kapitel 5. Beenden der Installation” auf Seite 61 fort.

Mit der Migrationsprozedur können Sie folgende Tasks ausführen:

v Upgraden von der Speicherverwaltungssoftware Version 6.22 auf Storage Mana-
ger Version 7.01 auf der Verwaltungsstation.

v Upgraden des RDAC auf dem Host.

v Installieren von MSVM und SM7agent auf dem Host.

v Migrieren der Firmware von 3.x zu 4.x auf den RAID-Controllern in einer IBM
Netfinity Fibre Channel RAID-Controllereinheit Modell 3526-1RU.

Hinweise:

1. Führen Sie die Installation von SM7client auf jeder Verwaltungsstation durch.

2. Führen Sie die Installation von SM7rdac, MSVM und SM7agent auf jedem
Host durch.

3. Führen Sie den Migrationsprozess für einen Host für jedes Speicher-
subsystem durch.

Installationsvoraussetzungen
Stellen Sie vor dem Starten des Migrationsprozesses sicher:

1. Auf dem Host und der Verwaltungsstation wird Windows NT Service Pack 5
oder höher ausgeführt.

Anmerkung: Sie können die Controller-Firmware nicht migrieren, wenn auf
dem Host-Agent und der Verwaltungsstation Windows 2000 aus-
geführt wird. Windows 2000 kann mit Controllern kommunizieren,
die über Firmware-Version 4.x verfügen.

2. Fibre Channel RAID-Controller, die migriert werden sollen, müssen über boot-
ware 03.01.00.02 und appware 03.01.02.22 verfügen.

3. Stellen Sie sicher, dass die 32-LUN-Unterstützung aktiviert ist.

(Die Einstellung ’LargeLuns’ in der Registrierungsdatenbank für die Fibre Chan-
nel Host Bus Adapters (HBA) muss auf ’1’ festgelegt sein, und die Einstellung
’Luns per target’ im ALT-Q FC HBA-Dienstprogramm muss auf ’0’ festgelegt
sein.)

4. Die Speicherverwaltungssoftware Version 6.22 muss vor Beginn des Migrations-
prozesses deinstalliert sein.

5. Laden Sie die Softwaredateien von der IBM Website
http://www.ibm.com/pc/netfinity herunter.

a. Klicken Sie auf Downloads →Netfinity and PC Server Drivers.

b. Wählen Sie Ihr Produkt aus und klicken Sie auf Servers → Fibre Channel
Solutions → 3526→ All → Fibre ; stellen Sie dann einer Verbindung her und
laden Sie die folgende Software herunter:

v 06p4929A IBM Netfinity FAStT Storage Manager 7 for Windows NT version
7.01.
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v IBM Netfinity FAStT Storage Manager 7.01 migration from Storage Manager
version 6.22 (for Windows NT only).

Stellen Sie vor dem Installieren der Software Folgendes sicher:

v Sie haben die Administratorberechtigung auf dem Host.

v Der Host ist mit Windows NT 4.0 und Service Pack 5 oder höher konfiguriert.

v Auf dem Host stehen mindestens 10 MB freien Plattenspeicherplatz zur Verfü-
gung, und die Anzeigemerkmale sind auf eine Mindestauflösung von 640 x 480
Pixel und eine Palette von 256 Farben festgelegt.

v Auf der Verwaltungsstation stehen mindestens 20 MB freien Plattenspeicherplatz
zur Verfügung, und die Anzeigemerkmale sind auf eine Mindestauflösung von
800 x 600 Pixel und eine Palette von 256 Farben festgelegt.

v Alle anderen Programme sind geschlossen. Sie können den Controller nicht aktu-
alisieren, wenn eine aktive Sperre auf den logischen Laufwerken besteht. Dies
beinhaltet IBM Netfinity Manager, Netfinity Director, Diskeeper oder Microsoft
Cluster Server.

Installationsvorbereitung
Verwenden Sie zum Vorbereiten des Migrationsprozesses folgende Prozedur:

1. Führen Sie 06P4929A.exe aus. Wählen Sie ein Verzeichnis aus, in das die
Dateien extrahiert werden sollen, und klicken Sie auf Unzip . Hierdurch wird die
folgende Verzeichnisstruktur unter dem Zielextraktionsverzeichnis erstellt:

Verzeichnis von
<target directory>\temp\AGENT701 SM7agent-NT-07012501.exe
<target directory>\temp\CLIENT701 SM7client-NT-07012503.exe
<target directory>\temp\FW04000100 FW_04000100_04000100.dlp
<target directory>\temp\MIB arrayman.mib
<target directory>\temp\MSVM MSJavx86-5_00_3186.exe
<target directory>\temp\NVSRAM NV4766WNT856004.dlp

NV4774WNT856003.dlp
<target directory>\temp\RDAC SM7rdac-07002507.exe
<target directory>\temp\SCRIPTS SM7Scripts.exe
<target directory>\temp READM701.txt

2. Führen Sie migrate701.exe aus. Wählen Sie das gleiche Verzeichnis aus, das
auch im vorherigen Schritt ausgewählt wurde, und klicken Sie auf Unzip . Hier-
durch wird die folgende Verzeichnisstruktur unter dem Zielextraktionsverzeichnis
erstellt:

Verzeichnis von
<target directory>\temp\FW03010300 firmware_03010300.dlp
<target directory>\temp\MIB arrayman.mib
<target directory>\temp\migrate701 sm7migrate-nt-07012500.exe

v Migrate.txt

v Migrate.cmd

v NVutil.exe

v SetNVSRAM.cmd
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Installieren von SM7client
Verwenden Sie die folgende Prozedur, um das SM7client-Paket auf einer
Verwaltungsstation oder einem Datei-Server zu installieren, die oder der mit einem
der folgenden Betriebssysteme konfiguriert ist.

v Windows NT Server 4.0

v Windows NT Workstation 4.0

v Windows 98

v Windows 98 Second Edition

Anmerkung: Wenn Sie SM7client auf einem Host installieren, und Speicher-
subsysteme über den Fibre Channel E/A-Pfad statt über das Netz-
werk verwalten möchten, müssen Sie die TCP/IP-Software auf dem
Host installieren und dem Host eine statische IP-Adresse zuweisen.
Das Betriebssystem des Hosts muss auf Windows basieren.

Installationsanweisungen
1. Wechseln Sie in das Verzeichnis <target directory>\temp\client701.

2. Führen Sie die Datei SM7client-NT-07012503.exe aus.

Diese selbstextrahierende ausführbare Datei extrahiert ihre Dateien in das Ver-
zeichnis c:\storage. Wenn Sie zum Überschreiben von Dateien aufgefordert wer-
den, klicken Sie auf Yes to All .

Anmerkung: Möglicherweise wird Ihr Verzeichnispfad anders identifiziert.

3. Wählen Sie im Verzeichnis c:\storage die Datei setup.exe, und klicken Sie auf
Öffnen .

4. Klicken Sie auf Next . Das Begrüßungsfenster des Konfigurationsprogramms
wird geöffnet.

5.

Klicken Sie auf OK, um die Installation zu starten. Das Fenster Choose Destina-
tion Location wird geöffnet.

6. Klicken Sie auf Browse , um die Zieladresse zu ändern.

7. Klicken Sie auf Next , um die Installation zu beginnen.

8. Klicken Sie auf Beenden , wenn die Installation abgeschlossen ist.

Prüfen der SM7client-Installation
Gehen Sie folgendermaßen vor, um zu prüfen, dass die Installation erfolgreich war:
1. Klicken Sie auf Start → Programme .
2. Überprüfen Sie, dass Netfinity Fibre Channel Storage Manager 7 in der Liste

von Programmen angezeigt wird.
3. Fahren Sie mit „Installieren von SM7rdac” auf Seite 72 fort.
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Installieren von SM7rdac
Gehen Sie folgendermaßen vor, um das SM7client-Paket auf einer Verwaltungs-
station oder einem Datei-Server zu installieren, die mit einem der folgenden
Betriebssysteme konfiguriert sind.

Das RDAC-Paket besteht aus folgenden Komponenten:

v Der Multipath-Einheitentreiber, der für die Überbrückungsunterstützung benötigt
wird.

v Das Dienstprogramm Hot Add zum dynamischen Hinzufügen von logischen Lauf-
werken zum Betriebssystem (siehe „Verwenden des Hot-Add-Dienstprogramms”
auf Seite 86).

Wichtig: Sie müssen das RDAC-Paket installieren, bevor Sie das SM7agent-Paket
installieren.

Installationsanweisungen
1. Wählen Sie das Verzeichnis <Zielverzeichnis>\temp\RDAC\ aus.

2. Führen Sie die Datei SM7rdac-07002507.exe aus.

Stellen Sie die Einstellungen zum Überschreiben von Dateien auf ’Always’ ein.
Diese selbstextrahierende ausführbare Datei extrahiert ihre Dateien in das Ver-
zeichnis c:\storage.

3. Wählen Sie im Verzeichnis c:\storage die Datei setup.exe.

4. Klicken Sie auf Next . Das Begrüßungsfenster des Konfigurationsprogramms
wird geöffnet.

5. Klicken Sie auf OK, um die Installation zu beginnen.

Nach der Installation von RDAC wird das Fenster Setup Complete geöffnet.

6. Sie müssen den Host neu starten, um sicherzustellen, dass alle Änderungen
wirksam werden. Klicken Sie auf Beenden , und starten Sie den Computer
erneut.

Prüfen der SM7rdac-Installation
Gehen Sie folgendermaßen vor, um zu prüfen, dass die Installation erfolgreich war.

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Geräte .

Das Fenster Geräte wird geöffnet.

2. Wählen Sie aus der Geräteliste symarray aus.

3. Stellen Sie sicher, dass der Status des Geräts symarray gestartet ist.

4. Fahren Sie mit Schritt „Installieren von Microsoft Virtual Machine (MSVM)” auf
Seite 73 fort.
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Installieren von Microsoft Virtual Machine (MSVM)
Gehen Sie folgendermaßen vor, um Microsoft Virtual Machine (MSVM) auf einem
Host zu installieren, der mit einem oder mehreren Speichersubsystemen konfiguriert
sind.

Wichtig: Sie müssen Microsoft Virtual Machine (MSVM) installieren, bevor Sie
SM7agent installieren. Die Installations-CD zu Netfinity FAStT Storage Manager
7.01 enthält eine Version von Microsoft VM, die mit der Speicherverwaltungs-
software getestet wurde. Bevor Sie diese Version installieren, rufen Sie die IBM
Website über http://www.ibm.com/pc/support auf, ob eine neuere Version der Soft-
ware verfügbar ist. Überprüfen Sie die Website auf die neuesten Support-
Informationen.

Installationsanweisungen
1. Wechseln Sie in das Verzeichnis <target directory>\temp\MSVM.

2. Führen Sie die Datei MSJavx86-5_00_3186.exe aus.

Wählen Sie aus, neuere Dateien nicht zu überschreiben, wenn Sie dazu aufge-
fordert werden. Diese selbstextrahierende ausführbare Datei extrahiert ihre
Dateien in das Verzeichnis c:\storage.

3. Klicken Sie auf Next und befolgen Sie die Anweisungen.

Nachdem die Software installiert ist, wird das Fenster Setup Complete geöffnet.

Anmerkung: Sie müssen den Host neu starten, um sicherzustellen, dass alle
Änderungen wirksam werden.

4. Klicken Sie auf Ja, und starten Sie den Computer erneut.

Installieren des SM7agent-Pakets
Gehen Sie folgendermaßen vor, um das SM7agent-Paket auf einer Host-Maschine
zu installieren, die mit einem oder mehreren Speichersubsystemen verbunden ist.

Das SM7agent-Paket besteht aus folgenden Komponenten:

v Die Host-Agent-Software, die zur Verwaltung des Host-Agenten der Speicher-
subsysteme erforderlich ist.

v Das Dienstprogramm SM7devices, das zur Verbindung von logischen Laufwerken
mit den Einheitennamen des Betriebssystems benötigt wird. Weitere Informatio-
nen finden Sie unter „Verwenden des Dienstprogramms SM7devices” auf Sei-
te 86.

Wichtig: Sie können das SM7agent-Paket erst installieren, wenn das RDAC-Paket
installiert ist. Microsoft Virtual Machine ist auch eine erforderliche Komponente zum
Installieren und Verwenden des SM7agent-Pakets. Sie müssen SM7agent installie-
ren, selbst wenn Sie Speichersubsysteme nicht über die Host-Agent-Software ver-
walten möchten.
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Installationsanweisungen
1. Wählen Sie das Verzeichnis <target directory>\temp\AGENT701 aus.

2. Führen Sie die Datei SM7agent-NT-07012501.exe aus.

Wenn Sie zum Überschreiben von Dateien aufgefordert werden, klicken Sie auf
Yes to All . Diese selbstextrahierende ausführbare Datei extrahiert ihre Dateien
in das Verzeichnis c:\storage.

3. Führen Sie im Verzeichnis c:\storage die Datei setup.exe aus.

4. Klicken Sie auf Next .

Das Begrüßungsfenster des Konfigurationsprogramms wird geöffnet.

5. Klicken Sie auf OK, um die Installation zu beginnen.

Nachdem das SM7agent-Paket installiert ist, wird das Fenster Setup Complete
geöffnet.

6. Sie müssen den Host neu starten, um sicherzustellen, dass alle Änderungen
wirksam werden. Klicken Sie auf Beenden , um den Computer erneut zu starten.

Prüfen der SM7agent-Installation
Gehen Sie folgendermaßen vor, um zu prüfen, dass die Installation erfolgreich war.

1. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Dienste .

Das Fenster Dienste wird geöffnet.

2. Blättern Sie durch die Liste mit Diensten, bis Sie den Netfinity Fibre Channel
Storage Manager 7-Agenten finden, um sicherzustellen, dass der Service instal-
liert ist.

Hinweise:

a. Wenn der Host-Agent keine verbundenen Controller findet, auf denen Firm-
ware Version 4.x installiert ist, wird die folgende Nachricht von Service Cont-
rol Manager angezeigt:

Der Start mindestens eines Diensts, der beim Systemstart gestartet werden
sollte, schlug fehl. Überprüfen Sie das Ereignisprotokoll.

b. Im NT Systemereignisprotokoll wird ein dem folgenden ähnlicher Eintrag
angezeigt über das Fehlschlagen des Speicherverwaltungs-Agenten:

Datum: 16.14.00 Ereignis-ID: 7024
Zeit: 19:00:38 Quelle: Service Control Manager
Benutzer: Nicht verfügbar Typ: Fehler
Computer: FC-PD Kategorie: Keine
Beschreibung:
Der Dienst Netfinity Fibre Channel Storage Manager 7 Agent wurde mit dem dienst-
spezifischen Fehler 100 beendet.

In diesem Fall ist dieser Fehler erwartet und kann ignoriert werden. Wenn
der Host an ein Speichersubsystem mit Firmware Version 4.x installiert ist,
wird der Host-Agent automatisch nach dem Neustart des Systems gestartet.

Anmerkung: Wenn Sie die Host-Agent-Software nicht zum Verwalten von
Speichersystemen verwenden, können Sie den Dienst Host-
Agent ausschalten. Wählen Sie den Agenten aus der Liste der
angezeigten Dienste aus, und wählen Sie dann Beenden .
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Installieren von SM7migrate
Gehen Sie folgendermaßen vor, um SM7migrate auf einem Host zu installieren, der
mit einem oder mehreren Speichersubsystemen verbunden ist. SM7migrate wird
zum Herunterladen von NVSRAM-Dateien und zum Upgraden der Controller-
Firmware benötigt.

Installationsanweisungen
1. Legen Sie die Installations-CD für IBM Netfinity FAStT Storage Manager in das

CD-ROM-Laufwerk ein.

2. Klicken Sie auf Start → Einstellungen → Systemsteuerung → Software .

Das Fenster Eigenschaften von Software wird angezeigt.

3. Klicken Sie auf Installieren und befolgen Sie die Anweisungen auf dem Bild-
schirm.

4. Klicken Sie auf Durchsuchen .

Das Fenster Durchsuchen wird angezeigt.

5. Wählen Sie das CD-ROM-Laufwerk aus.

6. Wählen Sie das Verzeichnis <Zielverzeichnis>\temp\MIGRATE701 aus.

7. Führen Sie die Datei SM7migrate-NT-07012500.exe aus.

Wenn Sie zum Überschreiben von Dateien aufgefordert werden, klicken Sie
auf Yes to All . Diese selbstextrahierende ausführbare Datei extrahiert ihre
Dateien in das Verzeichnis c:\storage.

8. Führen Sie im Verzeichnis c:\storage die Datei setup.exe aus.

9. Wählen Sie Next aus.

Das Begrüßungsfenster des Konfigurationsprogramms wird geöffnet.

10. Wählen Sie OK aus.

Das Fenster Choose Destination Location wird geöffnet.

11. Klicken Sie auf Browse , um die Zieladresse zu ändern.

12. Klicken Sie auf Next , um die Installation zu beginnen.

13. Sie müssen den Host neu starten, um sicherzustellen, dass alle Änderungen
wirksam werden. Klicken Sie auf Beenden , um den Host erneut zu starten.
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Herunterladen von Firmware, NVSRAM und Stapeldateien
Wenn Sie bereits installierte Speichersubsysteme zur Verwaltung mit Netfinity
FAStT Storage Manager 7.x upgraden, müssen Sie mit Hilfe von SM7migrate eine
Standard-NVSRAM-Datei herunterladen. In der Standardeinstellung sind das
Netzwerk-Bit und des Bit zur Erstellung von access volume aktiviert.

1. Kopieren Sie die Datei NV4766WNT856004.dlp aus dem
<Zielverzeichnis>\Temp\NVSRAM in das Verzeichnis
\Programme\SM7migrate\native.

2. Kopieren Sie die Datei firmware_dlp aus dem
<Zielverzeichnis>\temp\FW03010300 in das Verzeichnis
\Programme\SM7migrate\native.

3. Kopieren Sie die Datei FW_04000100_04000100.dlp aus dem
<Zielverzeichnis>\temp\FW04000100 in das Verzeichnis
\Programme\SM7migrate\native.

4. Kopieren Sie die Stapeldatei migrate.cmd in das Verzeichnis
\Programme\SM7migrate\native.

5. Kopieren Sie die Datei NVutil.exe in das Verzeichnis
\Programme\SM7migrate\native.

6. Kopieren Sie die Stapeldatei SetNVSRAM.cmd in das Verzeichnis
\Programme\SM7migrate\native.

Ausführen der Stapeldatei SetNVSRAM.cmd
Bevor Sie NVSRAM upgraden können, muss das Speichersubsystem so festgelegt
werden, dass alle LUN berichtet werden (die ältere Version von NVSRAM schränkte
die Speichersubsysteme insoweit ein, dass lediglich 8 LUN berichtet wurden). Füh-
ren Sie die Stapeldatei SetNVSRAM aus, um die Speichersubsysteme vorzuberei-
ten. Dieser Schritt muss für jedes Speichersubsystem durchgeführt werden, auf
dem das NVSRAM aktualisiert werden soll.

Wichtig: Sie müssen die Stapeldatei setNVSRAM.cmd ausführen. Wenn dieser
Schritt nicht vor der Aktualisierung des NVSRAM durchgeführt wird, kann die
NVSRAM-Aktualisierung fehlschlagen.

Anmerkung: Die Stapeldatei führt die Schritte 1 und 2 aus.

1. nvutil -o 34=30

Hierdurch wird der Relativzeiger von 34 im NVSRAM auf 30 festgelegt, so dass
das Speichersubsystem alle LUN berichtet.

2. nvutil -o 34

Hierdurch wird die Einstellung von Relativzeiger 34 im NVSRAM des Speicher-
subsystems zurückgelesen. Es sollte ’30’ angezeigt werden.

3. Führen Sie einen Systemabschluss für das Host-System durch.

4. Schalten Sie die RAID-Controller des Speichers aus und wieder ein.

5. Schalten Sie den Host ein.

6. Bestätigen Sie, dass Sie mit dem Upgrade des NVSRAM fortfahren möchten.

7. Wählen Sie Start → Einstellungen → Systemsteuerung → SCSI-Adapter .

Zählen sie die Zahl der aufgelisteten Geräte für die FC HBA, die an die RAID-
Controller in den Speichersubsystemen angeschlossen sind. Es sollten 32
Geräte für jeden RAID-Controller angezeigt werden, mit denen jedes FC HBA
kommunizieren kann.
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Ausführen der Stapeldatei Migrate.cmd
Zur Vereinfachung der Installation der NVRAM- und Firmware-Dateien wurde eine
Stapeldatei erstellt. Wenn diese Datei ausgeführt wird, werden die Prozedurschritte
in „Installieren von NVSRAM-Dateien” und „Upgraden der Firmware von Version 3.x
auf Version 4.x” auf Seite 78 automatisch durchgeführt. Die Schritte der Stapeldatei,
die mit den Aktionen des Handbuchs korrelieren, werden neben den Befehlen in
„Installieren von NVSRAM-Dateien” und „Upgraden der Firmware von Version 3.x
auf Version 4.x” auf Seite 78 angezeigt.

Anmerkung: Achten Sie darauf, die Stapeldatei Migrate.cmd zu verwenden.

Installieren von NVSRAM-Dateien
1. Wechseln Sie von der DOS-Eingabeaufforderung in das Verzeichnis

\Programme\SM7migrate\native.

2. Geben Sie Folgendes ein:

SM7migrate NV4766WNT856004.dlp (Schritt 1 und 2 der Stapeldatei)

Die Software zeigt Informationen zu jedem Speichersubsystem an (siehe
Produkttabelle auf Seite 1), das an den Host angeschlossen ist, auf dem Sie
SM7migrate ausführen. Beispielsweise kann Folgendes angezeigt werden:

v JASON_001:Drive0 Drive8

v MAGGIE_01:Drive16 Drive32

v FRED_001:Drive1 Drive9

Anmerkung: Der erste Teil der angezeigten Informationen bezieht sich auf den
Namen des Speichersubsystems (beispielsweise JASON_001).
Der zweite Teil der angezeigten Informationen bezieht sich auf die
Controller des Speichersubsystems (beispielsweise Drive0 Dri-
ve8).

Die Software zeigt die folgenden Optionen an:

Make Selection: (A)ll Modules, E(x)it, or Module Index Number

3. Geben Sie eine Zahl ein, die einer der Modul-Indexnummern entspricht.

Wichtig: Geben Sie nicht A ein, um alle Module zu aktualisieren, hierdurch wird
das NVSRAM möglicherweise nicht ordnungsgemäß auf allen Speicher-
subsystemen aktualisiert.

Die Nachricht Download to controller drive <n> was successful wird ange-
zeigt.

4. Führen Sie die Stapeldatei ClearLocks.bat im Verzeichnis
\Programme\SM7migrate\native, um nicht mehr benötigte Dateien zu entfernen,
die von der Firmware-Migration generiert wurden.

5. Wiederholen Sie die obigen Schritte 2 bis 4, stellen Sie dabei sicher, dass die
gleiche Modul-Indexnummer wie vorher eingegeben wurde, um das NVSRAM
auf dem Speichersubsystem zweifach zu aktualisieren.

Anmerkung: Dies ist Schritt 2 der Stapeldatei.
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Wichtig: Diese zweite Aktualisierung des NVSRAM ist erforderlich auf Grund
eines bestehenden Ablaufsteuerungsfensters, durch das möglicherweise das
NVSRAM beim ersten Mal nicht ordnungsgemäß aktualisiert wurde. Durch den
zweiten Aktualisierungsvorgang ist sichergestellt, dass das NVSRAM ordnungs-
gemäß aktualisiert wird. Wenn die Nachricht Download to controller Drive
<n> was successful nicht angezeigt wird, stoppen Sie den Migrationsprozess
und kontaktieren Sie den IBM Ansprechpartner.

6. Wiederholen Sie die Schritte 2 bis 5 für jedes Speichersubsystem, das Sie mit
Storage Manager 7.01 verwalten möchten.

Upgraden der Firmware von Version 3.x auf Version 4.x
Mit Storage Manager 7.01 können Sie lediglich Speichersubsysteme mit Controllern
verwalten, die über Firmware 4.x verfügen. Wenn Sie Controller mit Storage Mana-
ger 7.01 verwalten möchten, verwenden Sie SM7migrate, um die Firmware auf die-
sen Controllern von Version 3.x auf Version 4.x zu aktualisieren. Abhängig von der
Version der momentan installierten Firmware geschieht dies in zwei Schritten:

v Upgraden von Version 3.x auf 3.1.3 (das “Sprungbrett” zum Upgraden auf Ver-
sion 4.x)

v Upgraden von Version 3.1.3 auf Version 4.x

Mit folgender Prozedur können Sie mit dem Dienstprogramm SM7migrate die
Controller-Firmware von Version 3.x auf Version 3.1.3 aktualisieren. (Die ist das
“Sprungbrett” zum Upgraden auf Version 4.x.)

Achtung: Verwenden Sie SM7migrate nicht, um Firmware direkt von Version
3.01.x auf Version 4.x zu aktualisieren, da möglicherweise die Verbindung mit den
Controllern im Speichersubsystem verloren geht.

1. Wechseln Sie von der DOS-Eingabeaufforderung in das Verzeichnis
\Programme\SM7migrate\native.

2. Geben Sie Folgendes ein:

SM7migrate firmware_03010300.dlp (Stapeldatei Schritt 3)

Die Software zeigt Informationen zu jedem Speichersubsystem an (siehe
Produkttabelle auf Seite 1), das an den Host angeschlossen ist, auf dem Sie
SM7migrate ausführen. Beispielsweise kann Folgendes angezeigt werden:

v JASON_001:Drive0 Drive8

v MAGGIE_01:Drive16 Drive32

v FRED_001:Drive1 Drive9

Anmerkung: Der erste Teil der angezeigten Informationen bezieht sich auf den
Namen des Speichersubsystems (beispielsweise JASON_001).
Der zweite Teil der angezeigten Informationen bezieht sich auf die
Controller des Speichersubsystems (beispielsweise Drive0 Dri-
ve8).

Die Software zeigt die folgenden Optionen an:

Make Selection: (A)ll Modules, E(x)it, or Module Index Number

3. Geben Sie eine Zahl ein, die einer der Modul-Indexnummern entspricht.
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Hinweise:

a. Geben Sie nicht A ein, um alle Module zu aktualisieren, hierdurch wird das
NVSRAM möglicherweise nicht ordnungsgemäß auf allen Speicher-
subsystemen aktualisiert.

Die Nachricht Download to controller Drive <n> was successful wird ange-
zeigt.

b. Wenn eine Fehlermeldung angezeigt wird, dass der eingegebene Dateiname
nicht der Name einer herunterladbaren Datei ist, überprüfen Sie, dass die
.dlp-Datei sich im Verzeichnis \Programme\SM7migrate\native befindet.
Wenn Sie die Datei in einem anderen Verzeichnis gespeichert haben, ver-
schieben Sie sie in das Verzeichnis \Programme\Files\SM7migrate\native,
und starten Sie den Migrationsprozess erneut.

c. Wenn die Nachricht Download successful nicht angezeigt wird, stoppen Sie
den Migrationsprozess und kontaktieren Sie den IBM Ansprechpartner.

4. Führen Sie die Stapeldatei ClearLocks.bat im Verzeichnis
\Programme\SM7migrate\native, um nicht mehr benötigte Dateien zu entfernen,
die von der Firmware-Migration generiert wurden.

5. Wiederholen Sie die Schritte b bis d für jedes Speichersubsystem, das Sie mit
Storage Manager 7.01 verwalten möchten.

6. Starten Sie das System erneut.

7. Mit folgender Prozedur können Sie mit dem Dienstprogramm SM7migrate die
Controller-Firmware von Version 3.1.3 auf Version 4.x aktualisieren.

a. Wechseln Sie von der DOS-Eingabeaufforderung in das Verzeichnis
\Programme\SM7migrate\native.

b. Geben Sie Folgendes ein:

SM7migrate FW_04000100_04000100.dlp (Stapeldatei Schritt 4)

Die Software zeigt Informationen zu jedem Speichersubsystem an(siehe
Produkttabelle auf Seite 1), das an den Host angeschlossen ist, auf dem Sie
SM7migrate ausführen. Beispielsweise kann Folgendes angezeigt werden:

v JASON_001:Drive0 Drive8

v MAGGIE_01:Drive16 Drive32

v FRED_001:Drive1 Drive9

Anmerkung: Der erste Teil der angezeigten Informationen bezieht sich auf
den Namen des Speichersubsystems (beispielsweise
JASON_001). Der zweite Teil der angezeigten Informationen
bezieht sich auf die Controller des Speichersubsystems (bei-
spielsweise Drive0 Drive8).
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Die Software zeigt die folgenden Optionen an:

Make Selection: (A)ll Modules, E(x)it, or Module Index Number

v Geben Sie eine Zahl ein, die einer der Modul-Indexnummern entspricht.

Wichtige Hinweise:

v Geben Sie nicht A ein, um alle Module zu aktualisieren, hierdurch wird
das NVSRAM möglicherweise nicht ordnungsgemäß auf allen Speicher-
subsystemen aktualisiert.

Die Nachricht Download to controller Drive <n> was successful wird
angezeigt.

v Wenn eine Fehlermeldung angezeigt wird, dass der eingegebene Datei-
name nicht der Name einer herunterladbaren Datei ist, überprüfen Sie,
dass die .dlp-Datei sich im Verzeichnis \Programme\SM7migrate\native
befindet. Wenn Sie die Datei in einem anderen Verzeichnis gespeichert
haben, verschieben Sie sie in das Verzeichnis
\Programme\Files\SM7migrate\native, und starten Sie den Migrations-
prozess erneut.

v Wenn die Nachricht Download successful nicht angezeigt wird, stoppen
Sie den Migrationsprozess und kontaktieren Sie den IBM Ansprechpart-
ner.

v Führen Sie die Stapeldatei ClearLocks.bat im Verzeichnis
\Programme\SM7migrate\native, um nicht mehr benötigte Dateien zu entfernen,
die von der Firmware-Migration generiert wurden.

v Wiederholen Sie die Schritte b bis d für jedes Speichersubsystem, das Sie mit
Storage Manager 7.01 verwalten möchten.

v Starten Sie das System erneut.

80 IBM Netfinity FAStT Storage Manager Version 7.02 for Windows NT: Installations- und Unterstützungshandbuch



Anwenden von NVSRAM-Konfigurationsscripts
Nachdem das System erneut gestartet ist, müssen drei NVSRAM-
Konfigurationsscripts ausgeführt werden, um das Speichersubsystem zur Verwen-
dung mit Windows NT 4.0-Host in einer nicht-geclusterten Umgebung zu verwen-
den. Mit der folgenden Prozedur können Sie diese Scripts anwenden:

1. Führen Sie <target directory>\Temp\SCRIPTS\SM7Scripts.exe aus. Diese sich
selbst entpackende Datei extrahiert die NVSRAM-Konfigurationsscriptdateien.
Wählen Sie ein Zielverzeichnis aus und klicken Sie auf Unzip .

v Hierdurch wird die folgende Verzeichnisstruktur unter dem Zielextraktions-
verzeichnis erstellt:

Verzeichnis von <target directory>
25.04.00 17:25 321 clusteringoff.scr
25.04.00 17:22 423 clusteringon.scr
Kommentar: Wird zum ordnungsgemäßen Betrieb von MS Clustering verwendet
21.04.00 15:48 246 lun0off.scr
21.04.00 15:48 245 lun0on.scr
Hinweis: Wird zum Verwalten der Standarderstellung von LUN 0 ausgeführt
21.04.00 15:53 248 networkoff.scr
21.04.00 15:54 248 networkon.scr
Hinweis: Wird ausgeführt, um die Netzwerkfähigkeit der Controller ein- oder auszuschalten
21.04.00 15:56 248 propresetoff.scr
25.04.00 17:21 248 propreseton.scr
Hinweis: Wird ausgeführt, um das ″weitergegebene Zurücksetzen″ zwischen Controllern ein-
oder auszuschalten
21.04.00 15:52 252 softresetoff.scr
21.04.00 15:51 253 softreseton.scr
Hinweis: Wird ausgeführt, um ein Target Reset als weiches oder hartes Zurücksetzen zu
interpretieren.
25.04.00 17:39 398 UnixWare.scr
31.03.00 12:01 317 Novell.scr
25.04.00 17:42 654 FactoryDefaults.scr
02.05.00 11:47 405 Windows2000.scr
02.05.00 11:47 402 WinNT4.scr
Hinweis: Wird ausgeführt, um an den Controllern die werkseitigen Standardeinstellungen
vorzunehmen, und um die Abfragedaten so festzulegen, dass sie den Betriebssysteman-
forderungen entsprechen.

2. Wählen Sie Start → Programme → Netfinity Fibre Channel Storage Manager
7.

3. Nach dem Starten des Programms Netfinity Fibre Channel Storage Manager 7
wird die folgende Meldung angezeigt:

Confirm Initial Automatic Discovery
The Enterprise Management Window is not configured to monitor any devices.
Select Yes to be in an automatic discover on the local sub-network; this may take several
minutes. Select No to bypass the automatic discover process.

<Ja> <Nein> <Hilfe>
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Wählen Sie Ja aus. Wenn Sie Nein auswählen, können Sie mit der Option
Edit → Add Device Geräte manuell hinzufügen.

Die Speichersubsysteme, die über die Firmware-Version 4.x verfügen, werden
automatisch erkannt.

4. Klicken Sie rechts im rechten Teilfenster des Fenster Enterprise Management
von Netfinity Fibre Channel Storage Manager 7, auf ein Speichersubsystem,
und wählen Sie im Kontextmenü Execute Script aus.

Das Fenster Script Editor wird geöffnet.

5. Wählen Sie im Menü des Fensters Script Editor die Option File → Load Script
aus.

Wenn Sie zum Speichern der Änderungen in newscript.scr aufgefordert wer-
den, wählen Sie Nein aus.

6. Wählen Sie im Fenster Load Script die Datei <target
directory>\FactoryDefaults.scr aus, und wählen Sie Open .

7. Wählen Sie im Menü des Fensters Script Editor die Option Tools → Verify and
Execute aus.

Im unteren Teilfenster des Fenster Script Editor wird die Nachricht Script Exe-
cution complete angezeigt.

8. Wählen Sie im Menü des Fensters Script Editor die Option File → Load Script
aus.

Wenn Sie zum Speichern der Änderungen in newscript.scr aufgefordert wer-
den, wählen Sie Nein aus.

9. Wählen Sie im Fenster Load Script die Datei <target directory>\WinNT4.scr
aus, und wählen Sie Öffnen .

10. Wählen Sie im Menü des Fensters Script Editor die Option Tools → Verify and
Execute aus.

Im unteren Teilfenster des Fenster Script Editor wird die Nachricht Script Exe-
cution complete angezeigt.

11. Wählen Sie im Menü des Fensters Script Editor die Option File → Load Script
aus.

Wenn Sie zum Speichern der Änderungen in newscript.scr aufgefordert wer-
den, wählen Sie Nein aus.

12. Wählen Sie im Fenster Load Script die Datei <target directory>\softreseton.scr
aus, und wählen Sie Open .

13. Wählen Sie im Menü des Fensters Script Editor die Option Tools → Verify and
Execute aus.

Im unteren Teilfenster des Fensters Script Editor wird die Nachricht Script Exe-
cution complete angezeigt.

Bereinigung
1. Deinstallieren Sie SM7migrate.

2. Die Migration ist abgeschlossen. Sie können jetzt mit Storage Manager 7.01 die
Speichersubsysteme verwalten, die über die Firmware 4.x verfügen.
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Kapitel 7. Unterstützung von Betriebssystemen

Dieses Kapitel enthält Informationen zur Verwendung der Speicherverwaltungs-
software unter Windows NT.

Einschränkung unter Windows NT
Wichtig: Überprüfen Sie immer, ob sich auf einem Installationsdatenträger eine
README-Datei befindet. Diese README-Datei enthält wichtige Informationen, die
bei der Erstellung dieses Installations- und Unterstützungshandbuchs noch nicht zur
Verfügung standen.

In Tabelle 13 werden die Einschränkungen erklärt, die für die Verwendung von IBM
Netfinity FAStT Storage Manager Version 7.02 mit Windows NT gelten.

Tabelle 13. Einschränkungen unter Windows NT und Hinweise

Einschränkung Umgehungsverfahren

Durch Klicken auf einen senkrechten Schiebepfeil (auf
oder ab) wird das Schiebefeld über die ganze Länge der
Schiebeleiste ans andere Ende verschoben.

Dies ist ein bekannter Fehler in der Laufzeitumgebung
von Java. Klicken Sie auf das Schiebefeld und schieben
Sie es, bis Sie die gewünschte Position im Hilfefenster
erreicht haben.

Die Migration von logischen Laufwerken (Entfernen eines
Laufwerks-Sets mit logischen Laufwerken von einem
Speichersubsystem und Einsetzen in ein anderes
Speichersubsystem) wird nicht unterstützt, da die
Konfiguration verloren gehen kann.

Benachrichtigen Sie den Kundendienst.

Wenn Sie Speichersubsysteme über die Host-Agent-
Software verwalten, und die Speicherverwaltungssoftware
zum Herunterladen der Controller-Firmware verwenden,
benötigt der Übertragungsvorgang bis zu 10 Minuten.

Keines.

Wenn Sie ein neues Speichersubsystem mit einem
einzelnen Controller konfigurieren, müssen Sie den
Controller in Steckplatz A platzieren. Die Controller-
Firmware erkennt einen einzelnen Controller nicht bzw.
kann nicht mit ihm kommunizieren, wenn Steckplatz A
nicht belegt ist. Diese Einschränkung gilt nicht für
Speichersubsysteme, die ursprünglich mit zwei Controllern
konfiguriert wurden.

Keines.

Eine allgemeine Ringleitungskonfiguration (verwaltete
Hubs, die an Switches angeschlossen sind) wird nicht
unterstützt.

Keines.

Wenn Sie einen Lüfter oder ein Netzteil (CRU) bei
laufendem System aus einem Speichersubsystem
entfernen, zeigt die Speicherverwaltungssoftware keinen
Fehler an, und die Komponente wird nicht als fehlend
angezeigt.
Anmerkung: Ausfälle bei Lüftern und Netzteil-CRU
werden berichtet.

Ersetzen Sie die fehlenden Lüfter oder Netzteil-CRU
unmittelbar, um die Redundanz zu gewährleisten. Stellen
Sie sicher, dass der Lüfter oder das Netzteil-CRU
ordnungsgemäß in der Controller-Einheit eingesetzt ist.
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Zahl der unterstützten logischen Laufwerke
Folgende Einschränkungen gelten für die Unterstützung logischer Laufwerke:

v Unter Windows NT mit Service Pack 5 oder höher werden bis zu 8 logische Lauf-
werke je Speichersubsystem unterstützt (LUN 0–7).

v Unter Windows NT mit Service Pack 5 oder höher werden bis zu 32 logische
Laufwerke je Speichersubsystem unterstützt (LUN 0–31), wenn der Host-Adapter
auch große LUN unterstützt und ordnungsgemäß konfiguriert ist.

v Host-Adapter unterstützten die Höchstzahl an logischen Laufwerken. Weitere
Informationen hierzu finden Sie in der Dokumentation des Host-Adapters.

v Die Host-Agent-Verwaltungsmethode verwendet ein besonderes logisches Lauf-
werk, Zugriffsdatenträger genannt, um mit den Controllern im Speichersubsystem
zu kommunizieren. Der Zugriffsdatenträger verwendet eines der zulässigen logi-
schen Laufwerke. Wenn Sie das Speichersubsystem über die Host-Agent-
Software verwalten, steht ein LUN weniger zur Verfügung als die Höchstzahl, die
von Windows NT und dem Host-Adapter unterstützt wird.

Erstellen von logischen Laufwerken
Ein logisches Laufwerk ist ein logisches Objekt, das Sie als grundlegende Struktur
zum Speichern von Daten im Speichersubsystem erstellen. Ein logisches Laufwerk
wird mit einer bestimmten RAID-Stufe über ein Array konfiguriert, um dem Bedarf
von Anwendungen nach Datenverfügbarkeit und Fibre Channel-E/A-Leistung zu ent-
sprechen. Ein logisches Laufwerk wird vom Betriebssystem als einzelnes Laufwerk
erkannt. Sie können logische Laufwerke in einer standardmäßigen Konfiguration
(ohne Cluster) und in einer Cluster-Server-Umgebung hinzufügen oder löschen.

Standardkonfiguration
Wenn Sie mit der Speicherverwaltungssoftware neue logische Laufwerke erstellen,
müssen Sie die neuen Laufwerke unter Windows NT hinzufügen. Informationen
zum Hinzufügen von Laufwerken finden Sie in der Dokumentation zu Windows NT.
Beachten Sie, dass jedes logische Laufwerk (nicht das Array) von Windows NT al
ein Laufwerk erkannt wird. Führen Sie nach dem Erstellen eines logischen Lauf-
werks die Dienstprogramme Hot-Add und SM7devices aus, die im Lieferumfang der
Speicherverwaltungssoftware enthalten sind. Das Hot-Add-Dienstprogramm fügt
neue logische Laufwerke zum Betriebssystem hinzu, das Dienstprogramm
SM7devices identifiziert logische Laufwerke über den vom Betriebssystem zugeord-
neten Einheitennamen. Weitere Informationen zur Verwendung dieser Dienst-
programme finden Sie unter „Verwenden des Hot-Add-Dienstprogramms” auf Sei-
te 86 und „Verwenden des Dienstprogramms SM7devices” auf Seite 86.

Bevor Sie logische Laufwerke mit der Speicherverwaltungssoftware oder über Con-
figure → Reset Configuration löschen, beenden Sie alle Ein- und Ausgabevor-
gänge am betroffenen Speichersubsystem. Verwenden Sie den Festplatten-
Manager zum Löschen von Partitionen, und um die den logischen Laufwerken
zugeordneten Laufwerksbuchstaben freizugeben.

Achtung: Wenn Sie den Festplatten-Manager nicht vorher verwenden, werden
Informationen der Registrierungsdatenbank beschädigt.
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Cluster-Server-Umgebungen
Wenn Sie logische Laufwerke auf einem Knoten oder in einer Cluster-Server-
Umgebung erstellen, müssen Sie den gleichen Laufwerkbuchstaben auch auf dem
anderen Knoten zuordnen. Führen Sie nach dem Erstellen eines logischen Lauf-
werks die Dienstprogramme Hot-Add und SM7devices aus, die im Lieferumfang der
Speicherverwaltungssoftware enthalten sind. Das Dienstprogramm Hot-Add fügt
neue logische Laufwerke zum Betriebssystem hinzu, das Dienstprogramm
SM7devices identifiziert logische Laufwerke über den vom Betriebssystem zugeord-
neten Einheitennamen. Weitere Informationen zur Verwendung dieser Dienst-
programme finden Sie unter „Verwenden des Hot-Add-Dienstprogramms” auf Sei-
te 86 und „Verwenden des Dienstprogramms SM7devices” auf Seite 86.

Gehen Sie wie folgt vor, um logische Laufwerke in einer Cluster-Server-Umgebung
hinzuzufügen:

1. Erstellen Sie mit der Speicherverwaltungssoftware ein neues logische Lauf-
werk. Weitere Informationen hierzu finden Sie in der Online-Hilfefunktion von
Subsystem Management.

2. Verwenden Sie das Hot-Add-Dienstprogramm, um das logische Laufwerk auf
Knoten A hinzuzufügen.

3. Formatieren Sie das neue logische Laufwerk auf Knoten A mit dem
Festplatten-Manager.

4. Verwenden Sie das Hot-Add-Dienstprogramm, um das logische Laufwerk auf
Knoten B hinzuzufügen.

5. Weisen Sie dem neuen logischen Laufwerk auf Knoten B mit dem Festplatten-
Manager den gleichen Laufwerksbuchstaben wie auf Knoten B zu.

6. Starten Sie Cluster Administrator auf Knoten B, und beenden Sie das Cluster-
Dienstprogramm.

7. Klicken Sie auf Node B → File Stop → Cluster Service .

8. Klicken Sie in Cluster Administrator auf Node B , und klicken Sie dann auf File
→ Evict Cluster Node .

9. Starten Sie Knoten A neu.

10. Erstellen Sie auf Knoten A mit Cluster Administrator ein neues Array, oder wäh-
len Sie ein bestehendes Array aus, zu dem Sie das neue logische Laufwerk
hinzufügen können.

11. Wählen Sie das Array aus, und klicken Sie auf File → New → Resource .

12. Benennen Sie die neue Ressource und wählen Sie als Ressourcentyp Physi-
cal Disk aus.

13. Klicken Sie auf Next .

14. Klicken Sie auf Node A als Eigentümer der Plattenressource, und klicken Sie
dann auf Next .

15. Geben Sie Abhängigkeiten an (andere Ressourcen, die von Cluster Administra-
tor online gebracht werden müssen), bevor diese neue Plattenressource online
geht.

16. Wählen Sie die neue Platte aus der Laufwerksparameterliste aus, und klicken
Sie dann auf Finish .

17. Deinstallieren Sie das Programm Cluster-Server von Knoten B.

18. Installieren Sie das Programm Cluster-Server erneut auf Knoten B, und ver-
knüpfen Sie den bestehenden Cluster, in dem Knoten A enthalten ist.
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Wichtig: Editieren Sie die Merkmale der neuen Platte, damit Knoten B ein potenzi-
eller Eigentümer der Ressource wird. Sie können die Cluster-Ressourcen zwischen
den Knoten A und B neu verteilen und die Merkmale aller Cluster-Ressourcen edi-
tieren, so dass sie Knoten B enthalten. Verschieben Sie alle Cluster-Ressourcen,
die zu Knoten B gehören, von Knoten A nach Knoten B zurück.

Verwenden des Hot-Add-Dienstprogramms
Die RDAC-Software enthält ein Dienstprogramm namens Hot-Add, mit dem neue
logisch Laufwerke dynamisch hinzugefügt werden können, ohne das System neu zu
starten. Das Dienstprogramm registriert die neuen logischen Laufwerke, so dass
Sie mit Disk Administrator Partitionen erstellen, Gerätenamen hinzufügen können
usw. Das Dienstprogramm Hot-Add ist als Teil des RDAC-Pakets installiert.

Nachdem die logischen Laufwerke auf einem bestimmten Speichersubsystem
erstellt wurden, wechseln Sie zum Host, der mit dem Speichersubsystem verbun-
den ist, und führen Sie folgende Schritte aus, um das Hot-Add-Dienstprogramm zu
verwenden:

1. Geben Sie an der DOS-Eingabeaufforderung Folgendes ein:

hot_add

2. Drücken Sie die Eingabetaste.

Die neuen logischen Laufwerke stehen über den Festplatten-Manager zur Verfü-
gung.

Verwenden des Dienstprogramms SM7devices
Die SM7agent-Software enthält ein Dienstprogramm namens SM7devices, mit dem
Sie das logische Laufwerk des Speichersubsystems sichten können, das einem
bestimmten Gerätenamen des Betriebssystems zugeordnet ist. Diese Funktion ist
sinnvoll, wenn Sie mit dem Festplatten-Manager Laufwerksbuchstaben oder Partitio-
nen für das logische Laufwerk erstellen möchten.

Nachdem die logischen Laufwerke auf einem bestimmten Speichersubsystem
erstellt wurden, wechseln Sie zum Host, der mit dem Speichersubsystem verbun-
den ist, und führen Sie folgende Schritte aus, um das Dienstprogramm SM7devices
zu verwenden:

1. Wechseln Sie von der DOS-Eingabeaufforderung in das Verzeichnis
\Programme\SM7agent.

2. Geben Sie Folgendes ein:

SM7devices

3. Drücken Sie die Eingabetaste.

Die Software zeigt Informationen zu Gerätekennung an. Beispielsweise kann
Folgendes angezeigt werden:

\\.\PHYSICALDRIVE0 [Storage Subsystem Finance, Logical Drive DEBIT, LUN
0, WWN <600a0b800006028600000000382060eb>] \\.\PHYSICALDRIVE1 [Sto-
rage Subsystem Finance, Logical Drive CREDIT, LUN 1, WWN
<600a0b70006028600000000392060eb>]

Wobei PHYSICALDRIVEx = Diskx in Disk Administrator Storage Subsystemx =
der Name des Speichersubsystem Logical Drivex= der logische Laufwerksname
LUNx = die Nummer der logischen Einheit, die dem logischen Laufwerk zuge-
ordnet ist WWNx = der externe Name des logischen Laufwerks
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Deinstallieren von Softwarekomponenten der Speicherverwaltung
Gehen Sie wie folgt vor, um eine oder mehrere Komponenten von Storage Manager
7.02 zu deinstallieren.

Achtung: Deinstallieren Sie die RDAC-Komponente nicht, es sei denn, Sie wer-
den vom IBM Kundendienstpersonal dazu aufgefordert. Das Host-Agent-Paket
erfordert RDAC, um ordnungsgemäß zu funktionieren. Wenn Sie RDAC in einer
Koexistenzumgebung deinstallieren, geht die Unterstützung zur Überbrückung beim
FibreChannel E/A-Pfad sowohl unter Storage Manager 7.02 und der Speicher-
verwaltungssoftware Version 6.22 verloren.

1. Klicken Sie auf Start → Settings → Control Panel → Add/Remove Programs .

Das Fenster Add/Remove Programs Properties wird geöffnet.

2. Wählen Sie aus der Liste von Programmen die Komponente aus, die deinstal-
liert werden soll.

Wählen Sie beispielsweise Fibre Channel Storage Manager 7 Client.

3. Klicken Sie auf Add/Remove.

Das Fenster Confirm File Deletion wird geöffnet.

4. Klicken Sie auf Ja, um den Deinstallationsvorgang zu starten.

5. Klicken Sie auf OK, wenn die Deinstallation abgeschlossen ist.
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Anhang A. Hinweise

Hinweise auf IBM Produkte, Programme und Dienstleistungen in dieser Veröffentli-
chung bedeuten nicht, dass IBM diese in allen Ländern, in denen IBM vertreten ist,
anbietet. Hinweise auf IBM Lizenzprogramme oder andere IBM Produkte bedeuten
nicht, dass nur Programme, Produkte oder Dienstleistungen von IBM verwendet
werden können. Anstelle der IBM Produkte, Programme oder Dienstleistungen kön-
nen auch andere äquivalente Produkte, Programme oder Dienstleistungen verwen-
det werden, solange diese keine gewerblichen oder anderen Schutzrechte von IBM
verletzen. Die Verantwortung für den Betrieb der Produkte, Programme oder Dienst-
leistungen in Verbindung mit Fremdprodukten und Fremddienstleistungen liegt beim
Kunden, soweit solche Verbindungen nicht ausdrücklich von IBM bestätigt sind.

Für in diesem Handbuch beschriebene Erzeugnisse und Verfahren kann es IBM
Patente oder Patentanmeldungen geben. Mit der Auslieferung dieses Handbuchs ist
keine Lizenzierung dieser Patente verbunden. Anfragen bezüglich Lizenzen können
schriftlich an folgende Adresse gerichtet werden:

IBM Europe
Director of Licensing
92066 Paris La Defense Cedex
France

Dieses Kapitel enthält Angaben zu Marken und weitere wichtige Informationen.

Verweise in dieser Veröffentlichung auf Websites anderer Anbieter dienen lediglich
als Benutzerinformationen und stellen keinerlei Billigung des Inhalts dieser Websites
dar. Das über diese Websites verfügbare Material ist nicht Bestandteil des Materials
für dieses IBM Produkt. Die Verwendung dieser Websites geschieht auf eigene Ver-
antwortung.

Impressum
DIESE VERÖFFENTLICHUNG WIRD VON DER INTERNATIONAL BUSINESS
MACHINES CORPORATION OHNE JEDE GEWÄHRLEISTUNG, OB DIREKT
ODER INDIREKT, ZUR VERFÜGUNG GESTELLT, EINSCHLIESSLICH, JEDOCH
NICHT BESCHRÄNKT AUF INDIREKT GELTENDE HANDELSÜBLICHE UND FÜR
EINEN BESTIMMTEN ZWECK GEEIGNETE GARANTIELEISTUNGEN. Einige
Rechtsordnungen erlauben keine Ablehnungserklärungen für direkte oder indirekte
Gewährleistungen bei bestimmten Transaktionen. Daher trifft dies für Sie möglicher-
weise nicht zu.

Trotz sorgfältiger Bearbeitung können technische Ungenauigkeiten oder Druckfehler
in dieser Veröffentlichung nicht ausgeschlossen werden. Die Angaben in diesem
Handbuch werden in regelmäßigen Zeitabständen aktualisiert. Die Änderungen wer-
den in Überarbeitungen oder in Technical News Letters (TNLs) bekanntgegeben.
IBM kann jederzeit Verbesserungen und/oder Änderungen an den in dieser Veröf-
fentlichung beschriebenen Produkten und/oder Programmen vornehmen.
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Diese Veröffentlichung ist für Produkte und Services entwickelt, die in den Vereinig-
ten Staaten und in Großbritannien angeboten werden. Dieses Handbuch kann Ver-
weise auf oder Informationen über IBM Produkte (Maschinen und Programme), Pro-
grammierung oder Dienstleistungen enthalten, die nicht in allen Ländern
angekündigt sind. Die endgültige Entscheidung über die Ankündigung eines Produk-
tes liegt bei IBM.

Anfragen bezüglich technischer Informationen über IBM Produkte sollten an einen
autorisierten IBM Händler oder den IBM Vertriebsbeauftragten gerichtet werden.
Diese Veröffentlichung darf ohne vorherige schriftliche Genehmigung der IBM weder
ganz noch in Auszügen vervielfältigt oder vertrieben werden.

© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2000.
Alle Rechte vorbehalten.
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Marken
Die folgenden Namen sind in den USA und/oder anderen Ländern Marken der Inter-
national Business Machines Corporation:

IBM

Netfinity

JavaHelp ist in den USA und/oder anderen Ländern eine Marke von Sun Microsys-
tems, Inc.

Microsoft, Windows und Windows NT sind in den USA und/oder anderen Ländern
Marken der Microsoft Corporation.

UNIX ist in gewissen Ländern eine eingetragene Marke der Open Group.

Andere Namen von Unternehmen, Produkten oder Dienstleistungen können Marken
oder Dienstleistungsmarken anderer Unternehmen sein.
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Anhang B. Informationsdatensatz zum
Speichersubsystem/Controller

Tabelle 14 bietet einen Datensatz, in dem Sie die Bezeichnungen für das Speicher-
subsystem, die Verwaltungsarten, die Hardware-Ethernet-Adressen und die
IP-Adressen aufzeichnen können. Kopieren Sie diese Tabelle, und vervollständigen
Sie die Daten über Ihre Subsysteme und Controller. Verwenden Sie die Informatio-
nen aus Tabelle 14, um die BOOTP-Tabelle für den Netz-Server sowie die Host-
Tabelle oder die Tabelle für das Domänennamensystem (DNS = Domain Name Sys-
tem) zu installieren. Mit Hilfe der Daten aus Tabelle 14 können Sie nach der
Erstinstallation weitere Speichersubsysteme hinzufügen. Die Spaltenüberschriften
zeigen einen Seitenverweis auf detaillierte Anweisungen über das Abrufen von
Informationen an. Ein Beispiel für einen Informationsdatensatz finden Sie unter
Tabelle 9 auf Seite 20.

Tabelle 14. Informationsdatensatz zum Speichersubsystem und Controller

Name des Speicher-
subsystems
(siehe Seite 21)

Verwaltungsart
(siehe Seite 17)

Controller — Ethernet und IP-Adressen
sowie Host-Name
(siehe Seiten 22 und 24)

Host — IP-Adresse
und Host-Name
(siehe Seite 24)

Name des Speicher-
subsystems:

Name des Speicher-
subsystems:

Name des Speicher-
subsystems:

Name des Speicher-
subsystems:

Name des Speicher-
subsystems:

Name des Speicher-
subsystems:

Name des Speicher-
subsystems:

Name des Speicher-
subsystems:
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Antwort

IBM Netfinity FAStT
Storage Manager Version 7.02 for Windows NT
Installations- und Unterstützungshandbuch

Teilenummer 19K6076

Anregungen zur Verbesserung und Ergänzung dieser Veröffentlichung nehmen wir gerne entgegen. Bitte informie-
ren Sie uns über Fehler, ungenaue Darstellungen oder andere Mängel.

Zur Klärung technischer Fragen sowie zu Liefermöglichkeiten und Preisen wenden Sie sich bitte entweder an Ihre
IBM Geschäftsstelle, Ihren IBM Geschäftspartner oder Ihren Händler.

Unsere Telefonauskunft ″HALLO IBM ″ (Telefonnr.: 01803/31 32 33) steht Ihnen ebenfalls zur Klärung allge-
meiner Fragen zur Verfügung.

Kommentare:

Danke für Ihre Bemühungen.

Sie können ihre Kommentare betr. dieser Veröffentlichung wie folgt senden:
v Als Brief an die Postanschrift auf der Rückseite dieses Formulars
v Als E-Mail an die folgende Adresse: ibmterm@de.ibm.com

Name Adresse

Firma oder Organisation

Rufnummer E-Mail-Adresse



Antwort IBM

IBM Deutschland GmbH
SW NLS Center

70548 Stuttgart
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Teilenummer: 19K6076

(1P) P/N: 19K6076
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